Xerox® Phaser® 6510 Printer
User Guide
# Table of Contents

1 Safety ................................................................................................................................. 11
   Notices and Safety ........................................................................................................... 12
   Electrical Safety ............................................................................................................. 13
      General Guidelines ....................................................................................................... 13
      Power Cord .................................................................................................................. 13
      Emergency Power Off ................................................................................................. 14
   Operational Safety .......................................................................................................... 15
      Operational Guidelines ............................................................................................... 15
      Ozone Release ............................................................................................................. 15
      Printer Location ........................................................................................................... 15
      Printer Supplies ........................................................................................................... 16
   Maintenance Safety ......................................................................................................... 17
   Printer Symbols ............................................................................................................... 18
   Environmental, Health and Safety Contact Information .................................................... 22

2 Features ................................................................................................................................... 23
   Parts of the Printer .......................................................................................................... 24
      Front View .................................................................................................................... 24
      Rear View .................................................................................................................... 25
      Internal Parts ............................................................................................................... 26
      Control Panel .............................................................................................................. 27
   Power Saver ..................................................................................................................... 30
      Exiting Sleep Mode ..................................................................................................... 30
   Information Pages .......................................................................................................... 31
      Printing Reports .......................................................................................................... 31
      Specifying the Source Tray for Printing Reports ......................................................... 31
      Configuration Report ................................................................................................. 31
      Configuring Printing of the Startup Page at Power On ............................................... 32
   Administrative Features ................................................................................................. 33
      The Embedded Web Server ......................................................................................... 33
      Finding the IP Address of Your Printer ...................................................................... 33
      Certificates for the Embedded Web Server .................................................................. 34
      Downloading the Configuration Report from the Embedded Web Server .................. 34
      Accessing the Printer .................................................................................................... 35
      Meter Readings ............................................................................................................ 35
   More Information ............................................................................................................. 36

3 Installation and Setup ..................................................................................................... 37
   Installation and Setup Overview ...................................................................................... 38
   Selecting a Location for the Printer .................................................................................. 39
Table of Contents

Opening the Output Tray Extension ................................................................. 39
Connecting the Printer ..................................................................................... 40
Selecting a Connection Method ........................................................................ 40
Connecting to a Computer Using USB ............................................................ 40
Connecting to a Wired Network ...................................................................... 41
Connecting to a Wireless Network ................................................................. 41
Powering the Printer On and Off ................................................................. 51
Installation Wizard ......................................................................................... 52
Configuring Network Settings ........................................................................ 53
About TCP/IP and IP Addresses .................................................................... 53
Assigning the Printer IP Address .................................................................... 53
Configuring AirPrint ....................................................................................... 54
Configuring Google Cloud Print ..................................................................... 55
Installing the Software .................................................................................... 56
Operating System Requirements ................................................................... 56
Installing the Print Drivers for a Windows Network Printer ......................... 56
Installing the Print Drivers for a Windows USB Printer ................................ 57
Installing the Drivers and Utilities for Macintosh OS X .............................. 57
Installing Drivers and Utilities for UNIX and Linux .................................... 58
Installing the Printer as a Web Service on Devices ..................................... 59

4 Paper and Media ......................................................................................... 61
Supported Paper ............................................................................................. 62
Recommended Media .................................................................................... 62
Ordering Paper ............................................................................................... 62
General Paper Loading Guidelines ............................................................... 62
Paper That Can Damage Your Printer ........................................................... 62
Paper Storage Guidelines .............................................................................. 63
Supported Paper Types and Weights ............................................................. 64
Supported Standard Paper Sizes .................................................................. 65
Supported Paper Types and Weights for Automatic 2-Sided Printing .......... 65
Supported Custom Paper Sizes ..................................................................... 66
Setting the Tray Mode .................................................................................... 66
Loading Paper ................................................................................................. 68
Loading Paper in the Bypass Tray ................................................................. 68
Configuring Trays 1 or 2 for the Paper Length ............................................. 70
Loading Paper into Trays 1 and 2 .................................................................. 72
Printing on Special Paper .............................................................................. 75
Envelopes ...................................................................................................... 75
Labels ............................................................................................................ 80
Glossy Cardstock ............................................................................................ 84

5 Printing ........................................................................................................ 85
Printing Overview .......................................................................................... 86
Selecting Printing Options ........................................................................... 87
Print Driver Help ............................................................................................ 87

Xerox® Phaser® 6510 Printer
User Guide
Table of Contents

General Troubleshooting ............................................................... 126
  Printer Does Not Power On ..................................................... 126
  Printer Resets or Powers Off Frequently ................................ 126
  Printer Does Not Print .......................................................... 127
  Printing Takes Too Long ......................................................... 128
  Document Prints from Wrong Tray ........................................... 129
  Automatic 2-Sided Printing Problems ..................................... 129
  Printer is Making Unusual Noises ......................................... 129
  Paper Tray Will Not Close ..................................................... 130
  Condensation has Formed Inside the Printer ............................ 130
Paper Jams .............................................................................. 131
  Locating Paper Jams .............................................................. 131
  Minimizing Paper Jams .......................................................... 131
  Clearing Paper Jams .............................................................. 133
  Troubleshooting Paper Jams ................................................... 140
  Print-Quality Problems .......................................................... 142
Getting Help ............................................................................ 149
  Control Panel Messages ........................................................ 149
  Using the Integrated Troubleshooting Tools ............................. 149
  Online Support Assistant ....................................................... 150
  Helpful Information Pages ..................................................... 150
  More Information about Your Printer ..................................... 150

8 System Administrator Functions ............................................. 151

Accessing the Printer ............................................................... 152
  Logging In at the Control Panel as the Administrator .............. 152
  Accessing the Embedded Web Server as a System Administrator 152
  Changing the System Administrator Password ....................... 153
Connecting the Printer ............................................................. 154
  Connecting to a Wireless Network .......................................... 154
  Wi-Fi Direct .......................................................................... 157
  IP ......................................................................................... 158
  NFC ..................................................................................... 160
Configuring General Settings Using the Embedded Web Server .... 161
  Viewing Printer Information .................................................. 161
  Setting the Date and Time Using the Embedded Web Server .... 161
  Setting the Sounds Using the Embedded Web Server .............. 162
  Configuring the Device Website Timeout ................................. 162
  Configuring Power Saver Using the Embedded Web Server ...... 162
  Configuring Tray Settings Using the Embedded Web Server ...... 163
  Cloning Printer Settings ........................................................ 164
  Enabling the Plug-in Feature ................................................... 165
  Resetting the Printer ............................................................. 165
  Configuring Alerts ............................................................... 165
  Configuring the SMTP Server Settings .................................... 166
  Configuring Email Alerts ....................................................... 167
  Configuring PDL Settings from the Embedded Web Server ....... 167
# Table of Contents

### A Specifications

- Printer Configurations and Options .......................................................... 216
  - Available Configurations ........................................................................ 216
  - Standard Features .................................................................................. 216
  - Options and Upgrades .......................................................................... 217
- Physical Specifications .................................................................................. 218
  - Weights and Dimensions ...................................................................... 218
  - Standard Configuration .......................................................................... 218
  - Configuration with Optional 550-Sheet Feeder ..................................... 218
  - Total Space Requirements .................................................................... 219
  - Clearance Requirements ....................................................................... 219
- Environmental Specifications ........................................................................ 221
  - Temperature .......................................................................................... 221
  - Relative Humidity ................................................................................. 221
  - Elevation ............................................................................................... 221
- Electrical Specifications ............................................................................... 222
  - Power Supply Voltage and Frequency .................................................... 222
  - Power Consumption .............................................................................. 222
  - ENERGY STAR Qualified Product .......................................................... 222
  - Germany - Blue Angel ........................................................................... 222
  - Recycling Supplies ................................................................................. 223
- Performance Specifications ........................................................................ 224
  - Print Speed .............................................................................................. 224

### B Regulatory Information

- Basic Regulations ...................................................................................... 226
  - United States FCC Regulations ............................................................... 226
  - Canada ..................................................................................................... 226

### Regulatory Information

- Before You Begin ....................................................................................... 207
- Creating a Security Certificate .................................................................... 207
- Importing a Digital Certificate .................................................................... 208
- Initializing Certificates At the Control Panel ............................................. 208
- Verifying the Digital Certificate Purpose ................................................... 209
- Deleting a Digital Certificate ..................................................................... 209
- Exporting a Digital Certificate .................................................................... 209
- Configuring Remote Services Upload ......................................................... 211
  - Setting Up a Proxy Server ....................................................................... 211
  - Enabling Remote Services ...................................................................... 211
- Testing the Connection to the Xerox® Remote Services Datacenter .......... 211
- Scheduling Daily Data Upload to the Xerox® Remote Services Datacenter ... 212
- Enabling Email Notifications for Remote Services ..................................... 212
- Disabling Remote Services ...................................................................... 213
- Updating the Printer Software ................................................................... 214
  - Checking the Software Version ............................................................... 214
  - Enabling Upgrades ................................................................................. 214

### Remote Services Datacenter

- Remote Services Datacenter ...................................................................... 212
Table of Contents

Certifications in Europe ................................................................. 226
European Union Lot 4 Imaging Equipment Agreement Environmental Information ................................................................. 227
Germany ......................................................................................... 229
Turkey RoHS Regulation ................................................................. 229
Regulatory Information for a 2.4–GHz Wireless Network Adapter ................................................................. 229
Material Safety Data Sheets ............................................................. 230

C Recycling and Disposal ................................................................ 231
All Countries ................................................................................... 232
North America ................................................................................ 233
European Union ............................................................................. 234
Domestic/Household Environment .................................................... 234
Professional/Business Environment ................................................... 234
Collection and Disposal of Equipment and Batteries .............................. 235
Battery Symbol Note ....................................................................... 235
Battery Removal ............................................................................ 235
Other Countries .............................................................................. 236
Safety

This chapter contains:

- Notices and Safety ................................................. 12
- Electrical Safety .................................................. 13
- Operational Safety ................................................. 15
- Maintenance Safety ............................................... 17
- Printer Symbols ..................................................... 18
- Environmental, Health and Safety Contact Information ........................................ 22

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your Xerox printer.
Safety

Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These include safety agency evaluation and certification, and compliance with electromagnetic regulations and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection of external devices, can affect the product certification. For more information, contact your Xerox representative.
Electrical Safety

General Guidelines

**WARNING:**
- Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a part could result in fire or electric shock.
- Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Power off the printer when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:
- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- The printer emits smoke, or the surface is unusually hot.
- The printer emits unusual noise or odors.
- The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:
1. Power off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

**Power Cord**

Use the power cord supplied with your printer.

- Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.

**WARNING:** To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power plugs for more than 90 days. When a permanent outlet receptacle cannot be installed, use only one factory-assembled extension cord of the appropriate gauge for each printer or multifunction printer. Always adhere to national and local building, fire, and electrical codes regarding length of cord, conductor size, grounding, and protection.

- Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.

- Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary.

- Do not place the printer in an area where people can step on the power cord.
Safety

- Do not place objects on the power cord.
- Do not plug or unplug the power cord while the power switch is in the On position.
- If the power cord becomes frayed or worn, replace it.
- To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Power Off

If any of the following conditions occur, power off the printer immediately and disconnect the power cord from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

- The equipment emits unusual odors or makes unusual noises.
- The power cable is damaged or frayed.
- A wall panel circuit breaker, fuse, or other safety device has been tripped.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- Any part of the printer is damaged.
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

Operational Guidelines

- Do not remove any trays when the printer is printing.
- Do not open the doors when the printer is printing.
- Do not move the printer when it is printing.
- Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
- Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the protective covers.
- Do not override any electrical or mechanical interlock devices.
- Do not attempt to remove paper that is jammed deeply inside the printer. Switch off the printer promptly and contact your local Xerox representative.

**WARNING:**

- The metallic surfaces in the fuser area are hot. Always use caution when removing paper jams from this area and avoid touching any metallic surfaces.
- To avoid a tip hazard, do not push or move the device with all the paper trays extended.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location

- Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the weight for your printer configuration, refer to Physical Specifications.
- Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
- Place the printer in an area where there is adequate space for operation and servicing.
- Place the printer in a dust-free area.
- Do not store or operate the printer in an extremely hot, cold, or humid environment.
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
Safety

- Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.
- Do not place the printer in locations susceptible to vibrations.
- For optimum performance, use the printer at the elevations specified in Elevation.

Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
- Store all consumables in accordance with the instructions given on the package or container.
- Keep all consumables away from the reach of children.
- Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.
- When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of skin or eye contact.

⚠️ WARNING:

Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Maintenance Safety

- Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with your printer.
- Clean with a dry lint-free cloth only.
- Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa.

⚠️ **WARNING:** Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for your area.
## Printer Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td><strong>Warning:</strong> Indicates a hazard which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td><img src="image" alt="Hot Warning" /></td>
<td><strong>Hot Warning:</strong> Hot surface on or in the printer. Use caution to avoid personal injury.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td><strong>Caution:</strong> Indicates a mandatory action to take in order to avoid damage to the property.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td><strong>Caution:</strong> To avoid damage to the property, be careful not to spill toner when handling the waste cartridge.</td>
</tr>
<tr>
<td><img src="image" alt="Do not touch" /></td>
<td>Do not touch the part or area of the printer.</td>
</tr>
<tr>
<td><img src="image" alt="Do not expose" /></td>
<td>Do not expose the drum cartridges to direct sunlight.</td>
</tr>
<tr>
<td><img src="image" alt="Do not burn" /></td>
<td>Do not burn the toner cartridges.</td>
</tr>
<tr>
<td><img src="image" alt="Do not burn" /></td>
<td>Do not burn the waste cartridge.</td>
</tr>
<tr>
<td><img src="image" alt="Do not burn" /></td>
<td>Do not burn the drum cartridges.</td>
</tr>
<tr>
<td><img src="image" alt="Do not use paper" /></td>
<td>Do not use paper attached with staples or any other form of binding clip.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="symbol.png" alt="No Fold" /></td>
<td>Do not use folded, creased, curled, or wrinkled paper.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="No Inkjet" /></td>
<td>Do not use inkjet paper.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="No Transparency" /></td>
<td>Do not use transparencies or overhead projector sheets.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="No Reload" /></td>
<td>Do not reload paper previously printed on or used.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Add Media" /></td>
<td>Add paper or media.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Paper Jam" /></td>
<td>Paper Jam</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Lock" /></td>
<td>Lock</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Unlock" /></td>
<td>Unlock</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Document" /></td>
<td>Document</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Paper" /></td>
<td>Paper</td>
</tr>
<tr>
<td><img src="symbol.png" alt="WLAN" /></td>
<td>WLAN</td>
</tr>
<tr>
<td><img src="symbol.png" alt="LAN" /></td>
<td>LAN</td>
</tr>
</tbody>
</table>

**WLAN**
Wireless Local Area Network

**LAN**
Local Area Network
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![USB](image) | USB  
Universal Serial Bus |
<p>| <img src="image" alt="Postcard" /> | Postcard |
| <img src="image" alt="Load Envelopes Closed" /> | Load envelopes in the tray with the flaps closed and facing up. |
| <img src="image" alt="Load Envelopes Open" /> | Load envelopes in the tray with the flaps open and facing up. |
| <img src="image" alt="OK Button" /> | OK Button |
| <img src="image" alt="Print Menu Button" /> | Print Menu Button |
| <img src="image" alt="Pause Printing Button" /> | Pause Printing Button |
| <img src="image" alt="Information Button" /> | Information Button |
| <img src="image" alt="Menu Button" /> | Menu Button |
| <img src="image" alt="Back Button" /> | Back Button |
| <img src="image" alt="Power/Wake Button" /> | Power/Wake Button |
| <img src="image" alt="Cancel Job Button" /> | Cancel Job Button |
| <img src="image" alt="Paper-Feeding Direction Indicator" /> | Paper-Feeding Direction Indicator |</p>
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Left Direction Indicator</td>
</tr>
<tr>
<td>→</td>
<td>Right Direction Indicator</td>
</tr>
<tr>
<td>↑</td>
<td>Up Direction Indicator</td>
</tr>
<tr>
<td>↓</td>
<td>Down Direction Indicator</td>
</tr>
</tbody>
</table>
Environmental, Health and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and
supplies, contact:

- United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
- Europe: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.
For product safety information in Europe, go to www.xerox.com/environment_europe.
Features

This chapter contains:

- Parts of the Printer ................................................................. 24
- Power Saver ........................................................................ 30
- Information Pages .................................................................. 31
- Administrative Features ......................................................... 33
- More Information .................................................................. 36
Parts of the Printer

Front View

1. Tray 2, Optional 550-Sheet Feeder
2. Tray 1
3. Bypass Tray
4. Front Door
5. Power/Wake Button
6. Touch Screen
7. Output Tray Extension
8. Right-Side Door
Rear View

1. Fuser
2. Rear Door
3. Wireless Network Adapter Port Cover
4. Left-Side Cover
5. USB Port
6. Ethernet Connection
7. Power Connector
Features

Internal Parts

1. Right-Side Door
2. Toner Cartridges
3. Drum Cartridges
4. Waste Cartridge
5. Cleaning Rod
6. Right-Side Door
Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on the printer. The control panel:

- Displays the current operating status of the printer.
- Provides access to print features.
- Provides access to reference materials.
- Provides access to Tools and Setup menus.
- Prompts you to load paper, replace supplies, and clear jams.
- Displays errors and warnings.
- Provides the Power/Wake button used for turning on or turning off the printer. This button also supports the power-saver modes, and blinks to indicate the power status of the printer.

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Back</td>
<td>This button navigates up one level in the menu.</td>
</tr>
<tr>
<td>2</td>
<td>OK/Accept</td>
<td>This button displays the selected menu or selects the current menu option.</td>
</tr>
<tr>
<td>3</td>
<td>Menu</td>
<td>This button displays the Information Pages, Billing Meters, Admin, Tray Settings, and Panel Language menus.</td>
</tr>
<tr>
<td>4</td>
<td>Information</td>
<td>This button displays additional information about error or status messages on the control panel.</td>
</tr>
</tbody>
</table>
### Features

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Control Panel Display</td>
<td>The control panel display provides information about settings, statuses, and error messages. An asterisk (*) next to a menu option indicates the current default setting.</td>
</tr>
<tr>
<td>6</td>
<td>Pause Printing</td>
<td>This button changes the printer state. When paused, communication is disconnected from the computer or print server. However, printing continues until all pages received before the pause are completed.</td>
</tr>
</tbody>
</table>
| 7    | Power/Wake                    | When the printer is off, this button turns on the printer. When the printer is on, this button displays the Power Saver menu on the control panel. From this menu, you can choose to power off the printer, or enter a low-power mode.  
This button also blinks to indicate the power status of the printer.  
- When the light blinks slow, the printer is in a low-power mode.  
- When the light blinks fast, the printer is powering up, powering down, or exiting a low-power mode. |
<p>| 8    | Print Menu                    | This button provides access to documents stored in the printer or the server, such as Secure Print.                                                                                                          |
| 9    | Up and Down Arrow Buttons     | These arrow buttons navigate to the next menu, item, or option.                                                                                                                                              |
| 10   | Cancel Job                    | This button ends the current print job.                                                                                                                                                                     |
| 11   | Printer Ready or Processing Light | The light appears green when the printer is ready to receive data, and blinks when the printer is busy receiving data.                                                                                 |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Left and Right Arrow Buttons</td>
<td>These arrow buttons move forward and back through submenus or number fields. To display Secure Jobs and Saved Jobs, press the Left arrow button.</td>
</tr>
<tr>
<td>13</td>
<td>Status LED</td>
<td>This light blinks blue or amber to indicate printer status.</td>
</tr>
<tr>
<td></td>
<td>Blue</td>
<td>• Solid blue acknowledges an Authentication request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Blinks slow-blue at completion of a print job.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Blinks fast-blue when the printer is powering up, or to signal detection of a Wi-Fi Direct connection request, like AirPrint.</td>
</tr>
<tr>
<td></td>
<td>Amber</td>
<td>• Blinks amber to indicate an error condition or warning that requires your attention. For example, an out of toner condition, a paper jam, or out of paper for the current job.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• It also blinks amber to indicate a system error, which typically is associated with an error code.</td>
</tr>
</tbody>
</table>
Power Saver

You can set the time the printer spends idle in ready mode before the printer transitions to a lower power level. For details, refer to Configuring Power Saver Using the Embedded Web Server.

There are two levels of power-saver mode.

- **Low Power Timeout**: The printer shifts from Ready mode to Low Power mode to reduce standby power consumption.
- **Sleep Timeout**: The printer shifts from Low Power mode to Sleep mode for a greater reduction in power consumption.

⚠️ **Note**: Increasing the default Power Saver activation times can result in an overall higher energy consumption of the printer.

Exiting Sleep Mode

The printer exits Low Power mode or Sleep mode automatically when it receives data from a connected device.

To exit Low Power mode or Sleep mode manually, at the control panel, press the **Power/Wake** button.
Information Pages

Your printer has a printable set of information pages. These include configuration and font information, demonstration pages, and more.

Printing Reports

1. At the control panel, press **Menu**.
2. Navigate to **Print Reports**, then press **OK**.
3. Navigate to the desired report, then press **OK**.
4. To print the report, at the prompt, press **OK**.
5. To return the printer to Ready, press **Menu**.

Specifying the Source Tray for Printing Reports

1. At the printer control panel, press **Menu**.
2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **Printer Settings**, then press **OK**.
4. Navigate to **Paper Tray Priority**, then press **OK**.
5. Navigate to the desired paper tray, then press **OK**.
6. To set the paper tray to the highest priority, navigate to **Priority 1**, then press **OK**.
7. To return the printer to Ready, press **Menu**.

   **Note:**
   - To print a report, ensure that the paper tray that you selected matches match the default paper size, type, and color.
   - The Bypass Tray cannot be set to Priority 1.
   - To print a report from the Bypass Tray, remove all the other trays, then load the default paper size, type, and color in the Bypass Tray.

Configuration Report

The Configuration Report provides product information including installed options, network settings, port setup, tray information, and more.

Printing a Configuration Report at the Control Panel

1. At the printer control panel, press **Menu**.
2. Navigate to **Print Reports**, then press **OK**.

**Note:** To navigate through the menu, use the arrow buttons.
Features

3. Navigate to Configuration, then press OK.
4. To print the report, at the prompt, press OK.
5. To return the printer to Ready, press Menu.

Configuring Printing of the Startup Page at Power On

The Startup Page provides basic printer configuration information, such as printer name, serial number, fonts, firmware, and Ethernet versions. When this feature is on, the Startup Page prints each time you power on your printer. If you do not want the Startup Page to print, you can disable the feature.

To configure the Startup page:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. Click System.

3. Click Defaults and Policies → Startup Page.
   a. To print the Startup Page at power-on, click Auto Print.
   b. To disable printing the Startup Page at power-on, click Do Not Auto Print.

4. Click OK.
Administrative Features

The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows you to configure and administer the printer from a Web browser.

The Embedded Web Server requires:

- A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
- TCP/IP and HTTP enabled in the printer.
- A network-connected computer with a Web browser that supports JavaScript.

Accessing the Embedded Web Server

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

Finding the IP Address of Your Printer

To install the print driver for a network-connected printer, it is often necessary to know the IP address of your printer. Also, the IP address is used to access the settings of your printer through the Embedded Web Server. You can view the IP address of your printer on the control panel or on the Configuration Report.

Note: Wait until the printer has been on for 2 minutes to view the TCP/IP address. If the TCP/IP address is 0.0.0.0 or begins with 169, this indicates a network connectivity issue. For details, refer to Printer Does Not Print.

Viewing the IP Printer Address on the Control Panel

To view the IP address of the printer on the control panel:

1. At the control panel, press Menu.
   
   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to Network/Port, then press OK.
4. Navigate to TCP/IP Settings, then press OK.
5. Navigate to Ethernet, then press OK.
6. Navigate to IP Address, then press OK.
   The IP address of the printer appears on the IP Address screen.
7. To return the printer to Ready, press Menu.
Obtaining the Printer IP Address from the Configuration Report

To view the IP address of the printer on the Configuration Report:

1. At the printer control panel, press Menu.
2. Navigate to Print Reports, then press OK.
3. Navigate to Configuration, then press OK.
4. To print the report, at the prompt, press OK.
5. To return the printer to Ready, press Menu.

The IP address information is located in the Communication Settings section of the Configuration Report under IPv4 and IPv6.

Certificates for the Embedded Web Server

Your device includes a self-signed HTTPS certificate. The device generates the certificate automatically during device installation. The certificate is used to encrypt communications between your computer and the Xerox device.

Note:

- The Embedded Web Server page for your Xerox device can display an error message that the security certificate is not trusted. This configuration does not lessen the security of the communications between your computer and the Xerox device.
- To eliminate the connection warning in your Web browser, you can replace the self-signed certificate with a signed certificate from a Certificate Authority. For information on obtaining a certificate from a Certificate Authority, contact your Internet Service Provider.

For information on obtaining, installing, and enabling certificates, refer to Managing Certificates.

Downloading the Configuration Report from the Embedded Web Server

From the Embedded Web Server, you can download and save a copy of the Configuration Report to your computer hard drive. Use Configuration Reports from multiple devices to compare software versions, configurations, and compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   **Note:** For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your Printer.

2. To download the Configuration Report scroll to the bottom of the page, then, in the Quick Links section, click **Download Configuration Report**.

   **Note:** If this feature does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your computer hard drive. To open the Configuration Report, use an XML viewer.
Accessing the Printer

The system administrator can set access rights on the printer to ensure that unauthorized users cannot access the printer. If the system administrator configures authentication and authorization, users require a login and a password to access some or all of the features of the printer.

Logging In at the Control Panel as the Administrator

1. At the printer control panel, press Menu.
2. If Panel Lock is On, you are prompted to enter the passcode to access the control panel menus.
3. At the prompt, to enter numbers at the control panel, select an option:
   - To select a number, press the Up or Down arrow buttons.
   - To scroll quickly, hold down the Up or Down arrow buttons.
   - To move to the next number field, press the Right arrow button.
   - To move to the previous number field, press the Left arrow button.
4. When finished, press OK.

Meter Readings

The Meter Readings menu shows the number of processed print jobs. The meter is divided according to the color mode. You cannot reset the meter readings; they track the total number of pages printed for the life of the printer.

To view the Meter Readings on the control panel:

1. At the printer control panel, press Menu.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Meter Reading, then press OK.
3. Navigate to Current Meter, then press OK.
4. After viewing the readings, to return the printer to Ready, press Menu.

To view the Usage Counters using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

3. To view more details, for Billing/Usage, click Details.
   - To view Billing Meter details, click Billing Meters.
   - To view Usage Counter details, click Usage Counters.
4. To return to the previous window, click Close.
More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Installation Guide</em></td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Other documentation for your printer</td>
<td><a href="http://www.xerox.com/office/6510docs">www.xerox.com/office/6510docs</a></td>
</tr>
<tr>
<td>Recommended Media List</td>
<td>United States: <a href="http://www.xerox.com/rmlna">www.xerox.com/rmlna</a></td>
</tr>
<tr>
<td></td>
<td>European Union: <a href="http://www.xerox.com/rmleu">www.xerox.com/rmleu</a></td>
</tr>
<tr>
<td>Technical support information for your</td>
<td><a href="http://www.xerox.com/office/6510support">www.xerox.com/office/6510support</a></td>
</tr>
<tr>
<td>printer; including online technical</td>
<td></td>
</tr>
<tr>
<td>support, Online Support Assistant, and</td>
<td></td>
</tr>
<tr>
<td>print driver downloads.</td>
<td></td>
</tr>
<tr>
<td>Information Pages</td>
<td>Print from the control panel. For details,</td>
</tr>
<tr>
<td></td>
<td>refer to Information Pages.</td>
</tr>
<tr>
<td>Order supplies for your printer</td>
<td><a href="http://www.xerox.com/office/6510supplies">www.xerox.com/office/6510supplies</a></td>
</tr>
<tr>
<td>Local sales and Technical Customer</td>
<td><a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Support</td>
<td></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
<tr>
<td>Xerox® Direct online store</td>
<td><a href="http://www.direct.xerox.com/">www.direct.xerox.com/</a></td>
</tr>
</tbody>
</table>
Installation and Setup

This chapter contains:

- Installation and Setup Overview
- Selecting a Location for the Printer
- Connecting the Printer
- Powering the Printer On and Off
- Configuring Network Settings
- Configuring AirPrint
- Configuring Google Cloud Print
- Installing the Software

For reference:

- Installation Guide packaged with your printer
- Online Support Assistant at www.xerox.com/office/6510docs
Installation and Setup

Installation and Setup Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. Configure the initial settings of the printer, then install the print driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a USB connection, and it provides access to the Embedded Web Server.

For more information, refer to Connecting the Printer.
Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 5–32°C (41–90°F), and relative humidity 15–85%.

   **Note:** Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the weight for your printer configuration, refer to Physical Specifications. Select a location with adequate clearance to access supplies and to provide proper ventilation. To find the clearance requirements for your printer, refer to Clearance Requirements.

3. After positioning the printer, you are ready to connect it to the power source and computer or network.

Opening the Output Tray Extension

To provide better support for your prints, open the Output Tray Extension. For printing on longer paper, to lengthen the Output Tray Extension, pull out the extender until it stops.
Connecting the Printer

Selecting a Connection Method

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection. The method that you select depends on how your computer is connected to the network. A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect to a network. If you are using a network connection, it is important to understand how your computer is connected to the network.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately.

USB

If you connect the printer to one computer and do not have a network, use a USB connection. A USB connection offers fast data speeds, but typically not as fast as a network connection.

Note: To access the Embedded Web Server, a network connection is required.

Network

If your computer is connected to an office network or home network, use an Ethernet cable to connect the printer to the network. You cannot connect the printer directly to the computer. A connection through a router or network switch is required. An Ethernet network can be used for one or more computers and supports many printers and systems simultaneously. An Ethernet connection is typically faster than USB and allows you direct access to the settings of the printer using the Embedded Web Server.

Wireless Network

If your environment includes a wireless router or wireless access point, you can connect the printer to the network with a wireless connection. A wireless network connection provides the same access and services as a wired connection. A wireless network connection is typically faster than USB and allows direct access to the settings of the printer using the Embedded Web Server.

Connecting to a Computer Using USB


To connect the printer to the computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
2. Connect the A end of the USB cable to the USB port on the computer.
3. If the Windows Found New Hardware Wizard appears, cancel it.
4. Install the print driver.
Connecting to a Wired Network

1. Ensure that the printer is powered off.
2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the switch or router with one cable, then connect the printer to the switch or router with the second cable. Connect to any port on the switch or router except the uplink port.
3. Attach the power cord, then plug in the printer and turn it on.
4. Set the network IP printer address, or set up the printer for automatic printer IP detection.

Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect 2 or more devices in a LAN without a physical connection. The printer can connect to a wireless LAN that includes a wireless router or wireless access point. Before connecting the printer to a wireless network, the wireless router must be configured with a service set identifier (SSID) and any necessary credentials.

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

Configuring the Printer for a Wireless Network

Note: Before you configure wireless network settings, install the Xerox® Wireless Network Adapter Kit.

If you purchased and installed a Wireless Network Adapter Kit, you can connect the device to a wireless network. If the device is connected to a wired network, you can configure wireless networking at the device, or use the Embedded Web Server.

Note: After the Wireless Network Adapter is installed, remove it only as necessary. For information on removing the adapter, refer to Removing the Wireless Network Adapter.
Installation and Setup

Installing the Wireless Network Adapter

The optional wireless network adapter plugs in to the back of the printer. After the adapter is installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless network.

To install the Wireless Network Adapter:

1. Power off the printer.

2. To remove the Wireless Network Adapter Port Cover, press down the latch, then pull the cover away from the printer.

3. Remove the packaging from the Wireless Network Adapter.
4. To install the Wireless Network Adapter, follow the procedure defined on the instruction sheet provided with the Wireless Network Adapter.

   **Note:** Pulling on the adapter can damage it. Once installed, remove it only as needed, and as directed in the Wireless Network Adapter removal instructions. For details, refer to Removing the Wireless Network Adapter.

5. Power on the printer.

6. In the Admin Menu, configure the Wi-Fi Settings.
Installation and Setup

Removing the Wireless Network Adapter

1. Power off the printer.

2. To unlatch the left-side cover, slide the handle away from the printer, then swing the handle toward the rear of the printer.
3. To remove the cover, slide it toward the back, then away from the printer.

4. Reach into the printer and push the release lever toward the front of the printer. Hold the release lever in this position and gently pull the Wireless Network Adapter away from the printer.

   ![Diagram](image1)

   **Note:** Do not use force to pull on the Wireless Network Adapter. If the latch is released properly, the adapter pulls out easily. Pulling on a secured adapter can damage it.

5. To reinstall the Wireless Network Adapter Port Cover, insert the bottom tab into the small slot. Gently press the port cover against the back of the printer until it latches into place.

   ![Diagram](image2)
Installation and Setup

6. Place the left-side cover into place, then slide it toward the front of the printer.

7. To latch the cover, swing the handle toward the front of the printer, then push the handle in until it clicks into the locked position.
8. Connect the printer to your computer with a USB cable or to a network using an Ethernet cable.


Resetting Wireless Settings

If the printer was previously installed in a wireless network environment, it could retain setup and configuration information. To prevent the printer from attempting to connect to the previous network, reset the wireless settings.

To reset the wireless settings:

1. At the printer control panel, press the **Menu** button.
   
   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Network / Port**, then press **OK**.

4. Navigate to **Wi-Fi Settings**, then press **OK**.

5. Navigate to **Cancel Settings**, then press **OK**.
Connecting to a Network with a Wi-Fi Protected Setup

Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network. The WPS protocols enable you to set up devices in a secure wireless network without having wireless networking experience. With a WPS-certified router, you can use tools in the router and the printer to connect the printer to the network. To use the tools, ensure that the wireless router is configured properly and is compliant with the WPS.

- **Push Button Connection (PBC)** is the easiest way to connect the printer to a wireless network. It automatically connects when you push a button on the router and on the printer. After the router and printer exchange information, the printer accepts the security and configuration information from the router and connects to the network. The PBC is a moderately secure way to connect the printer to the network. You do not need to enter any information to make the network connection.

- **PIN (Personal Identification Number)** automatically connects the printer to a wireless router using a common PIN. The printer generates and prints a PIN for use in the setup process. When you enter the PIN into the router, the router broadcasts network information using the PIN. When both devices recognize the PIN, the router provides the security and configuration information to the printer, which uses it to connect to the network.

To connect to a WPS wireless network using the PBC method:

- **Note:** Before you install the device, ensure that the wireless router is connected to the network and properly configured.

1. At the printer control panel, press the **Menu** button.
   - **Note:** To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Network/Port**, then press **OK**.

4. Navigate to **Wi-Fi Settings**, then press **OK**.

5. Navigate to **WPS Setup**, then press **OK**.

6. Navigate to **Start PBC**, then press **OK**.

7. At the prompt, press **OK**.

8. Within 10 seconds, on your router, press the **WPS** button. For details, refer to your router documentation. After the connection setup is complete, the printer restarts automatically.

9. After the printer restarts, wait two minutes, then to get the network information that includes the IP address, print a Configuration Report. For details, refer to Printing a Configuration Report at the Control Panel.

To connect to a WPS wireless network using the PIN method:

- **Note:** Before you install the printer, ensure that you connect and configure the wireless router for the network.

1. At your computer, open the wireless router control panel, then select **Add WPS Client**.
   - **Note:** For details, refer to your wireless router documentation.

2. Select **PIN Method**. The wireless router control panel opens to a dialog box ready for the PIN number.
   - **Note:** The following steps can vary with different router manufacturers.
3. At the printer control panel, press the **Menu** button.

4. Navigate to **Admin Menu**, then press **OK**.

5. Navigate to **Network / Port**, then press **OK**.

6. Navigate to **Wi-Fi Settings**, then press **OK**.

7. Navigate to **WPS Setup**, then press **OK**.

8. Navigate to **PIN Code**, then press **OK**.

9. Record the PIN from the screen, then press **OK**.

   The printer starts advertising using the displayed PIN Code.

   **Note:** The printer continues to advertise for 120 seconds. If the printer does not locate the wireless router within 120 seconds, the connection attempt stops.

10. At your computer, in the wireless router control panel **Client PIN Code** field, enter the PIN Code, then click **Next**.

    The printer communicates with the wireless router to resolve setup and configuration information. When the printer has the correct information, it connects to the router and restarts with the proper setup and configuration information.

    If the router does not connect with the printer within 120 seconds, the connection attempt stops.

11. After the printer restarts, wait 20 seconds, then to get the network information that includes the IP address, print a Configuration Report. For details, refer to **Printing a Configuration Report at the Control Panel**.

### Connecting to a Wireless Network Using the Control Panel Wi-Fi Setup Wizard

Before you begin, ensure that you have the wireless network Service Set Identifier (SSID), encryption type, and passphrase.

To connect to a wireless network using the Wi-Fi Setup Wizard:

1. At the printer control panel, press the **Menu** button.

   **Note:** To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Network / Port**, then press **OK**.

4. Navigate to **Wi-Fi Settings**, then press **OK**.

5. Navigate to **Access Point Search**, then press **OK**.

6. Navigate to the desired network, then press **OK**.

   **Note:** If the wireless network does not appear in the list, refer to **Connecting to a Wireless Network Manually**.

7. Enter the passcode for the selected network, then press **OK**.

8. After the printer restarts, wait two minutes, then to get the network information that includes the IP address, print a Configuration Report. For details, refer to **Printing a Configuration Report at the Control Panel**.
Connecting to a Wireless Network Manually

When connecting to a wireless network that does not include a WPS-compliant router, set up and configure the printer manually. Before starting, obtain the router setup and configuration information, such as name and passphrase. For assistance, contact your system administrator.

To connect to a wireless network manually:

1. At the printer control panel, press the Menu button.
   
   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.

3. Navigate to Network/Port, then press OK.

4. Navigate to Wi-Fi Settings, then press OK.

5. Navigate to SSID Direct Entry, then press OK.

6. Enter the network SSID (name), then press OK.

7. Depending on your network mode, navigate to Infrastructure type or Ad-hoc, then press OK.

   Note: Infrastructure provides the greatest selection of security options. Ad hoc provides only WEP encryption in most networks.

8. Select an encryption type, then press OK.
   
   • As needed, enter the passphrase for the selected network, then press OK.
   
   • If using WEP encryption, enter the WEP key and press OK, select the transmit key, then press OK.

9. After the printer restarts, wait two minutes, then to get the network information that includes the IP address, print a Configuration Report. For details, refer to Printing a Configuration Report at the Control Panel.

Connecting to Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone, using Wi-Fi Direct. Wi-Fi Direct is disabled by default. For details, refer to Connecting with Wi-Fi Direct from Your Mobile Device.

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.
Powering the Printer On and Off

The printer has a single multifunction button on the control panel. The Power/Wake button restarts, powers up, or powers down the printer. This button also enters and exits low-power mode, and flashes when the printer is in power-saver mode.

To power on the printer:
At the printer control panel, press the **Power/Wake** button.

![Power/Wake button](image)

To power off the printer:
1. At the printer control panel, press the **Power/Wake** button.

   **Note:** If the printer does not respond to a single press of the **Power/Wake** button, press and hold the button for 5 seconds. A message appears that requests you to wait for the printer to power off.
2. Navigate to **Power Off**, then press **OK**. Do not plug or unplug the power cord when the printer is powered on.

   **Note:**

   After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the printer has completed the power off process.

**Installation Wizard**

The Installation wizard starts the first time you power on the printer. The wizard prompts you with a series of questions to help you configure basic printer settings.

**Note:** You can change these settings at any time.
Configuring Network Settings

About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically assigns an IP address to every computer and printer on the network that is configured to use DHCP.

If you use a Cable or DSL router, refer to the documentation for your router for information on IP addressing.

Assigning the Printer IP Address

By default, the printer is configured to acquire an IP address from the network server using DHCP. Network addresses assigned by DHCP are temporary, however. After a specified time, the network can assign a new IP address to the printer. If the print driver is configured to use a specific IP address that changes periodically, you can experience connectivity issues. To avoid problems, or if your network administrator requires a static IP address for the printer, you can assign the IP address to the printer.

You can view the IP address of your printer on the control panel or on the Configuration Report. For details, refer to Finding the IP Address of Your Printer.

Assigning the IP Address Automatically

1. At the printer control panel, press Menu.

   ✍ Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to Network/Port, then press OK.
4. Navigate to TCP/IP Settings, then Press OK.
5. Navigate to Ethernet, then press OK.
6. Navigate to Get IP Address, then press OK.
7. Navigate to DHCP/AutoIP, then press OK.
8. Power off the printer, then power it on again.
9. Two minutes after the printer restarts, verify that the printer has obtained a valid IP Address. For details, refer to Finding the IP Address of Your Printer.
Configuring AirPrint

AirPrint® is a software feature that allows you to print from wired or wireless Apple iOS-based mobile devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers allow you to print directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print from a wired device or a wireless device without using a print driver.

Note:

- Not all applications support AirPrint®.
- Wireless devices must join the same wireless network as the printer.
- For AirPrint to function, both IPP and Bonjour® (mDNS) protocols must be enabled.
- The device that submits the AirPrint job must be on the same subnet as the printer. To allow devices to print from different subnets, configure your network to pass multicast DNS traffic across subnets.
- The Mac OS device must be Mac OS 10.10 or later.
- AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch (third generation or later), running the latest version of iOS.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, click Home→Connectivity.
   
   Note: If this feature does not appear, log in as a system administrator.

3. For Mobile Printing, click AirPrint.

4. To enable AirPrint, click the Enable toggle button.
   
   Note: AirPrint is enabled by default when IPP and Bonjour® (mDNS) are both enabled.

   - To change the printer name, in the Name field, enter a new name.
   - To enter a location for the printer, in the Location field, enter the location of the printer.
   - To enter a physical location or address for the printer, in the Geo-Location field, enter the geographic latitude and longitude coordinates in decimal form. For example, use coordinates such as 45.325026, -122.766831 for a location.

5. Click OK.

6. To activate your changes, at the prompt, click Restart Now.
Configuring Google Cloud Print

Google Cloud Print allows you to print documents that are stored in the cloud without using a print driver.

Before you begin:

- Set up a Google email account.
- Configure the printer to use IPv4.
- Configure Proxy Server settings as needed.

To configure Google Cloud Print:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, click Home → Connectivity.

3. For Mobile Printing, click Google Cloud Print.

4. To enable Google Cloud Print, click the Enable toggle button.

5. Click OK.

6. Restart the printer, then wait 2 minutes for the printer to connect.

7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print.

8. Click Printer Registration.

9. Click Register.

   A printer registration page prints.

10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to scan the barcode.

   After the printer is registered, a confirmation status window appears.

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.

   Note: The default printer name appears in this format: Model name (MAC address).
Installing the Software

Before installing driver software, verify that the printer is plugged in, powered on, connected correctly, and has a valid IP address. The IP address usually appears in the upper, right corner of the control panel. If you cannot find the IP address, see Finding the IP Address of Your Printer.

Note:

If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/office/6510drivers.

Operating System Requirements

- Macintosh OS X version 10.9 and later.
- UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

Installing the Print Drivers for a Windows Network Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
2. Select your printer model.
3. Click Install Print Driver.
4. At the License Agreement, click I Agree.
5. From the list of discovered printers, select your printer.

   Note: When installing drivers for a network printer, if your printer does not appear in the list, click the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your printer, then click Search to locate and select your printer. If you do not know the IP address of the printer, refer to Finding the IP Address of Your Printer.

6. Click Next.
7. If desired, you can name your printer by typing a name in the Queue Name field.
8. Make a print driver selection.
9. Click Install.
10. If desired, set the printer as the default printer.

   Note: Before selecting Share Printer, contact your system administrator.

11. To complete the installation, click Finish, then click Close.
Installing the Print Drivers for a Windows USB Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
   If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
2. Click Install Software.
3. At the License Agreement, select I Agree, then click Next.
4. To install the printer support software, select Software, then click Next.
5. In the Software and Documentation window, clear the check box for any undesired options.
6. Click Next.
7. To complete the installation, click Finish.

Installing the Drivers and Utilities for Macintosh OS X

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.
4. When prompted, click Continue.
5. To accept the license agreement, click I Agree.
6. To accept the current installation location, click Install, or select another location for the installation files, then click Install.
7. If prompted, enter your password, then click OK.
8. From the list of discovered printers, select your printer, then click Next.
9. If your printer does not appear in the list of discovered printers:
   a. Click the Network Printer Icon.
   b. Type the IP address of your printer, then click Continue.
   c. Select your printer in the list of discovered printers, then click Continue.
10. If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is connected properly.
11. To accept the print queue message, click OK.
12. Select or clear the Set Printer as Default and Print a Test Page check boxes.
13. Click Continue, then click Close.
**Adding the Printer**

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection.

To add the printer using Bonjour:

1. From the computer Applications folder or from the dock, open **System Preferences**.
2. Click **Printers & Scanners**.
   The list of printers appears on the left of the window.
3. Under the list of printers, click the **Plus** button (+).
4. At the top of the window, click the **Default** icon.
5. Select your printer from the list, then click **Add**.

   ⚠️ **Note:** If your printer was not detected, verify that the printer is on and that the Ethernet cable is connected properly.

To add the printer by specifying the IP address:

1. From the computer Applications folder or from the dock, open **System Preferences**.
2. Click **Printers & Scanners**.
   The list of printers appears on the left of the window.
3. Under the list of printers, click the **Plus** button (+).
4. Click **IP**.
5. From the Protocol drop-down menu, select the protocol.
6. In the Address field, enter the IP address of the printer.
7. In the Name field, enter a name for the printer.
8. From the Print Using drop-down list, choose **Select a driver to use**.
9. From the printer software list, select the print driver for your printer model.
10. Click **Add**.

For reference:

   Online Support Assistant at: [www.xerox.com/office/6510support](http://www.xerox.com/office/6510support)

**Installing Drivers and Utilities for UNIX and Linux**

For more information on installing print drivers and utilities for UNIX and Linux, refer to [UNIX and Linux Printing](http://www.xerox.com/office/6510support).
Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated services across a network. WSD supports device discovery, control, and use.

To install a WSD printer using the Add Device Wizard:

1. At your computer, click **Start**, then select **Devices and Printers**.
2. To launch the Add Device Wizard, click **Add a Device**.
3. In the list of available devices, select the one you want to use, then click **Next**.

*Note:* If the printer you want to use does not appear in the list, click the **Cancel** button.

Add the WSD printer manually using the Add Printer Wizard.

4. Click **Close**.

To install a WSD printer using the Add Printer Wizard:

1. At your computer, click **Start**, then select **Devices and Printers**.
2. To launch the Add Printer Wizard, click **Add a Printer**.
3. Click **Add a network, wireless, or Bluetooth printer**.
4. In the list of available devices, select the one you want to use, then click **Next**.
5. If the printer you want to use does not appear in the list, click **The printer that I want is not listed**.
6. Select **Add a printer using a TCP/IP address or hostname**, then click **Next**.
7. From the Device type field, select **Web Services Device**.
8. Enter the printer IP address in the Hostname or IP address field, then click **Next**.
9. Click **Close**.
Paper and Media

This chapter contains:

- Supported Paper ................................................................. 62
- Loading Paper ........................................................................ 68
- Printing on Special Paper ...................................................... 75

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:
Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:

- [www.xerox.com/rmlna](http://www.xerox.com/rmlna) Recommended Media List (United States)
- [www.xerox.com/rmleu](http://www.xerox.com/rmleu) Recommended Media List (Europe)

Ordering Paper

To order paper or other media, contact your local reseller or visit [www.xerox.com/office/6510supplies](http://www.xerox.com/office/6510supplies).

General Paper Loading Guidelines

- Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
- Adjust the paper guides to fit the paper size.
- Fan paper before loading it in the paper tray.
- If excessive jams occur, use paper or other approved media from a new package.
- Do not print on label media after a label has been removed from a sheet.
- Use only paper envelopes. Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media
- Transparencies
Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.
- Reduce the exposure of paper to strong lights for long periods of time.
- Maintain constant temperatures and relative humidity.
- Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
- Store paper flat, either on pallets, cartons, shelves, or in cabinets.
- Avoid food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load the paper into the printer. Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain.
- Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are ready to use it. Keep unused media in the bag and reseal it for protection.
## Supported Paper Types and Weights

<table>
<thead>
<tr>
<th>Trays</th>
<th>Paper Types</th>
<th>Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Trays</td>
<td>Recycled</td>
<td>60–80 g/m²</td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td>60–90 g/m²</td>
</tr>
<tr>
<td></td>
<td>Bond</td>
<td>75–105 g/m²</td>
</tr>
<tr>
<td></td>
<td>Hole-Punched</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Plain</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pre-Printed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lightweight Cardstock</td>
<td>106–176 g/m²</td>
</tr>
<tr>
<td></td>
<td>Lightweight Glossy Cardstock</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cardstock</td>
<td>177–220 g/m²</td>
</tr>
<tr>
<td></td>
<td>Glossy Cardstock</td>
<td></td>
</tr>
<tr>
<td>Tray 1 and Bypass Tray</td>
<td>Envelope</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Labels</td>
<td></td>
</tr>
</tbody>
</table>
## Supported Standard Paper Sizes

<table>
<thead>
<tr>
<th>Tray</th>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1 and Bypass Tray</td>
<td>A6 (105 x 148 mm, 4.1 x 5.8 in.) A5 (148 x 210 mm, 5.8 x 8.3 in.) A4 (210 x 297 mm, 8.3 x 11.7 in.) 215 x 315 mm, 8.5 x 12.4 in. DL Envelope (110 x 220 mm, 4.33 x 8.66 in.) C6 Envelope (114 x 162 mm, 4.5 x 6.38 in.)</td>
<td>Postcard (102 x 152 mm, 4 x 6 in.) 127 x 178 mm, 5 x 7 in. Statement (140 x 216 mm, 5.5 x 8.5 in.) Executive (184 x 267 mm, 7.25 x 10.5 in.) 203 x 254 mm, 8 x 10 in. Letter (216 x 279 mm, 8.5 x 11 in.) Folio (216 x 330 mm, 8.5 x 13 in.) Legal (216 x 356 mm, 8.5 x 14 in.) Monarch Envelope (98 x 190 mm, 3.9 x 7.5 in.) No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)</td>
</tr>
<tr>
<td>Tray 2</td>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.) A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.) Letter (216 x 279 mm, 8.5 x 11 in.) Folio (216 x 330 mm, 8.5 x 13 in.) Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
</tbody>
</table>

## Supported Paper Types and Weights for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recycled</td>
<td>60–80 g/m²</td>
</tr>
<tr>
<td>Custom</td>
<td>60–90 g/m²</td>
</tr>
</tbody>
</table>
### Paper Type and Weight

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bond</td>
<td>75–105 g/m²</td>
</tr>
<tr>
<td>Hole-Punched</td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Plain</td>
<td></td>
</tr>
<tr>
<td>Pre-Printed</td>
<td></td>
</tr>
<tr>
<td>Lightweight Cardstock</td>
<td>106–176 g/m²</td>
</tr>
<tr>
<td>Lightweight Glossy Cardstock</td>
<td></td>
</tr>
</tbody>
</table>

### Supported Custom Paper Sizes

<table>
<thead>
<tr>
<th>Tray Number</th>
<th>Paper Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>Minimum: 76 x 148 mm (3 x 5.8 in.)</td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td>Tray 2</td>
<td>Minimum: 76 x 191 mm (3 x 7.5 in.)</td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td>Bypass Tray</td>
<td>Minimum: 76 x 127 mm (3 x 5 in.)</td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td>2-Sided Printing, DN model only</td>
<td>Minimum: 140 x 210 mm (5.5 x 8.3 in.)</td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
</tbody>
</table>

### Setting the Tray Mode

Tray mode determines if you are prompted to confirm or modify paper settings when you load paper in the tray. Tray mode also defines how the printer behaves when a paper conflict or mismatch occurs.

To enable Bypass Mode:

1. At the printer control panel, press **Menu**.

   ➔ **Note:** To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **Printer Settings**, then press **OK**.
4. Navigate to **Bypass Mode**, then press **OK**.
5. Navigate to On, then press OK. When On, the Bypass Tray is set as the default tray for all print jobs without a specified tray.

6. To return the printer to Ready, press Menu.

To configure tray-prompt modes:
1. At the printer control panel, press Menu.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to Printer Settings, then press OK.
4. Navigate to During Loading, then press OK.
5. Navigate to the desired mode:
   - Allow Change: This mode prompts you to confirm or modify paper tray settings when paper is loaded in a tray.
   - No Attrib. Change: This mode hides paper tray attribute prompts.
6. Press OK.
7. To return the printer to Ready, press Menu.
Loading Paper

Loading Paper in the Bypass Tray

1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a different size or type.

2. Pull out the extension tray for larger sizes.

3. Move the width guides to the edges of the tray.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.
5. Load the paper in the tray. Load hole-punched paper with the holes to the left.

- For 1-sided printing, load Letterhead or pre-printed paper face up with the top edge going into the printer.

- For 2-sided printing, load Letterhead and pre-printed paper face down with the top edge going into the printer.

  Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Adjust the width guides until they touch the edges of the paper.
7. If the control panel prompts you, verify the paper size and type on the screen. If not, change the paper settings.
   a. At the printer control panel, press Menu.
      
      Note: To navigate through the menu, use the arrow buttons.
   b. Navigate to Admin Menu, then press OK.
   c. Navigate to Printer Settings, then press OK.
   d. To select the paper type, navigate to Paper Type, then press OK.
   e. Navigate to the desired tray, then press OK.
   f. To select the desired paper setting, press the arrow buttons, then press OK.
   g. To return to the Printer Settings menu, press the Left arrow button twice.
   h. To select paper size, navigate to Paper Size Settings, then press OK.
   i. Navigate to the desired tray, then press OK.
   j. To select a paper-size setting, press the arrow buttons, select the setting, then press OK.

8. To return the printer to Ready, press Menu.

**Configuring Trays 1 or 2 for the Paper Length**

You can adjust the lengths of trays 1 and 2 to accommodate A4/Letter and Legal paper sizes. In the Legal length settings, the trays protrude from the front of the printer.

To change Trays 1 and 2 to match the paper length:

1. Remove all paper from the tray.
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.
3. To compress the tray for shorter paper, hold the back of the tray with one hand. With the other hand, press the release latch at the front of the tray, then push the ends inward until they latch.

![Image of tray being compressed]

4. To extend the tray for longer paper, hold the back of the tray with one hand. With the other hand, press the release latch at the front of the tray and pull the ends outward until they latch.

5. To protect the paper when the tray is extended, place the paper cover over the extended section of the paper tray.

![Image of tray being extended]

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer.

6. Load paper into the tray before inserting it back into the printer. For details, refer to Loading Paper into Trays 1 and 2.
Loading Paper into Trays 1 and 2

1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.

2. Adjust the paper length and width guides to fit the paper size.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.
4. Load paper into the tray with the print side face up.
   - Load hole-punched paper with the holes to the left.
   - For 1-sided printing, load Letterhead face up with the top of the paper toward the back of the tray.
   - For 2-sided printing, load Letterhead face down with the top of the paper toward the back of the tray.

   **Note:** Do not load paper above the maximum fill line. Overfilling can cause paper jams.

5. Adjust the paper length and width guides until they touch the edges of the paper.

6. Slide the tray back into the printer.
7. Push the tray in all the way.

   **Note:**
   - If the tray does not go all the way in, ensure that the paper lift at the back of the tray is locked down.
   - To avoid paper jams, do not remove the paper cover while printing is in progress.
   - If the tray is extended for Legal-size paper, the tray protrudes when it is inserted into the printer.

8. If the control panel prompts you, verify the paper size and type on the screen. If you are not prompted, change the paper settings.
   a. At the printer control panel, press **Menu**.
      **Note:** To navigate through the menu, use the arrow buttons.
   b. Navigate to **Admin Menu**, then press **OK**.
   c. Navigate to **Printer Settings**, then press **OK**.
   d. To select the paper type, navigate to **Paper Type**, then press **OK**.
   e. Navigate to the desired tray, then press **OK**.
   f. To select the desired paper setting, press the arrow buttons, then press **OK**.
   g. To return to the Printer Settings menu, press the **Left** arrow button twice.
   h. To select paper size, navigate to **Paper Size Settings**, then press **OK**.
   i. Navigate to the desired tray, then press **OK**.
   j. To select a paper-size setting, press the arrow buttons, select the setting, then press **OK**.

9. To return the printer to Ready, press **Menu**.
Printing on Special Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/6510supplies.

For reference:
- www.xerox.com/rmlna Recommended Media List (United States)
- www.xerox.com/rmleu Recommended Media List (Europe)

Envelopes

You can print envelopes from Tray 1 or the Bypass Tray.

Guidelines for Printing Envelopes

- Use only paper envelopes.
- Do not use envelopes with windows or metal clasps.
- Print quality depends on the quality and construction of the envelopes. If you do not get the desired results, try another envelope brand.
- Maintain constant temperatures and relative humidity.
- Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.
- Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of the envelopes.
- In the print driver software, select Envelope as the paper type.
- Do not use padded envelopes. Use envelopes that lie flat on a surface.
- Do not use envelopes with heat-activated glue.
- Do not use envelopes with press-and-seal flaps.
Loading Envelopes in the Bypass Tray

1. Open the bypass tray.

2. Move the width guides to the edges of the tray.

Note:

- Do not load more than five envelopes in the Bypass Tray.
- If you do not load envelopes in the bypass tray right after they have been removed from the packaging, they can bulge. To avoid jams, flatten the envelopes.
3. To load the envelopes, select an option:
   - For Number 10 envelopes, load the envelopes with the short edge going into the printer, flaps down, and flaps to the right.

   ![Image of Number 10 envelope loading](image)

   - For Monarch or DL envelopes, do one of the following. If the envelopes wrinkle, try another option.
     - Load envelopes with the short edge going into the printer, flaps down, and flaps to the right.

   ![Image of Monarch or DL envelope loading](image)

   - Load envelopes with the print side up, flaps open and down, and the bottom of the envelope going into the printer.

   ![Image of Monarch or DL envelope loading](image)
• Load envelopes with the print side up, flaps closed and down, and flaps going into the printer.

• For C5 envelopes, do one of the following. If the envelopes wrinkle, try another option.
  • Load envelopes with the print side up, flaps open and down, and the bottom of the envelope going into the printer.

  \[\text{Note: When you load envelopes with the flaps open, in the print driver, select \textit{Portrait}, \textit{Landscape}, or \textit{Rotated Landscape}, as needed, to have them print correctly. In the print driver, use \textit{Rotate Image 180 Degrees} to flip the image, if needed.}\]

4. If the control panel prompts you, verify the envelope size and type on the screen. If not, change the paper settings.
   a. At the printer control panel, press \textit{Menu}.
      \[\text{Note: To navigate through the menu, use the arrow buttons.}\]
   b. Navigate to \textit{Admin Menu}, then press \textit{OK}.
   c. Navigate to \textit{Printer Settings}, then press \textit{OK}.
   d. To select the paper type, navigate to \textit{Paper Type}, then press \textit{OK}.
   e. Navigate to \textit{Bypass Tray}, then press \textit{OK}.
f. Navigate to Envelope, then press OK.
g. To return to the previous menu, press the Left arrow button.
h. To select paper size, navigate to Paper Size Settings, then press OK.
i. Navigate to Bypass Tray, then press OK.
j. To select an envelope size, press the arrow buttons, select the size, then press OK.

5. To return the printer to Ready, press Menu.

Loading Envelopes in Tray 1

1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.

![Tray 1](image1)

2. Adjust the paper length and width guides as illustrated.

![Guides](image2)

3. Load envelopes in the trays with the flaps closed, flap-side down, and the short edge leading into the printer.

   **Note:** Do not load more than 50 envelopes (or more than 45 mm in height).
4. Slide the tray back into the printer.

5. Push the tray in all the way.

6. If the control panel prompts you, verify the size and type on the screen. If you are not prompted, change the paper settings.
   a. At the printer control panel, press Menu.
      
      **Note:** To navigate through the menu, use the arrow buttons.
   b. Navigate to Admin Menu, then press OK.
   c. Navigate to Printer Settings, then press OK.
   d. To select the paper type, navigate to Paper Type, then press OK.
   e. Navigate to the desired tray, then press OK.
   f. To select the desired paper setting, press the arrow buttons, then press OK.
   g. To return to the Printer Settings menu, press the Left arrow button twice.
   h. To select paper size, navigate to Paper Size Settings, then press OK.
   i. Navigate to the desired tray, then press OK.
   j. To select a paper-size setting, press the arrow buttons, select the setting, then press OK.

7. To return the printer to Ready, press Menu.

**Labels**

You can print labels from the Bypass Tray or Tray 1.

**Guidelines for Printing Labels**

- Use labels designed for laser printing.
- Do not use vinyl labels.
- Do not feed a sheet of labels through the printer more than once.
- Do not use dry gum labels.
- Print only on one side of the sheet of labels. Use full-sheet labels only.
- Store unused labels flat in their original packaging. Leave the label sheets inside the original packaging until ready to use. Return any unused label sheets to the original packaging and reseal it.
• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing labels in extreme conditions can cause print-quality problems or cause labels to jam in the printer.
• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.
• In the print driver software, select Label as the paper type.
• Before loading labels, remove all other paper from the tray.

WARNING:

Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could damage the printer.

Loading Labels in the Bypass Tray

1. Remove all paper from the tray.

2. Load labels in the bypass tray, face up, with the top edge of the page feeding into the printer.

3. Adjust the width guides until they touch the edges of the paper.

4. If the control panel prompts you, verify the size and type on the screen. If not, change the paper settings.
   a. At the printer control panel, press Menu.
      
      Note: To navigate through the menu, use the arrow buttons.

   b. Navigate to Admin Menu, then press OK.
   c. Navigate to Printer Settings, then press OK.
   d. To select the paper type, navigate to Paper Type, then press OK.
   e. Navigate to the desired tray, then press OK.
Paper and Media

f. To select the desired paper setting, press the arrow buttons, then press OK.
g. To return to the Printer Settings menu, press the Left arrow button twice.
h. To select paper size, navigate to Paper Size Settings, then press OK.
i. Navigate to the desired tray, then press OK.
j. To select a paper-size setting, press the arrow buttons, select the setting, then press OK.

5. To return the printer to Ready, press Menu.

Loading Labels in Tray 1

1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.

2. Adjust the paper length and width guides as illustrated.
3. Load the label-sheets in the tray, face up.

   Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

4. Slide the tray back into the printer.

5. Push the tray in all the way.

6. The printer prompts you to verify the label-sheet size and type.
   a. Touch Paper Size and select the size of the label-sheet. Select OK.
   b. Touch Paper Type and select Label. Select OK.
   c. Navigate to Printer Settings, then press OK.
   d. To select the paper type, navigate to Paper Type, then press OK.
   e. Navigate to Tray 1, then press OK.
   f. Navigate to Labels, then press OK.
   g. To return to the Printer Settings menu, press the Left arrow button twice.
   h. To select a paper-size setting, navigate to Paper Size Settings, then press OK.
   i. Navigate to Tray 1, then press OK.
   j. To select a paper-size setting, press the arrow buttons, select the setting, then press OK.

7. To return the printer to Ready, press Menu.
Glossy Cardstock

You can print Cardstock and Glossy Cardstock up to 220 g/m² from any tray. For 2-Sided printing on cardstock, refer to Supported Paper Types and Weights for Automatic 2-Sided Printing.

Guidelines for Printing on Glossy Cardstock

- Do not open sealed packages of glossy cardstock until you are ready to load paper into the printer.
- Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until ready to use.
- Remove all other paper from the tray before loading glossy cardstock.
- Load only the amount of glossy cardstock you are planning to use. When you are finished printing, remove the cardstock from the paper tray. Replace unused cardstock in the original wrapper and seal.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to curl and jam in the printer.
- In the print driver software, select the glossy cardstock type, or select the tray loaded with the required paper.
Printing

This chapter contains:

- Printing Overview .................................................................................................................. 86
- Selecting Printing Options ....................................................................................................... 87
- Printing Features ...................................................................................................................... 93
Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure that you have the correct print driver software installed on your computer. For details, refer to Installing the Software.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.
3. Access the print settings in your software application. For most software applications, press CTRL +P for Windows, or CMD+P for Macintosh.
4. Select your printer.
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox Features for Macintosh. The title of the button can vary depending on your application.
6. Modify the print driver settings as necessary, then click OK.
7. Click Print to send the job to the printer.
Selecting Printing Options

Printing options, also called print driver software options, are specified as Printing preferences in Windows and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality. Printing options that are set from Printing preferences within the Devices and Printers window become the default setting. Printing options that are set from within the software application are temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the Help button (?) in the bottom, left corner of the Printing Preferences window to see the Help.

Information about Printing Preferences appears in the Help window. From there, you can select by topic or use the search field to enter the topic or function for which you need information.

Windows Printing Options

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before sending the job to the printer.

1. With the document open in your software application, access the print settings. For most software applications, click File → Print or press CTRL+P for Windows.

2. Select your printer and click the Properties or Preferences button to open the Printing Preferences window. The title of the button can vary depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.

4. Click OK to save and close the Printing Preferences window.

5. Click Print to send the job to the printer.
Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the Printing Preferences window. You can specify your most common printing options and save them so that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing Preferences.

To select default printing options:

1. Navigate to the list of printers on your computer:
   - For Windows Vista, click Start → Control Panel → Hardware and Sound → Printers.
   - For Windows Server 2008 and later, click Start → Settings → Printers.
   - For Windows 7, click Start → Devices and Printers.
   - For Windows 8, right-click the Start Menu, then click Control Panel → Devices and Printers.
   - For Windows 10, right-click the Start Menu, then click Start → Control Panel → Devices and Printers.

   **Note:** If you are using a custom Start Menu application, it can change the navigation path to your list of printers.

2. In the list, right-click the icon for your printer and click Printing Preferences.

3. In the Printing Preferences window, click a tab, select the options, then click OK to save.

   **Note:** For more information about Windows print driver options, click the Help button (?) in the Printing Preferences window.

Selecting Printing Defaults in Windows for a Shared Network Printer

1. Navigate to the list of printers on your computer:
   - For Windows Vista®, click Start → Control Panel → Hardware and Sound → Printers.
   - For Windows Server 2008 and later, click Start → Settings → Printers.
   - For Windows 7, click Start → Devices and Printers.
   - For Windows 8, click Control Panel → Devices and Printers.
   - For Windows 10, click Start → Control Panel → Devices and Printers.

   **Note:** If the Control Panel icon does not appear on the desktop, right-click on the desktop, then select Personalize → Control Panel Home → Devices and Printers.

2. In the Printers folder, right-click the name of your print driver and select Printer properties.

3. In the printer Properties dialog box, click the Advanced tab.

4. On the Advanced tab, click Printing Defaults.

5. Make your selections on the print driver tabs as needed, then click Apply.

6. To save the settings, click OK.
Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. With the document open in your application, click File→Print.
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences.
3. In the Printing Properties window, click the tabs, then select the desired settings.
4. In the Printing Properties window, click Saved Settings, then click Save As.
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, then click OK.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File→Print.
2. Select your printer.
3. Select Xerox Features from the Copies & Pages menu.
4. Select the desired printing options from the drop-down lists.
5. Click Print to send the job to the printer.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. With the document open in your application, click File→Print.
2. Select your printer from the Printers list.
3. Select the desired printing options from the drop-down lists in the Print dialog box.
4. Click Presets→Save As.
5. Type a name for the printing options, then click OK to save the set of options in the Presets list.
6. To print using these options, select the name from the Presets list.

UNIX and Linux Printing

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux environments.

The Xerox® print drivers provide a GUI-based (Graphical User Interface) driver dialog for printer feature selections. You can select print drivers based on your operating system.
Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in UNIX and Linux environments.

Xerox® Printer Manager allows you to:

- Configure and check the status of network connected printers.
- Set up a printer on your network and monitor the operation of the printer once installed.
- Perform maintenance checks and view supplies status at any time.
- Provide a common look and feel across the many different suppliers of UNIX and Linux operating systems.

Installing the Xerox® Printer Manager

Before you begin:

Ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install the Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your printer, go to www.xerox.com/office/drivers.
2. On the print driver website, navigate to your printer model.
3. For your printer model, click Drivers & Downloads.
4. From the Operating System menu, select your operating system.
5. To identify the print driver for your printer model, review the list of available print drivers.

   Note: For additional information on each driver, click Description.

6. To select the print driver for your printer model and operating system, click its name.
7. To begin the download, read the End User License Agreement, then click accept.
   The file automatically downloads to the default location for your computer file downloads.
8. To install the Xerox® Print Driver package:
   a. Open the package with your OS package manager.
   b. To install using a command-line utility, change to the directory where you downloaded the file. To run the installer, type the appropriate command-line utility for your operating system. For example:
      - Red Hat: rpm -U <filename>.rpm
      - Debian-based Linux: dpkg -i <filename>.deb
      - AIX: rpm -U <filename>.rpm
      - HPUX: <filename>.depot.gz
      - Solaris: pkgadd -d <filename>.pkg

   Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information about utilities included in the OS package manager, refer to the manual included with the package. For example, man xeroxprtmgr.
Launching Xerox® Printer Manager
To launch Xerox® Printer Manager, do one of the following tasks.

- For UNIX, log in as root. From a terminal window, type `xosdprtmgr`, then press Enter or Return.
- For Linux, type `sudo xeroxprtmgr`, then press Enter or Return.

Printing with xeroxprint
Xerox has its own print command. You can use the following command:

`xeroxprint -d<Some_Queue -o[Options] <Somefile`

Printing from a Linux Workstation
To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common UNIX Printing System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate drivers for your printer, go to www.xerox.com/office/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for installing and building CUPS are contained in the *CUPS Software Administrators Manual*, written and copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer to the *CUPS Software Users Manual* available from www.cups.org/documentation.php.

Installing the PPD on the Workstation
1. If available, download the Xerox® PPD for CUPS from the Drivers and Downloads page on the Xerox Support website.
2. Copy the PPD into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location of the folder, use the Find command to locate the PPD files.
3. Follow the instructions that are included with the PPD.

Adding the Printer
1. Verify that the CUPS (Common UNIX Printing System) daemon is running.
2. Open a Web browser and type `http://localhost:631/admin`, then click Enter or Return.
3. For User ID, type `root`. For password, type the root password.
4. Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.

1. To print to a specific printer in System V, type `lp -dprinter filename`, then click Enter.
2. To print to a specific printer in Berkeley, type `lpr -Pprinter filename`, then click Enter.

Mobile Printing Options
This printer can print from iOS and Android mobile devices. For more information, refer to Configuring Google Cloud Print.
Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone, using Wi-Fi Direct.

For details, refer to Connecting to Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note: Depending on which mobile device you are using, the printing procedure varies.

Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint. To enable AirPrint for your printer, refer to Configuring AirPrint. To use AirPrint, ensure that your mobile device is connected to the wireless network.

To print with AirPrint:

1. Open the email, photograph, website page, or document that you want to print.
2. Tap the Action icon.
3. Tap Print.
4. Select your printer, then set the printer options.
5. Tap Print.

Printing from a MOPRIA-Enabled Mobile Device

MOPRIA™ is a software feature that enables users to print from mobile devices without requiring a print driver. You can use MOPRIA™ to print from your mobile device to MOPRIA™-enabled printers.

Note:

- MOPRIA™ and all of its required protocols are enabled by default.
- Ensure that you have the latest version of the MOPRIA™ Print Service installed on your mobile device. You can obtain a free download from the Google Play Store.
- Wireless devices must join the same wireless network as the printer.
- The name and location of your printer appears in a list of MOPRIA™-enabled printers on connected devices.

To print using MOPRIA™, follow the directions provided with your mobile device.
Printing Features

Viewing Jobs in the Embedded Web Server
From the Jobs window in the Embedded Web Server, you can view a list of active and completed print jobs.

Printing Special Job Types
Special job types allow you to send a print job from your computer, then print it from the printer control panel. To select special job types from the print driver, select Printing Options → Job Type.

Secure Print
Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until you enter your passcode at the printer control panel.

To print a Secure Print job, refer to Printing a Secure Print Job.

Printing a Secure Print Job
1. In your software application, access the print settings. For most software applications, press CTRL +P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   • For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   • For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. For Job Type, select Secure Print.
4. Type the passcode, confirm the passcode, then click OK.
5. Select any other required printing options.
   • For Windows, click OK, then click Print.
   • For Macintosh, click Print.

Releasing a Secure Print Job
1. If the control panel is dark, press the Power/Wake button.
2. Press the Print Menu button.
3. Use the arrows to navigate to Personal & Secure, then press OK.
4. Navigate to your user name, then press OK.
5. At the passcode prompt, navigate to Enter, then press OK.
6. To enter your passcode, use the arrow buttons, then press OK.
7. Navigate to the desired job, or navigate to All Jobs, then press OK.
8. Select an option:
   • To print the jobs, navigate to Print, then press OK.
   • To delete the jobs without printing, navigate to Delete, then press OK.
9. At the prompt, press **OK**.
10. To return to the Ready screen, press the **Print Menu** button.

**Personal Print**

Personal Print allows you to store a document in the printer, then print it from the control panel.

> **Note:** The Personal Print feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:

- A Personal Print job appears in a folder named after the user ID associated with the print job.
- A Personal Print job does not use a passcode.
- Any user can print or delete a Personal Print job.
- You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.
- After a Personal Print job is printed, it is deleted automatically.

To print a Personal Print job, refer to **Printing a Personal Print Job**.

**Printing a Personal Print Job**

1. In your software application, access the print settings. For most software applications, click **File → Print** or for Windows, press **CTRL+P**.
2. Select your printer, then click **Printer Properties**. Depending on your application, the title of the button varies.
3. For **Job Type**, select **Personal Print**.
4. Select any other required printing options, then click **OK**.
5. To send the job to the printer, click **Print**.

**Releasing a Personal Print Job**

1. If the control panel is dark, press the **Power/Wake** button.
2. Press the **Print Menu** button.
3. Use the arrows to navigate to **Personal & Secure**, then press **OK**.
4. Navigate to your user name, then press **OK**.
5. Navigate to the desired job, or navigate to **All Jobs**, then press **OK**.
6. Select an option:
   - To print the jobs, navigate to **Print**, then press **OK**.
   - To delete the jobs without printing, navigate to **Delete**, then press **OK**.
7. At the prompt, press **OK**.
8. To return to the Ready screen, press the **Print Menu** button.
Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

- A Sample Set job appears in a folder named after the user ID associated with the print job.
- A Sample Set job does not use a passcode.
- Any user can print or delete a Sample Set job.
- A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing a Sample Set.

Printing a Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL +P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   - For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   - For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. For Job Type, select Sample Set.
4. Select any other required printing options.
   - For Windows, click OK, then click Print.
   - For Macintosh, click Print.

Releasing a Sample Set

1. If the control panel is dark, press the Power/Wake button.
2. Press the Print Menu button.
3. Use the arrows to navigate to Sample Set, then press OK.
4. Navigate to your user name, then press OK.
5. Navigate to the desired job, then press OK.
6. If your review of the printed copy is acceptable, print more copies.
   - Navigate to Print, then press OK.
   - Use the arrows to select the number of copies to print, then press OK.
   - At the prompt, press OK.
7. To delete the job without printing more copies, navigate to Delete, then press OK.
8. To return to the Ready screen, press the Print Menu button.
Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses the settings for portrait or landscape orientation from the application for printing the document.

Note: Ensure that the paper size and weight are supported. For more information, refer to Supported Paper Types and Weights for Automatic 2-Sided Printing.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings override the application page orientation settings.

- **1-Sided Print**: This option prints on one side of the media. Use this option when printing on envelopes, labels, or other media that cannot be printed on both sides.

- **2-Sided Print**: This option prints the job on both sides of the paper to allow binding on the long edge of the paper. The following illustrations show the result for documents with portrait and landscape orientation, respectively:

![2-Sided Print Illustration](image)

- **2-Sided Print, Flip on Short Edge**: This option prints on both sides of the paper. The images print to allow binding on the short edge of the paper. The following illustrations show the result for documents with portrait and landscape orientations, respectively:

![2-Sided Print, Flip on Short Edge Illustration](image)

Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Setting Default Printing Options for Windows.
Orientation

To select the default orientation:

1. In the print driver, on the Document Options tab, click the Orientation tab.
2. Select an option:
   - **Portrait**: Orients the paper so that the text and images print across the short dimension of the paper.
   
   ![Portrait](image)

   - **Landscape**: Orients the paper so that the text and images print across the long dimension of the paper.

   ![Landscape](image)

   - **Rotated Landscape**: Orients the paper so that the content is rotated 180 degrees and with the long bottom side up.

   ![Rotated Landscape](image)

3. Click OK.

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the desired paper.

Printing Multiple Pages to a Single Sheet

When printing a multiple-page document, you can print more than one page on a single sheet of paper.

To print 1, 2, 4, 6, 9, or 16 pages per side, select **Pages Per Sheet** on the Pages Per Sheet Page Layout tab.

- For Windows, Page Layout is on the Document Options tab.
- For Macintosh, in the Print window, Layout is on the Preview list.

![Pages Per Sheet](image)

To print a border around each page, select **Page Borders**.
Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets from any paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of paper, two page images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create the booklet.

- For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document Options tab.
- For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.

- **Gutter**: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).
- **Creep**: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can select a value from zero to 1 point.

Print Quality

Print-quality modes:

- Standard print-quality mode: 600 x 600 dpi
- Enhanced print-quality mode: 1200 x 1200 dpi

Image Options

Image options controls the way the printer uses color to produce your document. The Windows PostScript and the Macintosh drivers provide the widest range of color controls and corrections on the Image Options tab.

To convert all color in the document to black and white or shades of gray, select **Xerox Black and White**.

The printer provides the following color correction options:
• Xerox Automatic Color: This option applies the best color correction to text, graphics, and images. Xerox recommends this setting.
• Vivid RGB: This setting produces brighter and more saturated colors using red, green, and blue color.
• Commercial: This option applies color for printing on a commercial printing press.

Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

To print a watermark:
1. In the print driver, click the Document Options tab.
2. Click the Watermarks tab.
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a customized watermark. You can also manage watermarks from this menu.
4. Under Text, select an option:
   • Text: Enter the text in the field, then specify the font.
   • Time Stamp: Specify the date and time options, then specify the font.
   • Picture: To locate the picture, click the Browse icon.
5. Specify the scaling angle and position of the watermark.
   • Select the scaling option that specifies the size of the picture in relation to the original image. Use the arrows to scale the image in increments of 1%.
   • To define the angle of the image on the page, specify the position option or to rotate the image left or right by increments of 1, use the arrows.
   • To define the location of the image on the page, specify the position option, or to move the image in each direction in increments of 1, use the arrows.
6. Under Layering, select how to print the watermark.
   • Print in Background prints the watermark behind the text and graphics in the document.
   • Blend: This option combines the watermark with the text and graphics in the document. A blended watermark is translucent, so you can see both the watermark and the document content.
   • Print in Foreground prints the watermark over the text and graphics in the document.
7. Click Pages, then select the pages to print the watermark:
8. If you select a picture as a watermark, specify the lightness settings for the image.
9. Click OK.

Scaling

Scaling reduces or enlarges the original document to match the selected output paper size. In Windows, the Scale Options are located in the print driver on the Printing Options tab in the Paper field.

To access Scaling Options, to the right of the Paper field, click the arrow, then select Other Size—Advanced Paper Size.
Printing

- Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount appears in the percentage box below the sample image.
- No Scaling does not change the size of the page image printed on the output paper, and 100% appears in the percentage box. If the original size is larger than the output size, the page image is cropped. If the original size is smaller than the output size, extra space appears around the page image.
- Manually Scale scales the document by the amount entered in the percentage box below the preview image.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in your printed job.

1. To adjust the lightness, on the Image Options tab, move the slider to the right to lighten or to the left to darken your print job.
2. Click OK or Apply.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

1. To adjust the contrast, move the slider to the right to reduce the contrast or to the left to increase the contrast.
2. Click OK or Apply.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:

1. Click Notification.
2. Click Notify for Completed Jobs. Select an option:
   - Enabled: This option turns on notifications.
   - Disabled: This option turns off the Notification feature.
3. Click OK.
Using Special Pages

The Special Pages options control how covers, inserts, and exception pages are added to your printed document.

For details on accessing the Properties window, refer to Printing Overview.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages that are different from the source used for the body of a document. For example, you can use your company letterhead for the first page of a document. You can also use heavyweight paper for the first and last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

- **No Covers**: This option does not print cover pages. No cover pages are added to the document.
- **Front Only**: This option prints the first page on paper from the specified tray.
- **Back Only**: This option prints the back page on paper from the specified tray.
- **Front and Back: Same** prints the front and back cover pages from the same tray.
- **Front and Back: Different** prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side two, or both sides of the cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated pages within a document. Adding an insert after designated pages within a document separates sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

- **Insert Options**: Provides the options to place an insert After Page X, where X is the specified page, or Before Page 1.
- **Quantity**: Specifies the number of pages to insert at each location.
- **Pages**: Specifies the page or range of pages that use the exception page characteristics. Separate individual pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11.
- **Paper**: Displays the default size, color, and type of paper selected in Use Job Settings. To specify a different paper size, color, or type, for Paper, click the arrow, then select an option.
- **Job Setting**: Displays the attributes of the paper for the remainder of the job.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences such as page size, page type, and page color. You can also change the side of the paper on which to print as your job requires. A print job can contain multiple exceptions.
Printing

For example, your print job contains 30 pages. You want five pages to print on only one side of a special paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the alternate paper source:

- **Pages**: Specifies the page or range of pages that use the exception page characteristics. Separate individual pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and 11, type 1, 6–9 or 9–11.
- **Paper**: Displays the default size, color, and type of paper selected in Use Job Settings.
- **2-Sided Printing** allows you to select 2-sided printing options. Click the Down arrow to select an option:
  - **1-Sided Print** prints the exception pages on one side only.
  - **2-Sided Print** prints the exception pages on both sides of the paper and flips the pages on the long edge. The job then can be bound on the long edge of the pages.
  - **2-Sided Print, Flip on Short Edge** prints the exception pages on both sides of the paper and flips the pages on the short edge. The job then can be bound on the short edge of the pages.
  - **Use Job Setting** prints the job using the attributes shown in the Job Settings box.
- **Job Setting**: Displays the attributes of the paper for the remainder of the job.

**Note**: Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected results.

### Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported by the printer. For more information, refer to [Supported Custom Paper Sizes](#).

### Printing on Custom Paper Sizes

**Note**: Before printing on a custom paper size, use the Custom Paper Sizes feature in Printer Properties to define the custom size. For more information, refer to [Defining a Custom Paper Size at the Control Panel](#).

#### Printing on Custom Paper Size Using Windows

1. Load the custom-size paper in the tray.
2. In the application, click **File → Print** and select your printer.
3. In the Print dialog box, click **Properties**.
4. On the Paper/Output tab, use the **Paper Size** drop-down list to select the desired custom size.

**Note**: If you are printing on custom size paper, define the custom size in the printer properties before printing.

5. From the Paper Type drop-down list, select the paper type.
6. Select any other desired options, then click **OK**.
7. In the Print dialog box, click **OK** to start printing.
Printing on Custom Paper Size Using Macintosh
1. Load the custom-size paper. For details, refer to Loading Paper.
2. In the application, click Page Setup.
3. From the Paper Size drop-down list, select the custom paper size.
4. Click OK.
5. In the application, click Print.
6. Click OK.

Defining Custom Paper Sizes
To print custom paper sizes, define the custom width and length of the paper in the print driver software and on the printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the tray. Setting the wrong size paper can cause a printer error. Print driver settings override control panel settings when you print using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver
You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print driver and are available for you to select in all your applications.

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes.

To create and save custom sizes for Windows:
1. In the print driver, click the Printing Options tab.
2. For Paper, click the arrow, then select Other Size → Advanced Paper Size → Output Paper Size → New.
3. In the New Custom Paper Size window, enter the height and width of the new size.
4. To specify the units of measurement, at the bottom of the window, click the Measurements button, then select Inches or Millimeters.
5. To save, in the Name field, type a title for the new size, then click OK.

To create and save custom sizes for Macintosh:
1. In the application, click File → Page Setup.
2. Click Paper Sizes, then select Manage Paper Sizes.
3. To add a size, in the Manage Paper Sizes window, click the Plus sign (+).
4. Double-click Untitled at the top of the window, then type a name for the new custom size.
5. Enter the height and width of the new custom size.
6. Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set the top, bottom, right, and left margins for User Defined margins.
7. To save the settings, click OK.
Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print driver and are available for you to select in all your applications.

1. At the printer control panel, press Menu.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to Printer Settings, then press OK.
4. Navigate to Paper Size Settings, then press OK.
5. Navigate to the required tray, then press OK.
6. To specify a custom paper size, navigate to Custom, then press OK.
7. Navigate to Portrait (Y) Size, then press OK.
8. Press the arrow buttons to set the paper length, then press OK.
9. Navigate to Landscape (X) Size, then press OK.
10. Press the arrow buttons to set the paper width, then press OK.
11. To return to the Home menu, press the Menu button.
Maintenance

This chapter contains:

- Cleaning the Printer ................................................................. 106
- Adjustments and Maintenance Procedures .................................. 113
- Ordering Supplies ..................................................................... 118
- Moving the Printer ................................................................. 121
Cleaning the Printer

General Precautions

**WARNING:**
- Internal parts of the printer can be hot. Use caution when doors and covers are open.
- Keep all cleaning materials out of the reach of children.
- Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized spray cleaners increases the risk of fire and explosion.
- Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

**Caution:**
- When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed in this documentation.
- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time, especially in well-lighted places. Light exposure can damage the drum cartridges.
- Do not open covers and doors during printing.
- Do not tilt the printer while it is in use.
- Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print quality to deteriorate.
- Ensure that any parts removed during cleaning are replaced before you plug in the printer.

Cleaning the Exterior

Clean the exterior of the printer once a month.

- Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
- After cleaning, wipe with a dry, soft cloth.
- For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain off.

**Caution:** Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

Cleaning the Interior

**WARNING:**
• Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Power off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled.

• If you spill any toner in the printer, remove the toner using a moist cloth. Never use a vacuum cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion.

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer regularly. Clean the printer interior whenever you replace the drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing the printer covers and doors.

• Remove any remaining pieces of paper or debris. For more information, refer to Clearing Paper Jams.

• Remove any dust with a dry, lint-free clean cloth.
Maintenance

Cleaning the LED Lenses

If prints have voids or light streaks through one or more colors, use the following instructions to clean the LED lenses.

⚠️ **WARNING:** If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with cool water and consult a doctor.

1. Power off the printer.

2. Open the right-side door.

3. To unlock the waste cartridge, pinch the latch.
4. To remove the waste cartridge, lower the top of the cartridge and lift it away from the printer. To prevent toner spills, keep the openings facing up.

⚠️ **Note:**
- Be careful not to spill toner when handling the waste cartridge.
- After removing the waste cartridge, do not touch the area shown in the illustration.

5. Place the removed waste cartridge on a level surface, with the openings facing up.

⚠️ **Note:** To avoid toner spills or malfunction, do not lay the waste cartridge on its side, or with the openings facing down.
6. Remove the cleaning rod from inside the printer.

7. Insert the cleaning rod into one of the four cleaning holes until it stops, then pull out the rod. Repeat this two more times.

8. Repeat the procedure for the holes in the other three slots.
9. Return the cleaning rod to its original location.

10. To reinsert the waste cartridge, lower the bottom of the cartridge into position. To lock the cartridge into place, push the top forward until the latch clicks into place.

11. Close the right-side door.
Maintenance

Cleaning the Color Density Sensors

If the print or color density is too light, missing, or the background is foggy, clean the color density sensors.

1. Power off the printer. For details, refer to Powering the Printer On and Off.
2. Lift the rear door release and pull open the door.

3. Use a dry cotton swab to clean the color density sensors.

4. Close the rear door.
Adjustments and Maintenance Procedures

Color Registration
The printer automatically adjusts the color registration when automatic adjustment is turned on. You can also adjust color registration manually any time the printer is idle. You must adjust the color registration any time the printer is moved. If you are having printing problems, adjust the color registration.

Performing a Color Registration Adjustment
A color registration adjustment occurs every time a new toner cartridge is installed. You can run this adjustment at other times as needed.
To perform a color registration adjustment:
1. At the printer control panel, press Menu.
   
   Note: To navigate through the menu, use the arrow buttons.
2. Navigate to Admin Menu, then press OK.
3. Navigate to Image Quality, then press OK.
4. Navigate to Adjust Color Regi, then press OK.
5. At the prompt, press OK.
   When the process is complete, the printer displays Adjusted.
6. To return the printer to Ready, press Menu.

Adjusting Paper Registration
Use Adjust Paper Registration to adjust the placement of the printed image on the page. The adjustment allows you to place the top, bottom, left, and right margins exactly where you want. You can specify the image position on both the front and back sides of the paper, for each installed paper tray.

Verifying Paper Registration
1. At the printer control panel, press Menu.
   
   Note: To navigate through the menu, use the arrow buttons.
2. Navigate to Admin Menu, then press OK.
3. Navigate to Image Quality, then press OK.
4. Navigate to Adjust Paper Regi, then press OK.
5. Navigate to the desired paper tray, then press OK.
6. If visible in the menu, set the paper type and size.
   a. Navigate to Paper Type, then press OK.
b. Navigate to the type of paper that is loaded in the tray, then press OK.
c. Press the Back arrow button.
d. Navigate to Output Size, then press OK.
e. Navigate to the size of paper that is loaded in the tray, then press OK.

Note: If the printer determines the paper type and output size by another method, these selections are hidden from the adjustment menu.

7. To print a paper-registration chart, navigate to Print Chart, then press OK.

8. Select the calibration chart for the type of registration that you want to optimize.
   • To select a registration chart for adjusting 1-sided printing, navigate to Print Chart - 1 Sided, then press OK.
   • To select a registration chart for adjusting 2-sided printing, navigate to Print Chart - 2 Sided, then press OK.

9. To specify the number of prints, use the arrow buttons, then press OK.

10. At the prompt, press OK.

11. On the printed chart, for side 1, use a ruler to measure the distance of the printed image from the top, bottom, left, and right edges.

    Note: For identification, a single dot is printed on side 1, and two dots are printed on side 2.

12. For side 2, measure the distance of the printed image from the top, bottom, left, and right edges.

13. If the image is centered, no adjustment is required. If not centered, adjust the paper registration. For details, refer to Performing a Paper Registration Adjustment.

**Performing a Paper Registration Adjustment**

1. At the printer control panel, press Menu.

    Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.

3. Navigate to Image Quality, then press OK.

4. Navigate to Adjust Paper Regi, then press OK.

5. Navigate to the desired paper tray, then press OK.
6. Using the chart printed in Verifying Paper Registration, select the side for which you want to adjust registration.
   • To adjust side one, navigate to Adjust Side 1, then press OK.
   • To adjust side two, navigate to Adjust Side 2, then press OK.

7. Adjust the registration.
   • To adjust the side-to-side registration, navigate to Adjust Side Regi, then press OK.
   • To adjust the top-to-bottom registration, navigate to Adjust Lead Regi, then press OK.

8. To adjust the image-shift value, use the Up or Down arrow buttons, then press OK.
   For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page.
   • For Lead Registration, a positive value shifts the image down the page.
   • For Side Registration, a positive value shifts the image to the left.

9. As required, repeat steps 6 through 8 to enter more values.

10. Print another paper-registration chart, then repeat the process until you complete the registration corrections.

11. To return the printer to Ready, press Menu.

Adjusting the Voltage Offset

Use Voltage Offset to specify the bias voltage for printing on the selected paper type. If the printed image is too light, increase the offset for the paper you are using. If the printed image is mottled or blotchy-looking, decrease the offset for the paper you are using.

To adjust the voltage offset:
1. At the printer control panel, press Menu.
   **Note:** To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to Image Quality, then press OK.
4. Navigate to Voltage Offset, then press OK.
5. To select the paper type for the adjustment, press the arrow buttons, then press OK.
6. To increase or decrease the amount of offset, press the arrow buttons, then press OK.
7. Repeat this procedure for each paper type that you need to adjust.
8. To return the printer to Ready, press Menu.
Adjusting the Fuser

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is smearing or can be rubbed off the paper, increase the offset for the paper you are using. If the toner is blistered or mottled, decrease the offset for the paper you are using.

To adjust the fuser:

1. At the printer control panel, press **Menu**.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Image Quality**, then press **OK**.

4. Navigate to **Fuser Temperature**, then press **OK**.

5. To select the paper type for the adjustment, press the arrow buttons, then press **OK**.

6. To increase or decrease the amount of offset, press the arrow buttons, then press **OK**.

7. If necessary, repeat this procedure for other paper types.

8. To return the printer to Ready, press **Menu**.

Adjusting the Altitude

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If the altitude setting is incorrect, it can cause print-quality problems.

To adjust the altitude:

1. At the printer control panel, press **Menu**.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Image Quality**, then press **OK**.

4. Navigate to **Altitude Adjustmt**, then press **OK**.

5. To select the altitude of the location of the printer, press the arrow buttons, then press **OK**.

6. To return the printer to Ready, press **Menu**.

Performing an Engine Cleaning Procedure

When a printer sits idle for an extended time, it can result in visible background toner on prints. The Engine Cleaning procedure is used to reduce background toner on prints.

To perform an engine cleaning procedure:

1. At the printer control panel, press **Menu**.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Engine Cleaning**, then press **OK**.
4. At the prompt, press OK.
5. When the process is complete, the printer displays **Cleaning is finished**.
6. To return the printer to Ready, press **Menu**.
Ordering Supplies

Consumables

Consumables are printer supplies that are depleted during the operation of the printer. Consumable supplies for this printer are the Genuine Xerox® Toner Cartridges in cyan, magenta, yellow, and black.

Note:

- Each consumable includes installation instructions.
- Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner-remaining amount displayed could be inaccurate.
- To ensure print quality, the toner cartridge was designed to cease functioning at a predetermined point.

Caution: Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

- Cyan, Magenta, Yellow, and Black Drum Cartridges
- Waste Cartridge

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have replacements on hand. It is important to order these items when the messages first appear to avoid interruptions to your printing. An error message appears on the control panel when supplies must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/6510supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Viewing Printer Supply Status

Toner life information appears on the printer control panel. You can check the status and percentage of life remaining for your printer supplies at the control panel or from the Embedded Web Server.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: For details, refer to Finding the IP Address of Your Printer.

2. To view the percentage of life remaining for toners, click Home.

3. To view details, for Supplies, click Details.

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to www.xerox.com/gwa.

Toner Cartridges

General Precautions

WARNING:

- When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.
- Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child spit out the toner, and rinse the mouth with water. Consult a physician immediately.
- Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner, contact your local Xerox representative.
- Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch fire and cause burn injuries or an explosion.

Replacing a Toner Cartridge

A message appears on the control panel when a toner cartridge must be replaced.

Note: Each toner cartridge includes installation instructions.
Recycling Supplies

For more information on the Xerox® supplies recycling program, go to www.xerox.com/gwa.

Checking Meter Readings

You can use Meter Readings to view impression count details for the printer. The current counts for color, black and white, and combined total impressions appear. Meter Readings track the total number of images and pages that are printed for the life of the printer. You cannot reset Meter Readings. For details, refer to Checking Meter Readings.
Moving the Printer

**WARNING:**

- To lift the printer, always use at least two people to grasp the hand holds on each side of the printer.
- To prevent you from dropping the printer or injury, lift the printer firmly by gripping the recessed areas on both sides of the printer. Never lift the printer by gripping any other areas.
- If optional 550-Sheet Feeders are installed, uninstall them before you move the printer. If the optional 550-Sheet Feeders are not fixed to the printer securely, they can fall to the ground and cause injury.

Follow these instructions when moving the printer:

1. Power off the printer, then disconnect the power cord and other cables from the back of the printer.
   
   **WARNING:** To prevent electric shock, never touch the power plug with wet hands. When removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead to fire or electric shock.

2. Remove any paper from the Bypass Tray.

3. Close the Bypass Tray.
4. Remove any paper or other media from the output tray.

5. If the output tray extension is extended, close it.

6. Remove any paper from Tray 1, then close the tray.

7. Keep the paper wrapped and away from humidity and dirt.
8. If the optional 550-Sheet Feeder is installed, unlock, then uninstall it before you move the printer.

9. Lift and carry the printer as shown in the illustration.

   **Note:**
   - When moving the printer, do not tilt it more than 10 degrees in any direction.
   - Repack the printer and its options using the original packing material and boxes or a Xerox Repackaging Kit.

   **Caution:** Failure to repack the printer properly for shipment can result in damage not covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by improper moving.

After moving the printer:
1. Reinstall any parts that you removed.
2. Reconnect the printer to the cables and power cord.
3. Plug in and power on the printer.
Maintenance
Troubleshooting

This chapter contains:

- General Troubleshooting ................................................................. 126
- Paper Jams ................................................................................. 131
- Getting Help ............................................................................... 149
General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply restarting the printer.

Printer Does Not Power On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power switch is not turned on.</td>
<td>At the printer control panel, press the <strong>Power/Wake</strong> button. For details, refer to <em>Powering the Printer On and Off</em>.</td>
</tr>
<tr>
<td>The power cord is not plugged into the outlet correctly.</td>
<td>Power off the printer, and plug the power cord securely into the outlet.</td>
</tr>
</tbody>
</table>
| Something is wrong with the outlet connected to the printer. | • Plug another electrical appliance into the outlet and check if it operates properly.  
  • Try a different outlet. |
| The printer is connected to an outlet with a voltage or frequency that does not match the printer specifications. | Use a power source with the specifications listed in the *Electrical Specifications*.

⚠️ **Caution:** Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

Printer Resets or Powers Off Frequently

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power cord is not plugged into the outlet correctly.</td>
<td>Power off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then power on the printer.</td>
</tr>
<tr>
<td>A system error occurred.</td>
<td>Power off the printer, then power on again. Print the <em>Error History Report</em>. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is connected to an uninterruptible power supply.</td>
<td>Power off the printer, then connect the power cord to a suitable outlet.</td>
</tr>
<tr>
<td>The printer is connected to a power strip shared with other high-power devices.</td>
<td>Plug the printer directly into the outlet or into a power strip that is not shared with other devices.</td>
</tr>
</tbody>
</table>
# Troubleshooting

## Printer Does Not Print

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is in Power Saver mode.</td>
<td>On the control panel, press the <strong>Power/Wake</strong> button.</td>
</tr>
<tr>
<td>The printer has an error.</td>
<td>If the Status LED is blinking amber, follow the instructions on the control panel to clear the error. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is out of paper.</td>
<td>Load paper into the tray.</td>
</tr>
<tr>
<td>The incorrect paper is loaded for the print job.</td>
<td>Load the correct paper in the appropriate tray. At the printer control panel, specify the correct paper size, type and color.</td>
</tr>
<tr>
<td>The paper settings for the print job do not match any paper loaded in the paper trays at the printer.</td>
<td>From the print driver, select a paper tray containing the correct paper.</td>
</tr>
<tr>
<td>A toner cartridge is empty.</td>
<td>Replace the empty toner cartridge.</td>
</tr>
<tr>
<td>No control panel indicators are lighted.</td>
<td>Power off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then power on the printer. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is busy.</td>
<td><img src="https://via.placeholder.com/150" alt="List" /> • If the Status LED is flashing blue, a previous print job could be the problem. 1 In the print driver, use the Printer Properties to delete all print jobs in the print queue. 2 At the control panel, touch <strong>Jobs</strong>, then delete all pending print jobs. • Load the paper in the tray. • If the Status LED does not flash once after you send a print job, check the connection between the printer and the computer. Power off the printer, then power on the printer.</td>
</tr>
<tr>
<td>The printer cable is disconnected.</td>
<td>If the Status LED does not flash once after you send a print job, check the connection between the printer and the computer.</td>
</tr>
<tr>
<td>Probable Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>There is a network-connectivity issue.</td>
<td>If the printer is connected to a network:</td>
</tr>
<tr>
<td></td>
<td>1 Verify that the Ethernet cable is connected to the printer.</td>
</tr>
<tr>
<td></td>
<td>2 On the printer Ethernet connector, verify that the green LED is On. If the green LED is not lighted, reseat both ends of the Ethernet cable.</td>
</tr>
<tr>
<td></td>
<td>3 Examine the TCP/IP address in the Communication section of the Configuration Report. For more information, refer to Printing a Configuration Report at the Control Panel.</td>
</tr>
<tr>
<td></td>
<td>4 If the TCP/IP address is 0.0.0.0, the printer needs more time to acquire an IP address from the DHCP server. Wait 2 minutes, then print the Configuration Report again.</td>
</tr>
<tr>
<td></td>
<td>5 If the TCP/IP address is unchanged, or begins with 169, contact your network administrator.</td>
</tr>
<tr>
<td>There is a wireless network setup or connectivity issue.</td>
<td>Verify that the Wireless Network Adapter is installed and properly configured. For more information, refer to Connecting to a Wireless Network Using the Control Panel Wi-Fi Setup Wizard.</td>
</tr>
</tbody>
</table>

## Printing Takes Too Long

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is set to a slower printing mode. For example, the printer could be set to print on Heavyweight paper.</td>
<td>It takes more time to print on certain types of special paper. Ensure that the paper type is set properly in the driver and at the printer control panel. For details, refer to Print Speed.</td>
</tr>
<tr>
<td>The printer is in Power Saver mode.</td>
<td>It takes time for printing to start when the printer is coming out of Power Saver mode.</td>
</tr>
<tr>
<td>The way the printer was installed on the network could be an issue.</td>
<td>Determine if a print spooler or a computer sharing the printer is buffering all print jobs and then spooling them to the printer. Spooling can slow print speeds. To test the speed of the printer, print some information pages such as the Demo Page. If the page prints at the rated speed of the printer, there could be a network or printer installation issue. For more help, contact the system administrator.</td>
</tr>
<tr>
<td>The job is complex.</td>
<td>Wait. No action needed.</td>
</tr>
<tr>
<td>The print-quality mode in the print driver is set to Enhanced.</td>
<td>Change the print-quality mode in the print driver to Standard.</td>
</tr>
</tbody>
</table>
## Document Prints from Wrong Tray

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application and print driver have conflicting tray selections.</td>
<td>1. Check the tray selected in the print driver.</td>
</tr>
<tr>
<td></td>
<td>2. Access the page setup or printer settings of the application from which you are printing.</td>
</tr>
<tr>
<td></td>
<td>3. Set the paper source to match the tray selected in the print driver or set the paper source to <strong>Automatically Select</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Check that you have the latest print driver installed. For details, go to <a href="http://www.xerox.com/office/6510support">www.xerox.com/office/6510support</a>.</td>
</tr>
<tr>
<td><strong>Note:</strong> To have the print driver select the tray, set the tray used as the paper source to <strong>Auto Selection Enabled</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

## Automatic 2-Sided Printing Problems

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsupported or incorrect paper.</td>
<td>Ensure that you are using a supported paper size and weight for 2-sided printing. Envelopes and labels cannot be used for 2-sided printing. For details, refer to <a href="#">Supported Paper Types and Weights for Automatic 2-Sided Printing</a>.</td>
</tr>
<tr>
<td>Your printer model is not configured with automatic 2-sided printing.</td>
<td>Ensure that your printer supports automatic 2-sided printing. For details, refer to <a href="#">Printer Configurations and Options</a>.</td>
</tr>
<tr>
<td>Incorrect setting.</td>
<td>In the print driver Paper/Output tab, select <strong>Properties – 2-Sided Print</strong>.</td>
</tr>
</tbody>
</table>

## Printer is Making Unusual Noises

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is an obstruction or debris inside the printer.</td>
<td>Power off the printer, then remove the obstruction or debris. If you cannot remove the obstruction, contact your Xerox representative.</td>
</tr>
</tbody>
</table>
Paper Tray Will Not Close

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray does not fully close.</td>
<td>• If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. For more information, refer to Configuring Trays 1 or 2 for the Paper Length.</td>
</tr>
<tr>
<td></td>
<td>• Some debris or an object is blocking the tray.</td>
</tr>
<tr>
<td></td>
<td>• The tray is blocked by the table or shelf on which it is located.</td>
</tr>
<tr>
<td></td>
<td>• If the paper lift plate at the back of the tray is not locked down, replace the tray.</td>
</tr>
</tbody>
</table>

Condensation has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that is heated quickly.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer has been sitting in a cold room.</td>
<td>Allow the printer to operate for several hours at room temperature.</td>
</tr>
<tr>
<td>The relative humidity of the room is too high.</td>
<td>• Reduce the humidity in the room.</td>
</tr>
<tr>
<td></td>
<td>• Move the printer to a location where the temperature and relative humidity are within the operating specifications.</td>
</tr>
</tbody>
</table>
Paper Jams

Locating Paper Jams

**WARNING:** Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled. If the error persists, contact your Xerox representative.

**Caution:** Do not attempt to clear any paper jams using tools or instruments. This can permanently damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Tray 2
2. Fuser
3. Bypass Tray
4. Tray 1

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper path.

The following can cause paper jams:

- Selecting the incorrect paper type in the print driver.
- Using damaged paper.
- Using unsupported paper.
- Loading paper incorrectly.
- Overfilling the tray.
- Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:
Troubleshooting

- Use only supported paper. For details, refer to Supported Paper.
- Follow proper paper handling and loading techniques.
- Always use clean, undamaged paper.
- Avoid paper that is curled, torn, moist, creased, or folded.
- To separate the sheets before loading into the tray, fan the paper.
- Observe the paper tray fill line; never overfill the tray.
- Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.
- After loading the tray, at the control panel, select the correct paper type and size.
- When printing, select the correct type and size in the print driver.
- Store paper in a dry location.

Avoid the following:
- Polyester coated paper that is designed specially for inkjet printers.
- Paper that is folded, wrinkled, or excessively curled.
- Loading more than one type, size, or weight of paper in a tray at the same time.
- Overfilling the tray.
- Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/rmlna.
Clearing Paper Jams

Clearing Paper Jams from the Bypass Tray

To resolve the error displayed on the control panel, clear all paper from the paper path.

1. Remove any paper from the bypass tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Remove Tray 1 from the printer.

4. Remove the jammed paper.
5. Insert Tray 1 into the printer, then push it all the way in.

*Note:* If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer.

6. Insert the Bypass Tray completely into the printer.

7. If the control panel prompts you, verify the paper size and type on the screen. If not, change the paper settings.
   a. At the printer control panel, press **Menu**.
      
      *Note:* To navigate through the menu, use the arrow buttons.
   b. Navigate to **Admin Menu**, then press **OK**.
   c. Navigate to **Printer Settings**, then press **OK**.
   d. To select the paper type, navigate to **Paper Type**, then press **OK**.
   e. Navigate to the desired tray, then press **OK**.
   f. To select the desired paper setting, press the arrow buttons, then press **OK**.
   g. To return to the Printer Settings menu, press the **Left** arrow button twice.
   h. To select paper size, navigate to **Paper Size Settings**, then press **OK**.
   i. Navigate to the desired tray, then press **OK**.
   j. To select a paper-size setting, press the arrow buttons, select the setting, then press **OK**.

8. To return to the Home menu, press the **Home** button.
Clearing Paper Jams from the Tray 1 Area

To resolve the error displayed on the control panel, clear all paper from the paper path.

1. Remove any paper from the bypass tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Remove Tray 1 from the printer.

4. Remove any crumpled paper from the tray and any remaining paper jammed in the printer.
5. Insert Tray 1 into the printer, then push it all the way in.

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer.

6. Insert the Bypass Tray completely into the printer.

7. If the control panel prompts you, verify the paper size and type on the screen. If not, change the paper settings.
   a. At the printer control panel, press Menu.

      Note: To navigate through the menu, use the arrow buttons.

   b. Navigate to Admin Menu, then press OK.
   c. Navigate to Printer Settings, then press OK.
   d. To select the paper type, navigate to Paper Type, then press OK.
   e. Navigate to the desired tray, then press OK.
   f. To select the desired paper setting, press the arrow buttons, then press OK.
   g. To return to the Printer Settings menu, press the Left arrow button twice.
   h. To select paper size, navigate to Paper Size Settings, then press OK.
      i. Navigate to the required tray, then press OK.
      j. To select a paper-size setting, press the arrow buttons, select the setting, then press OK.

8. To return to the Home menu, press the Home button.
Clearing Paper Jams from the Tray 2 Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Pull out Tray 2 until it stops.

2. To remove the tray, lift the front of it slightly, then pull it out of the printer.

3. Remove any crumpled paper from the tray and any remaining paper jammed at the front of the printer.
Troubleshooting

4. At the back of the printer, open the Tray 2 Door, then remove any paper jammed that is present.

5. Insert Tray 2 into the printer, then push it all the way in.
   
   *Note:* If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer.

6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper settings.
   
   a. At the printer control panel, press **Menu**.

   *Note:* To navigate through the menu, use the arrow buttons.

   b. Navigate to **Admin Menu**, then press **OK**.

   c. Navigate to **Printer Settings**, then press **OK**.

   d. To select the paper type, navigate to **Paper Type**, then press **OK**.

   e. Navigate to the desired tray, then press **OK**.

   f. To select the desired paper setting, press the arrow buttons, then press **OK**.

   g. To return to the Printer Settings menu, press the **Left** arrow button twice.

   h. To select paper size, navigate to **Paper Size Settings**, then press **OK**.

   i. Navigate to the required tray, then press **OK**.

   j. To select a paper-size setting, press the arrow buttons, select the setting, then press **OK**.

7. To return to the Home menu, press the **Home** button.
Clearing Paper Jams from the Fuser Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Lift the rear door release and pull open the door.

2. To open the paper guide on the top of the fuser, lift the paper guide tab.

3. Remove any jammed paper from the back of the printer.
Troubleshooting

4. Close the paper guide on the fuser.

5. Close the rear door.

Troubleshooting Paper Jams

Multiple Sheets Pulled Together

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past fill line.</td>
</tr>
<tr>
<td>The edges of the paper are not even.</td>
<td>Remove the paper, align the edges, and then reload it.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the paper from the tray, and replace it with new dry paper.</td>
</tr>
<tr>
<td>Too much static electricity is present.</td>
<td>Try a new ream of paper.</td>
</tr>
<tr>
<td>Using unsupported paper.</td>
<td>Use only Xerox®-approved paper. For details, refer to Supported Paper.</td>
</tr>
</tbody>
</table>
### Probable Causes and Solutions

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity is too high for coated paper.</td>
<td>Feed paper one sheet at a time.</td>
</tr>
<tr>
<td>The feed rollers are dirty.</td>
<td>Clean the feed rollers. For details, refer to Cleaning the Printer.</td>
</tr>
<tr>
<td>Tray is loaded with mixed paper.</td>
<td>Load the tray with only one type and size of paper.</td>
</tr>
<tr>
<td>The paper is not correctly positioned in the tray.</td>
<td>• Remove the misfed paper and reposition it properly in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The paper guides are not correctly adjusted to the paper size.</td>
<td>Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The tray contains warped or wrinkled paper.</td>
<td>Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the moist paper and replace it with new, dry paper.</td>
</tr>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use only Xerox approved paper. For details, refer to Supported Paper.</td>
</tr>
<tr>
<td>The feed rollers are dirty.</td>
<td>Clean the feed rollers. For details, refer to Cleaning the Printer.</td>
</tr>
</tbody>
</table>

### Paper Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper is not correctly positioned in the tray.</td>
<td>• Remove the misfed paper and reposition it properly in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The paper guides are not correctly adjusted to the paper size.</td>
<td>Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The tray contains warped or wrinkled paper.</td>
<td>Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the moist paper and replace it with new, dry paper.</td>
</tr>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use only Xerox approved paper. For details, refer to Supported Paper.</td>
</tr>
<tr>
<td>The feed rollers are dirty.</td>
<td>Clean the feed rollers. For details, refer to Cleaning the Printer.</td>
</tr>
</tbody>
</table>

### Label and Envelope Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The label sheet is facing the wrong way in the tray.</td>
<td>• Load label sheets according to the instructions from the manufacturer.</td>
</tr>
<tr>
<td></td>
<td>• Load labels in the tray, face up.</td>
</tr>
<tr>
<td></td>
<td>• For more information, refer to Labels.</td>
</tr>
<tr>
<td>Labels are missing, curled, or pulled away from the backing sheet.</td>
<td>Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet.</td>
</tr>
</tbody>
</table>
### Probable Causes Solutions

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes are loaded incorrectly.</td>
<td>You can print envelopes from the Bypass Tray or Tray 1. For more information, refer to Envelopes.</td>
</tr>
</tbody>
</table>
| Envelopes are wrinkling.         | • The heat and pressure of the laser printing process can cause wrinkling.  
                                    • Use supported envelopes. For more information, refer to Guidelines for Printing Envelopes.  |
|                                  | **Note:** When you load envelopes long-edge feed, ensure that you specify landscape orientation in the print driver. |

### Paper Jam Message Stays On

*Note:* Check for, and remove, torn pieces of paper in the paper path.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some paper remains jammed in the printer.</td>
<td>Recheck the paper path and make sure that you have removed all of the jammed paper.</td>
</tr>
<tr>
<td>One of the printer doors is open.</td>
<td>Check the doors on the printer. Close any door that is open.</td>
</tr>
</tbody>
</table>

### Jams During Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use paper of the correct size, thickness, or type. For more information, refer to Supported Paper Types and Weights for Automatic 2-Sided Printing.</td>
</tr>
<tr>
<td>Paper is loaded in the wrong tray.</td>
<td>Ensure that paper is loaded into the correct tray. For more information, refer to Supported Paper.</td>
</tr>
<tr>
<td>Tray is loaded with mixed paper.</td>
<td>Load the tray with only one type and size of paper.</td>
</tr>
</tbody>
</table>

### Print-Quality Problems

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the information in this section to troubleshoot the problem. For more information, go to [www.xerox.com/office/6510support](http://www.xerox.com/office/6510support).
Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Contact your local Xerox representative for details.

Note:

- To ensure consistent print quality, the toner/print/drum cartridges for many devices are designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting increment the color pages counter, because color consumables are used. Composite black is the default setting on most printers.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The range for optimal print quality is 15–28°C (59–82°F) and 20–70% relative humidity. However, print quality can be affected when operating near the limits for both temperature and humidity.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:

Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and refer to the corresponding solution to correct the problem. You can also print a Demo Page to more precisely determine the print-quality problem. For details, refer to Information Pages.

If the print quality does not improve after performing the appropriate action, contact your Xerox representative.

Note:

- To enhance print quality, toner cartridges for many models of equipment have been designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting increment the color-pages counter, because color consumables are used. Composite black is the default setting on most printers.
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| **Page Margins Are Inconsistent.**  
• The image is not centered on the page or the margins are not consistent. | A paper registration adjustment is needed. | Use the paper registration procedure to adjust the image position on the page. For details, refer to Adjusting Paper Registration. |
| Faded printouts with multiple colors faded. | The toner cartridges are not Xerox® toner cartridges. | Verify that the toner cartridges meet specifications, and replace them if necessary. |
| | The paper being used is outside the recommended specification range. | Replace the paper with a recommended size and type, and confirm that your control panel and print driver settings are correct. For details, refer to Supported Paper. |
| | The paper type is heavier or thicker than the paper type selection. | • Ensure that the proper paper is loaded in the paper tray.  
• Choose a heavier paper type at the control panel and in the print driver.  
• Use a lighter paper or paper type. |
<p>| | The bias transfer voltage is not properly adjusted for the paper type. | Verify that the paper types set in the control panel and the print driver match the paper loaded in the tray. |
| | The settings in the application or print driver are incorrect. | Print the Demo Page. For details, refer to Printing Reports. If the Demo Page looks correct, the printer is printing properly. Verify that the application and the print driver selections are correct for your print job. |
| | The paper is damp. | Replace the paper. |
| | The high-voltage supply is defective. | For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/6510support">www.xerox.com/office/6510support</a>. |</p>
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only one color is faded.</td>
<td>Toner cartridge is empty or damaged.</td>
<td>Check the condition of the toner cartridge and replace it if necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color around the edge of printing is incorrect.</td>
<td>The color registration is incorrect.</td>
<td>Adjust the color registration. For details, refer to Color Registration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stray black dots or white areas (dropouts).</td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, and confirm that your control panel and print driver settings are correct. For details, refer to Supported Paper.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>There is debris on the rollers.</td>
<td>Wipe the feed rollers with a clean damp cloth to remove debris from the rollers.</td>
<td>Do not touch the transfer roller or the exposed end of the transfer belt. Fingerprints can cause print-quality issues.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Ensure that the toner cartridges meet specifications and replace them if necessary. For details, refer to Consumables.</td>
<td></td>
</tr>
<tr>
<td>Vertical black or color streaks or multiple colored streaks or lines.</td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Ensure that the toner cartridges meet specifications and replace them if necessary. For details, refer to Consumables.</td>
</tr>
<tr>
<td>Streaks in only one color.</td>
<td>Debris in the printer is dragging against the toner before it is fused.</td>
<td>Remove any debris or paper scraps from the paper path under the rear cover.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the toner cartridge for that color.</td>
<td>Check the toner cartridge for damage and replace if necessary. For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/6510support">www.xerox.com/office/6510support</a>.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partial blanks, creased paper, or blotted printing.</td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type. For details, refer to Supported Paper.</td>
</tr>
<tr>
<td></td>
<td>The printer is worn or damaged.</td>
<td>For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/6510support">www.xerox.com/office/6510support</a>.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, refer to Consumables.</td>
</tr>
<tr>
<td></td>
<td>The paper is impeded in the paper path.</td>
<td>• Remove any paper or debris from the paper path.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ensure that the trays are pushed in all the way.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ensure that the rear cover is closed and locked.</td>
</tr>
<tr>
<td></td>
<td>Condensation inside the printer causes partial blanks or creased paper.</td>
<td>Power on the printer and leave it on for at least one hour to get rid of the condensation. For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/6510support">www.xerox.com/office/6510support</a>.</td>
</tr>
<tr>
<td>Vertical blanks appear.</td>
<td>The LED lenses are blocked.</td>
<td>Clean the LED lenses. For details, refer to Cleaning the LED Lenses.</td>
</tr>
<tr>
<td></td>
<td>The printer is worn or damaged.</td>
<td>For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/6510support">www.xerox.com/office/6510support</a>.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Ensure that the toner cartridges meet specifications and replace if necessary.</td>
</tr>
<tr>
<td>White lines or streaks running through only one color.</td>
<td>Something is blocking the lens for the affected color.</td>
<td>Clean the lens for the affected color. For details, refer to Cleaning the LED Lenses.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Probable Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| White line or lines running through all colors. | Paper or debris is dragging the bottom of the transfer belt. | • Remove the paper or debris from the printer.  
• For assistance, go to the Xerox® Support website at www.xerox.com/office/6510support. |
| Slanted printing.                            | The paper guides in the trays are not set correctly.  | Reset the paper tray guides. For details, refer to Loading Paper.          |
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blotchy or mottled images.</td>
<td>The paper is too light or too thin.</td>
<td>Replace the paper with a recommended type, and confirm that your control panel and print driver settings are correct.</td>
</tr>
<tr>
<td></td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The humidity is too high.</td>
<td>Reduce the humidity in the room or move the printer to a new location.</td>
</tr>
</tbody>
</table>

| Spots or lines appear at regular intervals on the prints. | One or more of the components in the paper path is marking the paper. | 1 Print the Repeating Defects pages.  
For details, refer to Printing Reports.  
2 To determine the cause, measure the distance between the print defects.  
• 28 mm (1.1 in.) - Drum Cartridge  
• 52 mm (2.1 in.) - Drum Cartridge  
• 94 mm (3.7 in.) - Drum Cartridge  
• 56.5 mm (2.2 in.) - Transfer Roller  
• 63 mm (2.5 in.) - Fuser  
• 67 mm (2.6 in.) - Fuser  
3 If the repeating defects match one of the Drum Cartridge distances, replace the one for the affected color.  
4 If the distance matches the fuser or transfer roller, call for service. |
Getting Help

Your printer includes utilities and resources to help you troubleshoot printing problems.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning condition occurs, the control panel displays a message informing you of the problem. For many status and warning messages, the control panel information provides additional information.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, the printer alerts you of the problem. A message appears on the control panel and the LED status light on the control panel flashes amber or red. Warning alerts inform you about printer conditions, such as low supplies or open doors, that require your attention. If more than one warning condition occurs, only one warning message appears on the control panel at a time.

Viewing Current Errors on the Control Panel

When an error condition occurs, a message appears on the control panel to inform you of the problem. Error messages warn you about printer conditions that prevent the printer from printing or degrade printing performance. If more than one error occurs, only one is displayed on the control panel.

Using the Integrated Troubleshooting Tools

Your printer has a set of reports that you can print. These reports include the Demonstration Print page and the Error History report that can assist you in troubleshooting certain problems. The Demonstration Print page prints an image to show print quality. You can use this page to troubleshoot print-quality issues with the printer. The Error History report prints information on the most recent printer errors.

For more information, refer to Printing Reports.

Specifying the Source Tray for Printing Reports

1. At the printer control panel, press Menu.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to Printer Settings, then press OK.
4. Navigate to Paper Tray Priority, then press OK.
5. Navigate to the desired paper tray, then press OK.
6. To set the paper tray to the highest priority, navigate to **Priority 1**, then press **OK**.

   - **Note:**
     - To print a report, ensure that the paper tray that you selected matches the default paper size, type, and color.
     - The Bypass Tray cannot be set to Priority 1.
     - To print a report from the Bypass Tray, remove all the other trays, then load the default paper size, type, and color in the Bypass Tray.

7. To return the printer to **Ready**, press **Menu**.

### Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and more.

To access the Online Support Assistant, go to [www.xerox.com/office/6510support](http://www.xerox.com/office/6510support).

### Helpful Information Pages

To assist with troubleshooting, your printer has a set of Information Pages that you can print. These pages include configuration and font information, demonstration pages, and more. For more information, refer to Information Pages.

### More Information about Your Printer

To obtain more information about your printer, refer to More Information.
System Administrator Functions

This chapter contains:

- Accessing the Printer .......................................................... 152
- Connecting the Printer .......................................................... 154
- Configuring General Settings Using the Embedded Web Server .............. 161
- Configuring General Settings Using the Control Panel ..................................... 171
- Configuring Default Settings and Printing Policies from the Embedded Web Server .......... 178
- Configuring Secure Settings ................................................................ 184
- Configuring User Roles and Access Permissions ........................................... 193
- Managing Device User Roles .................................................................. 198
- Managing Printing User Roles .............................................................. 201
- Setting Up an LDAP User Permissions Group ............................................ 204
- Managing Certificates ........................................................................ 205
- Configuring Remote Services Upload ...................................................... 211
- Updating the Printer Software .............................................................. 214
Accessing the Printer

The system administrator can set access rights on the printer to ensure that unauthorized users cannot access the printer. If the system administrator configures authentication and authorization, users require a login and a password to access some or all of the features of the printer.

Logging In at the Control Panel as the Administrator

1. At the printer control panel, press Menu.
2. If Panel Lock is On, you are prompted to enter the passcode to access the control panel menus.
3. At the prompt, to enter numbers at the control panel, select an option:
   - To select a number, press the Up or Down arrow buttons.
   - To scroll quickly, hold down the Up or Down arrow buttons.
   - To move to the next number field, press the Right arrow button.
   - To move to the previous number field, press the Left arrow button.
4. When finished, press OK.

Accessing the Embedded Web Server as a System Administrator

Before you begin:

- Ensure that your printer is connected to a network.
- Use the Configuration Report to locate your printer IP address. For details, refer to Configuration Report.

To log in to the Embedded Web Server as the administrator:

1. At your computer, open a Web browser.
2. In the address field, type the IP address of the printer, then press Enter or Return.
3. In the top right area of the page, click Log In.
4. For User Accounts, click or type admin.
5. For Password, type the administrator password. For software versions earlier than PL6 (XX.5X.XX), the default administrator password is 1111. For software versions PL6 (XX.5X.XX) or later, the default administrator password is the device serial number. You can obtain the serial number from the back of the printer, from the configuration report, or from the home page of the Embedded Web Server. The password is case-sensitive.

   Note: Upgrading to PL6 (XX.5X.XX) does not change the administrator password. If you reset the device to factory defaults, the administrator password changes to the device serial number for versions PL6 (XX.5X.XX) or later of the software.
6. Click Log In.
Changing the System Administrator Password

For open systems with software versions earlier than PL6 (XX.5X.XX), all users have access to all features on the device, including all system administration features. To restrict access to system administration features, change the system administrator password. For software versions earlier than PL6 (XX.5X.XX), the default administrator password is 1111. For software versions PL6 (XX.5X.XX) or later, the default administrator password is the device serial number. You can obtain the serial number from the back of the printer, from the configuration report, or from the home page of the Embedded Web Server. The password is case-sensitive.

For software versions PL6 (XX.5X.XX) or later, the open system option is not available.

Note:

- Upgrading to PL6 (XX.5X.XX) does not change the administrator password. If you reset to the device to factory defaults, the administrator password changes to the device serial number for versions PL6 (XX.5X.XX) or later of the software.
- If you change the administrator password, ensure that you store the password in a secure location.
- For software versions earlier than PL6 (XX.5X.XX), if you change the administrator password to return the device to an open system, reset the device to factory defaults. Any settings that you configured are lost when you reset the device to factory defaults. For details refer to Deleting All Data.

To change the administrator password:

1. In the Embedded Web Server, log in as administrator, then click Permissions.
2. For User Accounts, click admin.
3. Click Change Password.
4. Type the old password. All passwords are case-sensitive.
5. Type the new password, then retype the password to verify it.
6. Click OK.
Connecting the Printer

Connecting to a Wireless Network

Note:

- If the printer is connected to your wired network, you can configure wireless settings in the Embedded Web Server.
- Before you begin, purchase and install the Xerox® Wireless Network Adapter.

To verify the wireless status and locate the wireless IP address, print a Configuration Report. For details, refer to Configuration Report. Examine the Connectivity Physical Connections, Connectivity Protocols, and TCP/IPv4 sections of the report.

Note:

- The printer uses separate IP settings for wired and wireless connections. For more information, refer to Assigning the Printer IP Address.
- When you switch from a wired connection to a wireless connection, the IP address of the printer changes. The connection to the Embedded Web Server through your Web browser closes. To reconnect to the Embedded Web Server, in your Web browser address field, type the new IP address or host name of your printer.

Configuring Wi-Fi from the Embedded Web Server

1. Connect the printer to a wired network.
2. In the Embedded Web Server, log in as administrator, then click Connectivity.
3. In the Connections area, click Wi-Fi.

   Note: Wi-Fi is available after you install the Xerox® Wireless Network Adapter.

1. To enable Wi-Fi, click the Enable toggle button.
2. Click Wi-Fi Band, then select an option.
3. For SSID, type the SSID for the network to which you want to connect.
4. Click Network Type, then select Infrastructure or Ad hoc, as needed.
5. In the TCP/IP Settings area, configure the settings for IPv4, IPv6, and DNS.

   Note: The printer uses separate IP settings for wired and wireless network connections. For details, refer to IP.

1. In the Security Settings area, click Encryption, then select a mode of encryption.
2. For the selected mode of encryption, configure the security settings.
   - For WEP:
To activate a transmit key, click **Transmit Key**.
- For each Transmit Key that you select, type values into the corresponding fields.
  - For both WPA2 Personal and Mixed Mode Personal, type the network passcode in the Passcode field and the Retype Passcode field.
  - For both WPA2 Enterprise and Mixed Mode Enterprise:
    - Click **Authentication Method**, then select the authentication method for your wireless network.
    - For Root Certificate, upload a Root Certificate.
    - Type values for EAP Identity, Login Name, and Password.

3. Click **OK**.
4. For the new settings to take effect, restart the printer.
5. Disconnect the printer from the wired network.

**Configuring the Primary Network From the Embedded Web Server**

You can set the primary network connection type in the Embedded Web Server.

⚠️ **Note:**
- A Primary Network setup in the Embedded Web Server is possible only if the optional Wi-Fi connection kit is installed and enabled.
- By default, without a Wi-Fi connection, the primary network is set to Ethernet. When the kit is installed and enabled, the device acquires two network connections. One network connection is primary, and the other network connection is secondary.
- The following features are available only over the primary network connection:
  - IPsec
  - SMTP
  - SNTP
  - WSD scan
  - Scan to SFTP, Scan to SMB, Scan to Email
  - LDAP
  - UPnP discovery
  - ThinPrint
  - EIP Web Service
- If you remove the Wi-Fi connection module, the primary network connection is set to Ethernet.

1. In the Embedded Web Server, log in as a system administrator, then click **Connectivity**.
2. In the Connections area, click **Ethernet**.
3. In the Common area, click **Edit**.
4. Click **Primary Network**, then select the appropriate network connection type for the device.
5. Click **OK**.
6. To activate your changes, at the prompt, click **Restart Now**.

### Configuring Wi-Fi Using a Direct Connection to the Printer

To configure the settings for a wireless network, connect your computer directly to the printer using an Ethernet cable, rather than through a wired network connection.

1. Ensure that the printer is not connected to a wired Ethernet network.
2. Restart the printer.
4. Using an Ethernet cable, connect a computer directly to the printer.

   **Note:**
   - Ensure that wireless connectivity is disabled on your computer.
   - Depending on your computer hardware, use a crossover cable or adapter.
5. Verify the IP address of the computer. Ensure that the computer obtains a private IP address, in the 169.254.x.x range, and is therefore on the same subnet as the printer.
6. On the computer, access the Embedded Web Server, log in as administrator, then configure the wireless settings. For details, refer to Connecting to a Wireless Network.
7. For the new settings to take effect, restart the printer.
8. Disconnect the Ethernet cable between the printer and the computer.

### Disabling Wireless Networking

#### Disabling Wireless Networking from the Control Panel

**Note:** Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

1. At the printer control panel, press the **Menu** button.

   **Note:** To navigate through the menu, use the arrow buttons.
2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **Network/Port**, then press **OK**.
4. Navigate to **Wi-Fi Settings**, then press **OK**.
5. Navigate to **Cancel Settings**, then press **OK**.
6. Navigate to **Clear Settings**, then press **OK**.
7. At the prompt, press **OK**.

The printer restarts automatically and the new settings take effect.
Disabling Wireless Networking From the Embedded Web Server

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

1. In the Embedded Web Server, log in as administrator, then click Connectivity.
2. In the Connections area, click Wi-Fi.
3. Click the Enable toggle button.
4. Click OK.
5. To activate your changes, at the prompt, click Restart Now.

Wi-Fi Direct

A Wi-Fi Direct network connection enables devices to connect with each other without requiring a wireless access point. You can connect to your printer from a Wi-Fi mobile device such as a tablet, computer, or smart phone.

A Wi-Fi Direct connection does not require manual configuration.

Note:

- Wireless networking is available only on printers that have the optional Wireless Network Adapter installed.
- The Wi-Fi Direct connection is disabled by default.

To configure Wi-Fi Direct from the Embedded Web Server:

1. In the Embedded Web Server, log in as administrator, then click Connectivity.
2. For Connections, click Wi-Fi Direct.
3. To enable Wi-Fi Direct, click the Enable toggle button.
4. Click Group Role, then select an option from the menu.
   - To set the printer to configure the Group Role automatically:
     - Select Auto.
     - For Device Name, type a name for the printer.
   - To set the printer as Group Owner for a Wi-Fi Direct group, similar to a wireless access point:
     - Select Group Owner.
     - In the Group Owner area, type the information for SSID and Passcode.
5. For DHCP Server:
   - Type the IP Address and Subnet Mask.
   - For IP Address Lease Time, type the number of minutes.
6. Click OK.

To configure Wi-Fi Direct at the control panel:

1. At the printer control panel, press the Home button.
2. Log in as administrator.
3. Touch **Device → Connectivity → Wi-Fi Direct**.
4. For Wi-Fi Direct, touch the enable toggle button.
5. Touch **Setup**.
6. Touch **Group Role**, then select an option.
7. If needed, touch **SSID Suffix**, then type a suffix.
8. If you selected Group Owner as the Group Role, in the Passcode field, enter an eight-character passcode.
9. Touch **OK**.

📝 **Note:** For the new settings to take effect, restart your printer.

## IP

Internet Protocol (IP) is a protocol within the Internet Protocol Suite that manages the transmission of messages from computer to computer.

### Assigning the IP Address Manually

You can assign a static IP address to your printer from the printer control panel. After an IP address is assigned, you can change it in the Embedded Web Server.

To assign a static IP address to the printer, ensure that you have the following information:

- An IP address that is configured properly for your network
- The Network Mask address
• The default Router/Gateway address

If you are on a network that is managed by a network administrator, contact your network administrator to obtain the network information.

For a home network using routers or other devices to connect the printer to the network, refer to the device instructions on assigning network addresses. The router or device documentation can give you a range of acceptable address numbers you can use. It is important that the addresses be similar to the IP addresses used by other printers and computers on the network, but not the same. Only the last digit must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4.

The router can assign the static IP address of the printer to another computer that obtains its IP address dynamically. To avoid having the IP address reassigned, provide the printer an address at the higher end of the range that the device or router allows. For example, if your computer has IP address 192.168.1.2, and your device allows IP addresses to 192.168.1.255, select an address between 192.168.1.200 and 192.168.1.254.

It is recommended when setting a static IP address, that at the same time, set a DHCP reservation. For details, refer to your router documentation.

In IPv6 network configurations, the IPv6 address is assigned automatically.

To access the Ethernet menu:
1. At the printer control panel, press Menu.
   
   Note: To navigate through the menu, use the arrow buttons. To select a menu item, press OK.

2. Navigate to Admin Menu, then press OK.
3. Navigate to Network Port, then press OK.
4. Navigate to TCP/IP Settings, then press OK.
5. Navigate to Ethernet, then press OK.

To assign a static IP address to the printer:
1. From the Ethernet menu, navigate to Get IP Address, then press OK.
2. Navigate to STATIC, then press OK.
3. In the IP Address field, set the address. When you are finished, press OK.
4. To return to the Ethernet menu, press the Left arrow button.
5. Navigate to Subnet Mask, then press OK.
6. Set the network mask. When you are finished, press OK.
7. To return to Ethernet, press the Left arrow button.
8. Navigate to Gateway Address, then press OK.
9. Set the address. When you are finished, press OK.
10. For the new settings to take effect, press the Menu button to restart the printer.
11. To verify the new settings, wait for two minutes after the printer restarts, then print the Configuration Report. For details, refer to Printing a Configuration Report at the Control Panel.

For reference:
Changing the IP Address Using the Embedded Web Server

To change the IP address of the printer using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. Click Connectivity.

3. Click Ethernet.

4. For IPv4, click Edit.

5. On the IPv4 page, click STATIC.

6. In the IP Address field, type the address as X.X.X.X, where X is a number from 0–255.

7. In the Subnet Mask field, type the address as X.X.X.X, where X is a number from 0–255.

8. In the Gateway Address field, type the address as X.X.X.X, where X is a number from 0–255.

9. Click OK.

   Note: Changing the IP address disconnects the Embedded Web Server.

10. To reconnect to the Embedded Web Server, in the address field of the Web browser, type the new IP address of the printer.

11. Press Enter or Return.

   The Embedded Web Server opens.

NFC

Near field communication (NFC) is a technology that enables devices to communicate when they are within 10 centimeters of each other.

You can use NFC to obtain the network interface to establish a TCP/IP connection between your device and the printer.

To configure NFC:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Connectivity.

4. For Connections, click NFC.

5. To enable NFC, click the Enable toggle button, then touch OK.

6. Click OK.

7. For the new settings to take effect, restart your printer.
Configuring General Settings Using the Embedded Web Server

This section provides information to help you configure general settings for the printer from your Web browser using the Embedded Web Server. You can configure settings such as power saver mode, alerts, and print job policies.

Viewing Printer Information

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   The Embedded Web Server Home page appears.
2. In the printer status area, click Details.
   The Device Details page opens, showing printer information, network connectivity details, and system administrator information.

Setting the Date and Time Using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, click System → Date & Time.
   
   Note: If this feature does not appear, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. In the Date area, for Date Format, select an option.
4. For Date, click the date field, then select the current date from the calendar.
5. In the Time area, select the desired clock options, then enter the current time.
6. To set the time zone, click Time Zone, select your time zone from the list, then click OK.
7. To enable or disable Daylight Savings Time, click the toggle button.

   Note: A check mark on the toggle button indicates the setting is enabled.
8. To enable or configure Time Server Synchronization, for SNTP, click Edit.
   • To enable or disable Time Server Synchronization, click the toggle button.

   Note: A check mark on the toggle button indicates the setting is enabled.
   • Type the Time Server Address.
   • To set the amount of time between time synchronizations, for Time Synchronization Interval, click the current value, then type a value in hours.
   • To save SNTP settings, click OK.
9. To save Date & Time settings, click OK.
Setting the Sounds Using the Embedded Web Server

You can configure the device to play sounds to alert users to various device conditions or events. You can set the volume for each sound independently of each other.

1. In the Embedded Web Server, log in as administrator, then click **System**.
2. Click **Sounds**.
3. To enable sounds, select **Enable Sounds**.
4. To adjust the sound volume for an event, select an event, then move the appropriate volume slider control, as needed:
   - **Touch**: A sound plays when a user interacts with the control panel touch screen.
   - **Job Completion**: A sound plays when a print job, copy job, or receive-fax job completes.
   - **Error/Fault**: A sound plays when the device issues an alert or when the device requires user attention.
   - **Power**: A sound plays when the device is powering down.
   - **Mobile Device Connected**: A sound plays when a connection to a mobile device is detected.
5. To confirm the volume setting, click **OK**.
6. To close the Sounds window, click **OK**.

Configuring the Device Website Timeout

You can set the timeout period for the Embedded Web Server. The timer begins when user input stops. At the end of the specified timeout period, the logged in user is logged out automatically.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **System → Timers**.
4. For Device Website Timeout, type a number in minutes.
5. Click **OK**.

Configuring Power Saver Using the Embedded Web Server

You can set the time that the printer spends idle in ready mode before it automatically transitions to a lower power level.

To configure Power Saver Timers:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, click **System → Power Saver**.

   **Note**: If this feature does not appear, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. To set the time delay before the printer enters Low-Power mode, for **Low Power Timeout**, click current value, then type the desired timeout in minutes.
4. To set the time delay before the printer enters Sleep mode, for **Sleep Timeout**, click current value, then type the desired timeout in minutes.

*Note:* The sum of the two timeouts is within 60 minutes.

5. To set Auto Power Off, click **Auto Power Off**:
   - To power off the device after all timeouts complete, select **On**, click the current value, then type the required timeout in hours.
   - To power off the device only if specific conditions are met:
     - Select **Only When Conditions Are Met**.
     - Click the current value, then type the required timeout in hours.

Specific conditions are when Fax, USB Drive, and Wired and Non-Wired Network features have not been activated.

6. To finalize your selections, click **OK**.

### Configuring Tray Settings Using the Embedded Web Server

When the bypass tray is set to Fully Adjustable mode, you can change paper settings each time you load the tray. When paper is loaded into the bypass tray, the control panel prompts you to set the paper size, type, and color.

When other trays are set to Fully Adjustable mode, open the selected tray and load the desired paper. When you close the tray, the control panel prompts you to set the paper size, type, and color.

When any paper tray is set to Dedicated mode, only load the size, type, and color of paper specified for the tray. If you move the guides, or load a different paper, change the size, type, and color of paper settings at the control panel.

The Tray Priority feature determines the order in which the printer selects the tray for a print job when you have not specified one. Tray Priority also determines how the printer selects another tray when a paper tray runs out in the middle of a job. Priority 1 indicates that the tray is set to the highest priority.

To configure the tray settings:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
   - *Note:* If you do not know the IP address for your printer, refer to **Finding the IP Address of Your Printer**.

2. In the Embedded Web Server, click **Home**.

3. In the Trays area, click the desired tray.

4. To configure the tray mode, click **Tray Mode**.
   - To configure the printer control panel to prompt you for the paper settings each time the paper tray is loaded, click **Fully Adjustable**.
   - To configure the tray to use a specific paper, click **Dedicated**, then specify the paper size, type, and color.
5. To configure the printer to select the appropriate paper tray for the print job, click the toggle button for **Auto Select**. If the required paper size is not available, the printer prompts you to load the correct paper size and type for the job.

   **Note:** A check mark on the toggle button indicates that the setting is enabled.

6. To determine the order in which the printer selects the tray for a print job, click **Priority**, then select the tray priority.

7. To save the tray settings, click **OK**.

### Cloning Printer Settings

You can use cloning to copy configuration settings from one printer to another printer on the same network.

   **Note:**
   
   - Before using the clone feature, ensure that the source printer clone file is compatible with the destination printer.
   - Before you copy the address book, verify that the address book of the target printer is empty.

To clone the printer settings:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.

3. At the bottom of the Home page, click **Cloning**.

4. To install a clone file:
   a. For Install Clone File, click **Select**.
   b. Locate, then select a clone file from the source printer, then click **Open**.
      - To select a different clone file, click the change file icon.
      - To remove the selected clone file, click the Trash icon.
      
      **Note:** Removing the clone file does not delete it from the computer.
   c. To install the selected clone file, click **Install**.

5. To create a clone file:
   a. Select the parameters to clone from this printer.
      
      - To select individual parameters to clone from this printer, select the desired parameter.
      - To choose all settings, select **Select/Clear All**.
      - To clear all settings, clear **Select/Clear All**.
   b. Click **Create**.
   c. If prompted, save the clone file to a location that you can remember easily when you need the file for installation.
6. When you are finished creating or installing a clone file, click Close.

**Xerox® Device Manager Cloning Feature**

These printers support the Xerox® Device Manager cloning feature. The cloning feature allows delivery of a clone file to the device with credentials for authentication. For more information on how to use the cloning feature, refer to *Xerox® Device Manager* documentation.

**Enabling the Plug-in Feature**

To configure your device to work with compatible plug-in applications, activate the Plug-in Feature.

1. In the Embedded Web Server, log in as administrator, then click **System**.
2. Click **Plug-in Settings**.
3. To enable the Plug-in Feature, click the **Plug-in Feature** toggle button.
4. Click **Close**.
5. To activate your changes, at the prompt, click **Restart Now**.

For more information about compatible plug-in applications, refer to [www.support.xerox.com](http://www.support.xerox.com).

**Resetting the Printer**

Using Software Resets to restart the printer is faster and wastes fewer consumables than powering the printer on and off. Restarting the printer can take several minutes, during which time the Embedded Web Server is not available.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, click **Home → Support → Restart Device**.
3. At the prompt, click **Restart**.

**Configuring Alerts**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to [Logging In as the Administrator at the Control Panel](#).
3. On the Home page, for Supplies, click **Details**.
4. For Options, click **Alerts Setup**.
5. To enable alerts, for Enable Alerts, click the toggle button.

*Note: A check mark on the toggle button indicates that the setting is enabled.*
6. To enable or disable an alert, for the alert type, select the appropriate option:
   • Click the toggle button.
   • Click the alert type, then select an option from the list.
7. Click OK.

Configuring the SMTP Server Settings

Before you can configure email alerts, configure the printer to communicate with your SMTP email server.

To configure the SMTP server settings:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click Connectivity.
4. Click SMTP.
5. To enable Email Submission, click the Email Notification toggle button.
   
   Note: A check mark on the toggle button indicates that the feature is enabled.
6. Type the following information:
   • For Device Email, type an appropriately formatted email address to appear in the From field of emails from the printer.
   • For Server Address, type the IP address or DNS name of the SMTP server.

   If you do not know the IP Address or DNS Name of the SMTP server, click Select Server from List.

   Note: This feature requires that specific configurations be made to your network. For details, contact your network administrator.
   • For Outgoing SMTP Port Number, type the default port number required for the SMTP server, or select a number from the range provided.

   Note: This feature requires you to make specific configurations to your network. For details, contact your network administrator.

   Note: Common default port numbers for SMTP include 25, 465, and 587.

   If you do not know the IP Address or DNS Name of the SMTP server, click Select Server from List.
7. As needed for your environment, select a Connection Security protocol.
8. As needed for your environment, select an Outgoing SMTP Authentication type.
   a. If authentication is required, click SMTP Authentication, then select SMTP AUTH. If authentication is not required, select Off.
   b. If authentication is required, for SMTP AUTH User Name, enter a valid SMTP Login Name for the SMTP Server.
   c. If authentication is required, for SMTP AUTH Password, enter a valid password for the SMTP server.
**Note:** Ensure that the authentication type is compatible with your SMTP server.

9. For **Retype Password**, reenter the password.

10. To save changes, click **OK**.

**Note:** To obtain your SMTP server name or IP address, contact your Internet service provider or system administrator. Some Internet service providers require authentication. Ensure that you confirm the authentication type, login, and password.

## Configuring Email Alerts

**Note:** Before configuring email alerts, configure the printer to communicate with your SMTP email server. For details, refer to **Configuring the SMTP Server Settings**.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.

3. On the Home page, for Supplies, click **Details**.

4. For Options, click **Email Alerts**.

5. For Email Alerts, type the email address for the recipient.

   **Note:** A check mark on the toggle button indicates that the setting is enabled.

6. To enable or disable an email alert, for the alert type, click the toggle button.

7. Click **OK**.

## Configuring PDL Settings from the Embedded Web Server

You can configure settings for the following PDL protocols:

- PCL® 6/5e
- PostScript®
- PDF
- TIFF/JPEG

**Note:** PCL® 6/5e is the default PDL protocol.

### Configure Settings for PCL 6/5e

**Note:** Default PCL® settings are used when a print driver is not selected. Print driver settings override default PCL® settings configured from the Embedded Web Server.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **System → PDL Settings**.

4. Click **PCL 6/5e**.

5. Configure the following settings as needed:
   - To set the priority mode for print quantity, click **Print Quantity Priority**, then select an option.
   - To set the limit for number of sheets to print, for Print Quantity, type a number.
   - To specify the default paper tray, click **Paper Tray**, then select a paper tray. To allow automatic tray selection, select **Auto**.
   - To specify the default paper size for the default paper tray, click **Paper Size**, then select a paper size.
   - To specify the paper size for the Bypass Tray, click **Paper Size (Bypass Tray)**, then select a paper size.
   - To select the maximum custom paper size width, for Custom Paper Size Width, type a number.
   - To select the maximum custom paper size length, for Custom Paper Size Length, type a number.
   - To set the default output color, click **Output Color**, then select an option. To allow automatic color output based on the original document, select **Auto Detect**.
   - To set the default printing option for 2-sided printing, click **2-Sided**, then select an option.
   - To configure the printer not to print blank pages, for Remove Blank Pages, click the toggle button.

     **Note:** A check mark on the toggle button indicates that the feature is enabled.

   - To set the default page orientation for the original document, click **Original Orientation**, then select an option.
   - To enable Wide A4 printing, for Wide A4, click the toggle button.
   - To set the default pitch size, for Pitch Size, enter a number.
   - To set the default output font point size, for Point Size, type a number.
   - To set the default output font, click **Font Name**, then select a font.
   - To specify the default symbol set for the selected font, click **Symbol Set**, then select an option.
   - To set the maximum limit of lines allowed on the page output, for Lines per Page, type a number.
   - To enable Hex Dump, for Hex Dump, click the toggle button.
   - To allow the printer to enhance the image automatically, for Image Enhancement, click the toggle button.

6. To save your settings, click **OK**.

---

**Configure Settings for PostScript**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.

3. Click **System → PDL Settings**.

4. Click **PostScript**.
5. Configure the following settings as needed:
   • To allow a report to print when an error occurs, for Print Error Sheet, click the toggle button.
     
     \textit{Note:} A check mark on the toggle button indicates that the feature is enabled.
   • To specify the default paper tray, click \textit{Paper Supply}, then select an option.

6. Click \textit{OK}.

\textbf{Configure Settings for PDF}

\textit{Note:} Default PDF settings are used when a print driver is not selected. Print driver settings
override default PDF settings configured from the Embedded Web Server.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
   then press \textit{Enter} or \textit{Return}.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to \textit{Logging In as the Administrator at the Control Panel}.

3. Click \textit{System \rightarrow PDL Settings}.

4. Click \textit{PDF}.

5. Configure the following settings as needed:
   • To specify the protocol used to construct the PDF output, click \textit{Decomposer}, then select an option.
   • To set the limit for number of printed pages, for Print Quantity, type a number.
     
     \textit{Note:} A check mark on the toggle button indicates that the feature is enabled.
   • To specify the default paper size for the output, click \textit{Paper Size}, then select a paper size.
   • To set the default output color, click \textit{Output Color}, then select an option. To allow automatic color output based on the original document, select \textit{Auto Detect}.
   • To set the default option for 2-sided printing, click \textit{2-Sided}, then select an option.
   • To allow output page collation, click \textit{Collated}, then select \textit{On}.
   • To specify output quality, click \textit{Print Mode}, then select an option.
   • To select a layout mode for the output, click \textit{Layout}, then select an option.
   • To require a password to open the PDF output, for Password, type a password.
     
     \textit{Note:} To remove the dots in the Password field, double-click the field.

6. Click \textit{OK}.

\textbf{Configure Settings for TIFF and JPEG}

\textit{Note:} Default TIFF and JPEG settings are used when a print driver is not selected. Print driver settings
override default TIFF and JPEG settings configured from the Embedded Web Server.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
   then press \textit{Enter} or \textit{Return}.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to \textit{Logging In as the Administrator at the Control Panel}.

3. Click \textit{System \rightarrow PDL Settings}.

4. Click \textit{TIFF/JPEG}.
5. To specify the default paper size for the output, click Paper Size, then select a paper size.
6. Click OK.

**Viewing Version Information for a PDL Protocol**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → PDL Settings.
4. To view version information for a PDL protocol, click the protocol name. Version information displays at the top of the settings page.
5. To return to the PDL Settings page, click OK or Cancel.

>Note: Version information is available for PostScript®, TIFF, and XPS.
Configuring General Settings Using the Control Panel

Use these topics to configure general settings for the printer using the control panel. You can configure many printer settings from the control panel, including settings for power saver mode, alerts, touch screen, security, and printing defaults.

Configuring System Settings

You can use this menu to configure system settings, such as Power Saver timers and clock settings.

Accessing the System Settings Menu

1. At the printer control panel, press Menu.
   
   \[Note: To navigate through the menu, use the arrow buttons.\]

2. Navigate to Admin Menu, then press OK.
3. Navigate to System Settings, then press OK.

Configuring Power Saver Mode Using the Control Panel

You can set the time the printer spends idle in ready mode before the printer transitions to a lower power level.

To configure Power Saver mode settings:

1. At the printer control panel, press Menu.
2. Navigate to Admin Menu, then press OK.
3. Navigate to System Settings, then press OK.
4. Select the Timer that you want to change, then press OK.
   - **Low Power Timer**: Set the time when the printer shifts from Ready mode to Low Power mode.
   - **Sleep Mode Timer**: Set the time when the printer shifts from Low Power mode to Sleep mode.
   - **Power Off**: Set the time of day for the printer to power off.

   \[Note: To set the timer values, use the arrow buttons.\]

5. If you select Power Off, do the following:
   a. In the Power Off menu, navigate to Scheduled, then press OK.
   b. Use the arrow buttons to select Enabled or Disabled, then press OK.
   c. If you enable the feature, navigate to Power Off Time, then press OK. Use the arrow buttons to enter the time of day the device powers off.

6. Press OK.
7. To return the printer to Ready, press Menu.
Setting the System Clock at the Control Panel

To access the System Clock menu:
1. At the printer control panel, press **Menu**.

   **Note:** To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **System Settings**, then press **OK**.
4. Navigate to **System Clock**, then press **OK**.

To set the date:
1. From the System Clock menu, navigate to **Set Date**, then press **OK**.
2. To set the month, day, and year, use the arrow buttons. When finished, press **OK**.
3. To return to the System Clock menu, press **Back**.
4. Navigate to **Date Format**, then press **OK**.
5. To select a date format, use the arrow buttons, then press **OK**.
6. To return to the System Clock menu, press **Back**.
7. If the date and time are set, to return the printer to Ready, press **Menu**.

To set the time:
1. From the System Clock menu, navigate to **Set Date**, then press **OK**.
2. To set the hour and minutes, use the arrow buttons. When finished, press **OK**.
3. To return to the System Clock menu, press **Back**.
4. Navigate to **Time Format**, then press **OK**.
5. To select the time format, navigate to **12 Hour Clock** or **24 Hour Clock**, then press **OK**.
6. To return to the System Clock menu, press **Back**.
7. If the date and time are set, to return the printer to Ready, press **Menu**.

Setting the Measurement Units

1. At the printer control panel, press **Menu**.

   **Note:** To navigate through the menu, use the arrow buttons.

2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **System Settings**, then press **OK**.
4. Navigate to **Paper Size Pref**, then press **OK**.
5. Select **Millimeters (mm)** or **Inches (")**, then press **OK**.
6. To return the printer to Ready, press **Menu**.
Configuring Audio Tones
1. At the printer control panel, press Menu.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to System Settings, then press OK.
4. Navigate to Audio Tones, then press OK.
5. To enable tones:
   a. Navigate to All, then press OK.
   b. Navigate to On, then press OK.
6. To set the volume for a specific tone:
   a. Navigate to the tone that you want to configure, then press OK.
   b. To increase or decrease the volume, use the arrows, then press OK.
7. To return the printer to Ready, press Menu.

Configuring the Panel Timeout
The panel timeout allows you to set the delay before the control panel times out.
1. At the printer control panel, press the Menu button.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to System Settings, then press OK.
4. Navigate to Auto Clear, then press OK.
5. To select a setting, press the arrow buttons, select it, then press OK.

Configuring Printer Settings
You can use this menu to configure general settings for the printer, such as default paper size, tray priority, and output settings.

Setting the Default Paper Size
1. If needed, log in as administrator.
2. At the printer control panel, press Menu.

   Note: To navigate through the menu, use the arrow buttons.

3. Navigate to Admin Menu, then press OK.
4. Navigate to Printer Settings, then press OK.
5. Navigate to Default Paper Size, then press OK.
6. Navigate to the desired size, then press **OK**.
7. To return the printer to Ready, press **Menu**.

### Configuring Tray Priority

The Tray Priority feature determines the order in which the printer selects the tray for a print job when you have not specified one. Tray Priority also determines how the printer selects another tray when a paper tray runs out in the middle of a job. Priority 1 indicates that the tray is set to the highest priority.

To set the priority for a tray:

1. At the printer control panel, press **Menu**.
   - **Note:** To navigate through the menu, use the arrow buttons.
2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **Printer Settings**, then press **OK**.
4. Navigate to **Paper Tray Priority**, then press **OK**.
5. Navigate to the desired tray, then press **OK**.
6. To set the paper tray to the highest priority, navigate to **Priority 1**, then press **OK**.
   - **Note:**
     - To print a report, ensure that the paper tray that you selected matches the default paper size, type, and color.
     - The Bypass Tray cannot be set to Priority 1.
     - To print a report from the Bypass Tray, remove Trays 1 and 2, then load the default paper size, type, and color in the Bypass Tray.
7. To establish priority for any remaining trays, repeat the steps.
8. To return the printer to Ready, press **Menu**.

### Configuring Paper Type Mismatch Settings

1. At the printer control panel, press **Menu**.
   - **Note:** To navigate through the menu, use the arrow buttons.
2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **Printer Menu**, then press **OK**.
4. To select what action the printer takes when a paper mismatch occurs, navigate to **Paper Type Mismatch**, then press **OK**.
5. To select an option, use the Up or Down arrow buttons:
   - **Confirmation Screen:** This option directs the printer to display a menu to confirm or change paper settings.
   - **Print:** This option directs the printer to print with no further action.
   - **Paper Supply Screen:** This option directs the printer to display a menu to change or confirm the source paper tray.
6. Press **OK**.
7. To return the printer to Ready, press **Menu**.

**Configuring the Output Settings**

You can use this menu to configure printer output settings.

To enable printing the user ID on the output page:
1. At the printer control panel, press **Menu**.

   **Note:** To navigate through the menu, use the arrow buttons. To select a menu item, press **OK**.

2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **Printer Settings**, then press **OK**.
4. To configure the device to print the user ID on the output page, navigate to **Print User ID**, then press **OK**.
5. To select a setting, press the arrow buttons, then press **OK**.
6. To return the printer to Ready, press **Menu**.

To configure banner page settings:
1. At the printer control panel, press **Menu**.

   **Note:** To navigate through the menu, use the arrow buttons. To select a menu item, press **OK**.

2. Navigate to **Admin Menu**, then press **OK**.
3. Navigate to **System Settings**, then press **OK**.
4. To specify if a banner page is printed, navigate to **Banner Settings**, then press **OK**.
5. Navigate to **Banner Sheet**, then press **OK**.
6. To select an option, use the arrow buttons:
   - **Off**: This option directs the printer not to print a banner pages.
   - **Start Sheet**: This option directs the printer to insert a banner page before the first page of each print job.
   - **End**: This option directs the printer to insert a banner page after the last page of every print job.
   - **Start and End**: This option directs the printer to insert a banner pages before the first page and after the last page of every print job.
7. Press **OK**.
8. To return the printer to Ready, press **Menu**.

To configure the banner page tray settings:
1. At the printer control panel, press **Menu**.

   **Note:** To navigate through the menu, use the arrow buttons. To select a menu item, press **OK**.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **System Settings**, then press **OK**.

4. Navigate to **Banner Settings**, then press **OK**.

5. To select the tray from which the banner page is printed, navigate to **Banner Tray**, then press **OK**.

6. To select a tray, press the arrow buttons, then press **OK**.

7. To return the printer to Ready, press **Menu**.

---

**Restoring Memory Settings and Deleting Data**

You can restore the printer memory to default settings, delete all job data, and delete Secure Print jobs that have not completed.

**Initializing NVM**

The non-volatile memory (NVM) stores printer settings, even after the power is turned off. The Initialize NVM feature resets the settings stored in the printer, including paper settings, tray settings, and connectivity settings. After executing this function and restarting the printer, all menu settings are reset to their default values.

To initialize non-volatile memory:

1. At the printer control panel, press the **Menu** button.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Init/Delete Data**, then press **OK**.

4. Navigate to **NVM**, then press **OK**.

5. At the prompts, press **OK**, then press **OK** again.

When the process is complete, the printer restarts automatically.

**Deleting All Data**

The non-volatile memory (NVM) stores printer settings, even after the power is turned off. The Deleting All Data feature erases all settings and returns the printer to original factory state. All jobs, presets, Apps, and device settings are reset. When complete, the printer restarts, then displays the Install Wizard.

To delete all data:

1. At the printer control panel, press the **Menu** button.

2. Navigate to **Admin Menu**, then press **OK**.

3. Navigate to **Init/Delete Data**, then press **OK**.

4. Navigate to **Delete All Data**, then press **OK**.

5. At the prompts, press **OK**, then press **OK** again.
When the process is complete, the printer restarts automatically.

Deleting Secure Print Jobs

After a Secure Print job is printed, it is deleted automatically. If the passcode to print Secure Print jobs is unknown, you can delete the jobs manually.

To delete all Secure Print jobs stored on the printer:

1. At the printer control panel, press the Menu button.
2. Navigate to Admin Menu, then press OK.
3. Navigate to Init/Delete Data, then press OK.
4. Navigate to Secure Print Jobs, then press OK.
5. At the prompts, press OK, then press OK again.

When the process is complete, the printer restarts automatically.
Configuring Default Settings and Printing Policies from the Embedded Web Server

This section provides information to help you configure default settings and printing policies for the printer. You can configure these settings from your Web browser using the Embedded Web Server. You can configure settings for paper supply, printer defaults, and reports.

Configuring Common Settings

Adjusting the Color Manually

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.

4. For Common, click Manual Color Adjustment.

5. In the Photo area, for Shadow, for Midtone, and for Highlight, adjust individual colors, as needed.

6. In the Text area, for Shadow, for Midtone, and for Highlight, adjust individual colors, as needed.

7. Click OK.

Configuring Paper Supply Settings

Adjusting the Paper Type

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.

4. For Paper Supply, click Adjust Paper Type.

5. To adjust a paper type, click the paper type name, then select an option.

6. After you have completed all paper type adjustments, click OK.
Configuring Custom Paper Names

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   **Note:** If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.


5. To give a custom name to a paper type, for the Custom Paper Type, type a name.

6. After you have completed the paper name adjustments, click OK.

Setting Printer Policies

Configuring Jobs Policies

You can set policies for your print jobs. You can configure settings for Print Around, job name concealment, and stored print jobs.

When a print job is paused or in an error state, the Print Around feature allows the subsequent jobs in the queue to print. For example, a print job can be paused because it requires paper that is not loaded in a tray. When Print Around is enabled, any subsequent job that requires another paper type prints immediately, even though a preceding job is held.

Enabling Print Around

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Jobs → Policies.

4. For Print Around, click the Enable toggle button.

   **Note:** A check mark on the toggle button indicates that the feature is enabled.

5. Click OK.

6. Click Restart Now.

Concealing or Showing Job Names

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Jobs.

4. Click Policies.
System Administrator Functions

5. For Conceal Job Names, select an option.
6. Click OK.
7. Click Restart Now.

Configuring Stored Print Job Settings
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click Jobs.
4. Click Policies.
5. In the Stored Print Job Settings area, for Minimum Number of Passcode Digits, type a number.
6. For Delete Stored Print Jobs After, select an option:
   - To save stored print jobs, select Off.
   - To delete print jobs after the specified number of days at the specified time, select Days. Type the number of days, select AM or PM, then type the time in hours and minutes.
   - To delete print jobs after the specified length of time, select Length of Time. Type the number of Hours and Minutes.
7. Click OK.
8. Click Restart Now.

Configuring PostScript® Memory
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Defaults and Policies.
4. For Printer Settings, click Memory Settings.
5. To specify the amount of memory allowed for PostScript® data, for PostScript Memory, type a number, in kilobytes.

   Note: The system requires that the number is a multiple of 256.
6. Click OK.
7. Click Restart Now.
Setting Policies for Allowed Print Job Types

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   \[ \text{Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.} \]

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.

4. For Printer Settings, click Allowed Print Job Types.

5. Select an option:
   - Personal, Secure, and Saved Only: This option limits the job types allowed.
   - All Jobs: This option allows any job type.

6. Click OK.

7. Click Restart Now.

Setting Policies for When a Paper Type is Unavailable

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   \[ \text{Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.} \]

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.

4. For Printer Settings, click Specified Paper is Unavailable.

5. Select an option:
   - Prompt to Load Paper: This option requires a user to load the specified paper type before the job can proceed.
   - Letter/A4 Substitution: This option allows the printer to substitute a loaded media that is of similar size.

6. Click OK.

7. Click Restart Now.

Setting Print Job Policies for When an Error Occurs

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   \[ \text{Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.} \]

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.
4. For Printer Settings, click Resume Print After Error.

5. To resume print jobs after the error is cleared, select an option:
   • To allow the print job to continue automatically, select Auto Resume.
   • To require user input before the job can continue, select Manual Resume.

6. Click OK.

7. Click Restart Now.

**Setting Print Job Policies for When a Paper Jam Occurs**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   ![Note:](image)
   If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.

4. For Printer Settings, click When Paper Jam Occurs.

5. Select an option for resuming print jobs after the paper jam is cleared:
   • To allow the print job to continue automatically, select Resume Print After Jam Clearance.
   • To delete the job in memory, select Cancel Print.

   ![Note:](image)
   To print a job that was canceled after jam clearance, resubmit the job.

6. Click OK.

7. Click Restart Now.

**Setting Printing Policies for Banner Pages**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   ![Note:](image)
   If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.

4. For Printer Settings, click Print Banner Pages.

5. Configure options as desired:
   • To configure banner page print settings, click Print Banner Pages, then select an option.
   • To disable banner page printing, click Print Banner Pages, then select Off.
   • To select a paper source for banner pages, touch Paper Tray, then select the desired tray.
   • To allow users to choose to print a banner page from a print driver, for Allow Print Driver to Override, click the toggle button.

   ![Note:](image)
   A check mark on the toggle button indicates that the feature is enabled.
6. Click OK.
7. Click Restart Now.

Configuring Report Settings

Setting the Output Tray for Reports

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.


5. Select the output paper tray where you want the reports to print. For automatic tray selection, select Auto.

6. Click OK.

Enabling the Job Deletion Report

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Defaults and Policies.


5. To allow the job deletion report to print, select On.

6. Click OK.
Configuring Secure Settings

You can use security settings to configure administrative settings, authentication, user roles, access permissions, and app access.

Note: For details, refer to the Help in the Embedded Web Server.

Logging In as the Administrator at the Control Panel

For software versions earlier than PL6 (XX.5X.XX), the default administrator password is 1111. For software versions PL6 (XX.5X.XX) or later, the default administrator password is the device serial number. You can obtain the serial number from the back of the printer, from the configuration report, or from the home page of the Embedded Web Server. The password is case-sensitive.

Note: Upgrading to PL6 (XX.5X.XX) does not change the administrator password. If you reset the device to factory defaults, the administrator password changes to the device serial number for versions PL6 (XX.5X.XX) or later of the software.

To access the control panel as the administrator:
1. At the printer control panel, press **Menu**.
2. If **Panel Lock** is On, you are prompted to enter the passcode to access the control panel menus.
3. At the prompt, to enter numbers at the control panel, select an option:
   - To select a number, press the **Up** or **Down** arrow buttons.
   - To scroll quickly, hold down the **Up** or **Down** arrow buttons.
   - To move to the next number field, press the **Right** arrow button.
   - To move to the previous number field, press the **Left** arrow button.
4. When finished, press **OK**.

Logging In as the Administrator at the Embedded Web Server

For software versions earlier than PL6 (XX.5X.XX), the default administrator password is 1111. For software versions PL6 (XX.5X.XX) or later, the default administrator password is the device serial number. You can obtain the serial number from the back of the printer, from the configuration report, or from the home page of the Embedded Web Server. The password is case-sensitive.

Note: Upgrading to PL6 (XX.5X.XX) does not change the administrator password. If you reset the device to factory defaults, the administrator password changes to the device serial number for versions PL6 (XX.5X.XX) or later of the software.

To log in to the Embedded Web Server as the administrator:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.
2. At the top of the page, click **Log In**.
3. Click **admin**.
4. Type the administrator password, then click **Log In**.

### Opening the Security Menu

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

   *Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.*

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click **System → Security**.

### Accessing the Advanced Security Settings

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click **Permissions**, then click **Login/Logout Settings**.

4. For Advanced Settings, click **Edit**.

### Configuring the Advanced Security Settings

To configure the log in security settings:

1. In the Embedded Web Server, access the Advanced Security Menu. For details, refer to Accessing the Advanced Security Settings.

2. To set the case sensitivity for the user name input, click **Case Sensitive User Name**, click either **Case Sensitive** or **Not Case Sensitive**, then click **OK**.

3. To configure logging of failed login attempts, click **Log Failed Login Attempts**.
   - To enable logging for failed login attempts, click the **Log Failed Login Attempts** toggle button.
   - To set the maximum number of failed login attempts allowed within a specific time period, in the Failed Login Attempt Limit field, type a number.
   - Click **OK**.

4. To configure limits for administrator login attempts, click **Limit Login Attempts of System Administrator**.
   - To limit the administrator login attempts, click the **Limit Login Attempts of System Administrator** toggle button.
   - To set the maximum number of failed login attempts allowed before the administrator login is disabled, in the Failed Login Attempt Limit field, type a number.
System Administrator Functions

**Note:** This setting is available only if more than one user is a member of the System Administrator device role.

5. Click **OK**.

To configure more advanced security settings:

1. In the Embedded Web Server, access the **Advanced Security Menu**. For details, refer to Accessing the Advanced Security Settings.

2. To set the timeout for the server authentication, in the Server Authentication Response Timeout field, type a number.

3. To set the timeout for the search function, in the Search Timeout field, type a number.

4. To configure the options for displaying the user name during login, click **Display User Name**.
   a. To hide the user name during login, click **Hide**.
   b. To hide the user name when using a smart card, click **Hide Smart Card ID**.
   c. To show the user name during login, click **Show**.

5. To obtain the user information during login, click **Obtain User Information at Login**, click **On**, then click **OK**.

6. To store the login information on the device, click **Store Login Information on Device**, then click **On**.

7. To save your settings, click **OK**.

**LDAP Server**

Lightweight Directory Access Protocol (LDAP) is a protocol used to process queries and updates to an LDAP information directory, on an external server. LDAP can also be used for network authentication and authorization. LDAP directories are optimized heavily for read performance. Use this page to define how the printer retrieves user information from an LDAP directory.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click **Connectivity** → **LDAP** → **LDAP Servers/Directory Services**.

4. For IP Address/Host Name: Port, enter the IP address or DNS name for the LDAP server, then enter the port number for LDAP.

5. Configure the optional LDAP server information as needed.
   a. In the Search Directory Root field using Base DN format, type the root path of the search directory. For example, DC=xerox, DC=net.
   b. Select the type of LDAP Server.
   c. Type the Login Name and Password used to access the server.
   d. For Search Timeout, specify the type of timeout to use for the server. You can set the LDAP server to limit the time or you can set the time limit manually in the seconds field.

6. Click **OK**.

7. To enable LDAP-SSL/TLS:
a. Click **System→Security**.  
   b. For Network Security, click **SSL/TLS Settings**.  
   c. To enable LDAP-SSL/TLS, click the **LDAP - SSL/TLS Communication** toggle button.

8. Click **OK**.  
9. At the prompt, click **Restart Now**.

**LDAP User Mapping**

LDAP servers display different results depending on how they implement mappings. Use this page to map LDAP fields to fields on your printer. Editing current map settings allows you to fine-tune server search results.

**Before you begin:**

- Ensure that you have configured the LDAP server settings. For details, refer to **LDAP Server**.
- Ensure that you have set LDAP for authentication. For details, refer to **Configuring an LDAP Authentication System**.
- Ensure that LDAP is enabled. For details, refer to **Configuring the Network Authentication**.
- Ensure that Network Authentication is enabled. For details, refer to **Configuring Secure Settings**.

**To define LDAP user mappings:**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **Connectivity**.
4. For Protocols, click **LDAP**, then click **LDAP User Mappings**.
5. In the User Name field, type a user name, then click **Search**.
6. If Network Authentication is enabled, the Home field appears. The Home field indicates the location of the user personal directory. The system administrator defines the default for home Directory when the user account is created.
7. If incorrect information is shown in the User Mapping fields, as required, change the information.
8. Click **OK**.
9. At the prompt, click **Restart Now**.

**Configuring LDAP Authentication**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **Connectivity**.
4. For Protocols, click **LDAP**, then click **LDAP Authentication**.
5. To use a text string to add to the user name, for Use Added Text String, click the toggle button.
   
   **Note:** A check mark on the toggle button indicates that the feature is enabled.

6. For Added Text String, enter the text string to add to the user name for authentication.

7. Click **OK**, then click **Close**.

### Configuring the Network Authentication

Network Authentication is a security protocol that requires users to provide their login credentials before they can access the printer. The printer compares the user credentials to the information stored on an authentication server.

To prove their identity, users can type their user credentials at the control panel, in the Embedded Web Server, or they can use a card reader.

To configure access rights using network authentication:

To access the authentication system:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click **Permissions**.
4. Click **Login/Logout Settings**.
5. For Network, click **Edit**.
6. For Network Login, select **LDAP**, then click **Next**.
7. Configure the authentication system. For details, refer to Configuring an LDAP Authentication System.

### Configuring an LDAP Authentication System

Before using LDAP servers for authentication, configure the settings in the Embedded Web Server.

To configure an LDAP system:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click **Permissions**, then click **Login/Logout Settings**.
4. For Network, click **Edit**.
5. In Network Login, select **LDAP**, then click **Next**.
6. In LDAP, click each of the topics in the list. In each window, perform the required configuration, then click **OK**.
7. When the LDAP configuration is finished, click **Done**.
Configuring Password Rules

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Password Rules.

5. For Minimum Length and Maximum Length, type the minimum and maximum number of characters allowed for the password.

6. To allow or disallow the user name as part of the password, for Password Contains User Name, select an option.

7. To set the security level for passwords, for Password Complexity, select an option.

8. Click OK.

Limiting Login Attempts

1. At the printer control panel, press the Menu button.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.

3. Navigate to System Settings, then press OK.

4. Navigate to Panel Settings, then press OK.

5. Navigate to Max. Login Attempts, then press OK.

6. Navigate to Limit, then press OK.

7. At the prompt, enter the maximum attempts, then press OK.

8. To return the printer to Ready, press Menu.

Setting the Panel Lock

You can use Panel Lock to limit access to the menus. When Panel Lock is enabled, access to the menus requires a password.

To set Panel Lock:

1. At the printer control panel, press the Menu button.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.

3. Navigate to System Settings, then press OK.

4. Navigate to Panel Settings, then press OK.
5. Navigate to Panel Lock, then press OK.
6. Navigate to On, then press OK.
7. At the prompt, enter a numeric passcode, then press OK.
8. At the prompt, reenter the passcode, then press OK.
9. To return the printer to Ready, press Menu.

To change the Panel Lock passcode:
1. At the printer control panel, press the Menu button.

   Note: To navigate through the menu, use the arrow buttons.

2. Navigate to Admin Menu, then press OK.
3. Navigate to System Settings, then press OK.
4. Navigate to Panel Settings, then press OK.
5. Navigate to Change Passcode, then press OK.
6. At the prompt, enter a numeric passcode, then press OK.
7. At the prompt, reenter the passcode, then press OK.
8. To return the printer to Ready, press Menu.

Enabling HTTPS Using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Accessing the Embedded Web Server as a System Administrator.
3. Click Connectivity → HTTP.
4. To enable HTTPS, click the HTTPS (SSL) toggle button.

   Note: A check mark on the toggle button indicates that the setting is enabled.
5. Click OK.
6. To activate your changes, at the prompt, click Restart Now.
Configuring SSL Settings in the Embedded Web Server

Secure Sockets Layer (SSL) is a protocol that creates an encrypted connection between your printer and a server.

To enable SSL, a digital certificate is required.

To create a digital certificate:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Security.
4. For Certificates, click Security Certificates.
5. From the Security Certificates menu, select Device Certificates.
6. Click Create, then select Create Self-Signed Certificate.
7. Select your Hash Algorithm and Public Key Length. For assistance, contact your system administrator.
8. To set the number of days for the certificate to remain valid, type the desired number of days in the Validity Period field.
9. Click Create.
10. To return to the Security Certificates page, at the prompt, click Close.
11. To close the Security Certificates page, click Close.

To configure the SSL Settings:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Security.
5. Select one or more protocols from the list of SSL and TLS protocols.
6. To select a Device Certificate for the server, click in the Device Certificate - Server area, then select a certificate from the list.
7. To enable SSL communication, click the HTTP - SSL/TLS Communication toggle button.
8. For HTTP - SSL/TLS Port Number, type a valid port number.

Caution: Before changing the default value of 443, contact your system administrator.
9. If your LDAP server requires SSL communication using LDAP authentication, click the LDAP - SSL/TLS Communication toggle button.
10. To enable SSL communication for SMTP, click SMTP - SSL/TLS Communication, then select an option.
11. If necessary for your environment, click the Verify Remote Server Certificate toggle button, then click OK.
12. To activate your changes, at the prompt, click Restart Now.

Note: A check mark on the toggle button indicates that the setting is enabled.

Configuring IP Address Filtering

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Security.
4. Click IP Address Filtering.
5. For IP Address Filtering, to enable an Internet Protocol, click its associated toggle button.

Note: A check mark on the toggle button indicates that the feature is enabled.

6. To add an IP Address:
   a. For Allowed IP Address/Subnet Mask, click Add.
   b. In the Enter IP Address field, enter the IP address of the host as X.X.X.X, where X is a number from 0 through 255. For example, 192.168.200.10.
   c. In the Enter IP Mask field, enter the last digits of the network mask for the host.
   d. Click OK.
7. To remove an allowed IP Address, for the IP Address:
   a. Click the Trash icon.
   b. At the prompt, click Delete.
8. To edit an allowed IP Address:
   a. From the allowed IP Address list, click the IP Address.
   b. Edit the information.
   c. Click OK.
9. When finished, to save your settings, at IP Address Filtering, click OK.
Configuring User Roles and Access Permissions

You can configure permissions settings, such as login settings, user roles, printing restrictions, and password rules.

Setting the Login Method

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   ✂️ **Note:** If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. In the Embedded Web Server, click Permissions → Login/Logout Settings.

4. To change the options for the selected login method, click Edit.

5. To change the login method to another login method:
   a. Click Select.
   b. Select options as needed.
   c. Click OK.
   d. To confirm the change, at the prompt, click Change.

   To activate your changes, the printer restarts automatically.

   ✂️ **Note:** For details on network authentication, refer to Configuring the Network Authentication.

6. To configure other login settings, for Advanced Settings, click Edit.
   a. For Input Settings, and Authentication Settings, make selections as needed.
   b. Click OK.
   c. To activate your changes, at the prompt, click Restart Now.

Managing User Accounts

User accounts allow you to manage device and printing permissions. You can create, modify, and delete user accounts. You can also configure settings for the guest user account.

Configuring Access Permissions for a Guest User

You can set device access and printing permissions for a guest user. A guest user is any user that is not logged in to the device.

To configure device access permissions for a guest user:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

2. In the Embedded Web Server, click Permissions.
3. For Guest Access, select **Edit**.
4. Select **Device User Role**, then select a role from the list.
5. To set Custom Permissions:
   a. Click **Custom Permissions**.
   b. Click **Setup**.
   c. Select **Home** or **Jobs**.
   d. Configure the permissions as needed.
   e. Click **OK**.
   f. Click **Close**.
6. Click **OK**.

To configure printing permissions for a guest user:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, click **Permissions**.
3. For Guest Access, select **Edit**.
4. Select **Printing User Role**.
5. For Printing Permissions, select an option.
   
   ![Note:](image) When you select Custom Permissions, more print settings appear. Configure the settings as needed.
6. Click **OK**.

### Adding a User Account

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, click **Permissions**.
3. For User Accounts, click **Add**.
4. Type a user name and click **Add**.

The new user account appears in the User Accounts list.

### Adding a Photo to a User Account

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
   
   ![Note:](image) If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click **Permissions**.
4. For User Accounts, select a user account.
5. On the Profile Photo icon, click the Pencil icon.
7. Click OK.

Changing Device Access Permissions for a User

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.
4. For User Accounts, select a user account.
5. For Roles, click Device User Role.
6. Select a role from the list.
7. Click OK.

Changing Printing Permissions for a User

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.
4. For User Accounts, select a user account.
5. For Roles, click Printing User Role.
6. Select a role from the list.
7. Click OK.

Configuring Guest User Permissions for Printing from an Application

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.
System Administrator Functions

4. For Guest Access, click **Edit**.
5. For Printing Permissions, select **Custom Permissions**.
6. Select **Printing User Role**.
7. For Application Permissions, click **Setup**.
8. To allow or restrict printing from an application, click the application name.
9. Set options as needed, then click **OK**.
10. To exit the Application Permissions page, click **Close**.
11. To save your changes and exit the Edit Role page, click **OK**.

**Restoring the Home Screen and Apps to Default Settings for a User Account**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
   
   Note: If you do not know the IP address for your printer, refer to **Finding the IP Address of Your Printer**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **Permissions**.
4. For User Accounts, select a user account.
5. For Personalizations, click **Reset**.
6. To confirm, click **Reset**.

**Linking a PC User Name to a User Account for Job Status Updates**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
   
   Note: If you do not know the IP address for your printer, refer to **Finding the IP Address of Your Printer**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **Permissions**.
4. For PC User Names, click **Link Account**.
5. Type the PC User Name.
6. Click **OK**.

Note: You can link multiple PC user names to a user account.
Adding an Email Address to a User Account

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. For Email "From" Address, click Edit.

5. Type the email address.

6. Click OK.

Deleting a User Account

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. For User Accounts, select an account.

5. Click Delete User.

6. To confirm, click Delete.
Managing Device User Roles

Device User Roles determine what appears on the printer control panel or in the Embedded Web Server for a logged-in user. You can create, modify, and delete device user roles. You can also associate user accounts with device user roles. Users added to a role are limited to the access permissions defined for the role. A user that is not a member of a custom device user role automatically becomes a member of the Basic User role.

Adding a Device User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Device User Roles.

6. For Device User Roles, click the Plus icon (+).

7. Select an option:
   - To start with the default settings, select Add New Role.
   - To start with settings from an existing role, select Add New Role from Existing, then select a role from the list.

8. Type a name and description for the new role.

9. For Device Website Permissions, select options as required.
   
   Note: If you select Custom Permissions, click Setup, then configure settings as needed.

10. Click OK.

Editing a Device User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Device User Roles.

6. In the Device User Roles area, select a role, then click Edit.
7. For Device Website Permissions, select options as needed.

   Note: When you select Custom Permissions, click Setup, then configure the settings as needed.

8. Click OK.

Adding Members to a Device User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Device User Roles.

6. In the Device User Roles area, select a role, then click Members.

7. For Members, click the Plus icon (+).

8. Select the members that you want to add to the Device User Role.

9. Click OK.

Deleting Members from a Device User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Device User Roles.

6. In the Device User Roles area, select a role, then click Members.

7. Select the user that you want to remove from the Device User Role.

8. Click OK.

   Note: Deleting a user from a custom role adds the user to the Basic User role.
Deleting a Device User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Device User Roles.

6. In the Device User Roles area, select a role, then click Edit.

7. At the bottom of the Edit Role page, click Delete.

8. To confirm, click Delete.

   Note:
   
   - Members deleted from a Custom Permissions role are added automatically to the Basic Printing User role.
   - You cannot delete the Basic User role.
Managing Printing User Roles

A Printing User Role is a set of permissions that governs print jobs that are submitted from a computer. You can create, modify, delete, and associate user accounts to printing user roles. Users added to a role are limited to the printing permissions defined for the role. A user that is not a member of a custom role automatically becomes a member of the Basic Printing User role.

You can set permissions for the following items:
- Days and times during which the user is allowed to print
- Color printing
- Job types
- 1-sided output
- Specific paper tray usage
- Printing from individual applications

Adding a Printing User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Printing User Roles.

6. For Printing User Roles, click the Plus icon (+).

7. Select an option:
   - To start with the default settings, select Add New Role.
   - To start with settings from an existing role, select Add New Role from Existing, then select a role from the list.

8. Type a name and description for the new role.

9. For Printing Permissions, select options as needed.

   Note: When you select Custom Permissions, more print settings appear. Configure the settings as needed.

10. Click OK.
Editing a Printing User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   > Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Printing User Roles.

6. In the Printing User Roles area, select a role, then click Edit.

7. For Printing Permissions, select options as needed.

   > Note: When you select Custom Permissions, more print settings appear. Configure the settings as needed.

8. Click OK.

Adding Members to a Printing User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   > Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Printing User Roles.

6. In the Printing User Roles area, select a role, then click Members.

7. For Members, click the Plus icon (+).

8. Select the members that you want to add to the Printing User Role.

9. Click OK.

Deleting Members from a Printing User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   > Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click **Permissions**.
4. Click **Roles**.
5. Select **Printing User Roles**.
6. In the Printing User Roles area, select a role, then click **Members**.
7. Select the user that you want to remove from the Printing User Role.
8. Click **OK**.

   **Note:** If you delete a user from a custom role, this action adds the user to the Basic Printing User role.

### Deleting a Printing User Role

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.

   **Note:** If you do not know the IP address for your printer, refer to **Finding the IP Address of Your Printer**.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **Permissions**.
4. Click **Roles**.
5. Select **Printing User Roles**.
6. In the Printing User Roles area, select a role, then click **Edit**.
7. At the bottom of the Edit Role page, click **Delete**.
8. Click **OK**.

   **Note:**
   - Members deleted from a Custom Permissions role are added automatically to the Basic Printing User role.
   - You cannot delete the Basic Printing User role.
Setting Up an LDAP User Permissions Group

You can define permissions groups using LDAP servers.

Before you begin, ensure that you have configured the LDAP server settings. For details, refer to LDAP Server.

To set up an LDAP user permissions group:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. Log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. In the Embedded Web Server, click Permissions.

4. Click Roles, then select Setup LDAP Permissions Groups.

5. Select an LDAP server, then click OK.

6. On the Permissions page, click Roles, then select Edit LDAP Groups.

7. For LDAP Groups, click the Plus icon (+).

8. In the Add LDAP Group field, type your LDAP group name, then click the search icon.

9. Select an LDAP group, then click Next.

10. For Select Device User Role, select an option, then click Next.

11. Select a user role, then click Next.

Selecting an LDAP Permissions Group

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click Permissions.

4. Click Roles.

5. Select Setup LDAP Permissions Groups.

6. Select an LDAP server.

7. Click OK.
Managing Certificates

About Security Certificates

A digital certificate is a file that contains data used to verify the identity of the client or server in a network transaction. A certificate also contains a public key used to create and verify digital signatures. One device proves its identity to another by presenting a certificate trusted by the other device. Or, the device can present a certificate signed by a trusted third party and a digital signature proving its ownership of the certificate.

A digital certificate includes the following data:

- Information about the owner of the certificate
- The certificate serial number and expiration date
- The name and digital signature of the certificate authority (CA) that issued the certificate
- A public key
- A purpose defining how the certificate and public key can be used

There are three types of certificates:

- Device Certificate: A certificate for which the printer has a private key, and the purpose specified in the certificate allows it to be used to prove identity.
- CA Certificate: A certificate with authority to sign other certificates.
- Trusted Certificate: A self-signed certificate from another device that you want to trust.

To ensure that the printer can communicate with other devices over a secure trusted connection, both devices must have certain certificates installed.

For protocols such as HTTPS, the printer is the server, and must prove its identity to the client Web browser. For protocols such as 802.1X, the printer is the client, and must prove its identity to the authentication server, typically a RADIUS server.

The following steps provide an overview of installing certificates for HTTPS and 802.1X:

- Install a device certificate on the printer.
  
  **Note:** To enable HTTPS, create a self-signed Certificate from the SSL page in the Embedded Web Server.

- Install a copy of the CA certificate that was used to sign the device certificate of the printer on the other device.

Protocols such as LDAP and IPsec require both devices to prove their identity to each other.

Certificates for the Embedded Web Server

Your device includes a self-signed HTTPS certificate. The device generates the certificate automatically during device installation. The certificate is used to encrypt communications between your computer and the Xerox device.
Note:

- The Embedded Web Server page for your Xerox device can display an error message that the security certificate is not trusted. This configuration does not lessen the security of the communications between your computer and the Xerox device.
- To eliminate the connection warning in your Web browser, you can replace the self-signed certificate with a signed certificate from a Certificate Authority. For information on obtaining a certificate from a Certificate Authority, contact your Internet Service Provider.

**Obtaining a Device Server Certificate from a Certificate Authority**

1. In the Embedded Web Server, log in as administrator. For details, refer to Accessing the Embedded Web Server as a System Administrator.
2. Click **System → Security**.
3. In the Certificates area, click **Security Certificates**.
4. Click **Create**, then select **Create Certificate Signing Request (CSR)**.
5. In each of the fields, enter values that are correct for your implementation.
   
   **Note:** For information on the correct values for your implementation, refer to [https://tools.ietf.org/html/rfc2511](https://tools.ietf.org/html/rfc2511).
6. To save the details and generate the CSR file, click **Create**.
7. To download the CSR file, click **Download**. Save the downloaded file to a selected location.
   
   **Note:** The CSR file is named default.pem.
8. To obtain the Device Server certificate file for your device, locate the file named default.pem, then exchange it with your Certificate Authority.
   
   **Note:** For information on exchanging the CSR default.pem file for a Device Server certificate, contact your local Certificate Authority.
9. Save the certificate file in a local folder on your computer hard drive.

**Installing and Selecting a Device Server Certificate Using the Embedded Web Server**

Before installing a Device Server Certificate, ensure that the certificate is in the correct format. Supported certificate encodings and typical file extensions include:

- Distinguished Encoding Rules (DER): `.cer`, `.crt`, `.der`
- PKCS#7: `.p7b`

**Note:** For information on obtaining a Device Server Certificate in the correct format, contact your Certificate Authority.

To install and select a Device Server Certificate for a Xerox device using the Embedded Web Server:

1. In the Embedded Web Server, log in as administrator. For details, refer to Accessing the Embedded Web Server as a System Administrator.
2. Click **System → Security**.
3. In the Certificates area, click Security Certificates.
4. Click Import.
5. In the Import Certificates window, click Select.
6. Navigate to the certificate file, select the file, then click Open.
7. Type the password for the certificate, then retype the password.
8. To install the certificate, click Import.
10. To save the changes, click OK.

Overview of Setting Up Digital Certificates

The following steps are an overview of the procedure to set up and use digital certificates:

1. Prepare the printer to manage digital certificates by enabling HTTPS communications.
2. Import and set up digital certificates.
   a. Import the digital certificates.
   b. Configure the digital certificate purpose.
   c. Verify the digital certificate purpose.
3. Configure the desired security features to use the imported digital certificates.

Use the following topics to set up the digital certificates for your printer.

Before You Begin

Before you can manage certificates, configure SSL. For details, refer to Configuring SSL Settings in the Embedded Web Server.

Creating a Security Certificate

Note: To import a certificate, ensure that HTTP - SSL/TLS communication is enabled. For details, refer to Enabling HTTPS Using the Embedded Web Server.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
4. For Certificates, click Security Certificates.
5. From the certificate type menu, select Device Certificates.
6. Click Create, then select Create Self-Signed Certificate.
7. For the available fields, select your options.
8. Confirm, or change, the issuer of the SSL self-signed certificate.
9. For Validity Period, specify the length of time in days for the certificate to remain valid.
10. Click Create, then at the prompt, click Close.
11. When you are finished, click Close.
   The printer creates a digital certificate and places it in the certificate list.
12. When you are finished, click Close.

**Importing a Digital Certificate**

Before you import a certificate, ensure that you back up the certificate file.

To import a digital certificate:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Security.
4. For Certificates, click Security Certificates.
5. Click Import.
6. Click Select.
7. Locate, select the certificate file, then click Open.
8. Depending on the type of security certificate, do one of the following:
   - Leave the password fields blank for PKCS#7 and other certificates.
   - If you select a PKCS#12 certificate, enter a password that corresponds to the certificate file to import. To confirm, reenter the password.

   \* Note: A password is required only for PKCS#12 certificates.
9. To import the file, click Import.
10. When the process completes, click Close.

**Initializing Certificates At the Control Panel**
1. At the printer control panel, press the Menu button.
2. Navigate to Admin Menu, then press OK.
3. Navigate to Init/Delete Data, then press OK.
4. Navigate to Initialize Cert, then press OK.
5. At the prompts, press OK, then press OK again.
6. When the process is complete, the printer restarts automatically.
Verifying the Digital Certificate Purpose

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Security → Security Certificates.
4. To view the security certificates, from the Security Certificates menu, select the type of security certificate that you want to verify.
5. To view all details for a certificate, click the desired certificate.
6. Ensure that the certificate is valid and that it is the certificate associated with the Certificate Purpose.
7. To return to the Security page, click Close, then click Close again.

Deleting a Digital Certificate

When you delete a digital certificate, it disables the feature associated with the deleted feature. To delete a certificate that is in use, disable the feature in advance or switch the association to another certificate.

- For an SSL server, select another certificate, such as a Local Device.
- For an SSL Client, disable the LDAP-SSL/TLS and IEEE802.1x features.
- For IPsec, change the IKE setting to Preshared Key, or disable the feature.

To delete a digital certificate:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Security.
4. For Certificates, click Security Certificates.
5. Select the certificate that you want to delete.
6. Click Delete.
7. At the prompt, click Delete.
8. Click Close.

Exporting a Digital Certificate

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click System → Security.
4. For Certificates, click Security Certificates.
System Administrator Functions

5. To display a list of certificates, from the Security Certificates menu, select the type of security certificate that you want to export.

6. To view all details for the certificate you want to export, click the certificate information.

7. Click Certificate Details.

8. To export the certificate, at the bottom of the details list, click Export.

   Note: PKCS#12 passwords cannot be exported. To export a PKCS#12 certificate, export it as a PKCS#7 certificate.

9. To return to the Security page, click Close, then click Close again.
Configuring Remote Services Upload

Remote Services is a suite of features that simplify printer ownership and administration. It provides free services to enable administration of metered billing and supplies replenishment plans for printers on a network.

Before you begin, if your network uses an HTTP proxy server, obtain the information about your proxy server. For details, refer to Setting Up a Proxy Server.

Setting Up a Proxy Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click Connectivity.
4. For Protocols, click HTTP.
5. To enable a Proxy Server, for Proxy Server, click the toggle button.

   Note: A check mark on the toggle button indicates the setting is enabled.
6. To set the configuration type, click Setup and select an option:
   - If your proxy server uses automatic configuration, select Automatic.
   - If your proxy server uses a configuration script, select Configuration Script. Type the URL to locate the configuration script.
   - If your proxy server uses manual configuration, select Manual, then configure the settings. For assistance, contact your system administrator.
7. Click OK.

Enabling Remote Services

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
4. For Remote Services, click Enable.
5. Click OK.

Testing the Connection to the Xerox® Remote Services Datacenter

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.
3. Click **System → Remote Services Upload**.
4. For Remote Services, click **Settings**.
5. Click **Test Connection**. If communication is successful, a status message appears.
6. Click **Close**.
7. Click **OK**.

**Scheduling Daily Data Upload to the Xerox® Remote Services Datacenter**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **System → Remote Services Upload**.
4. For Remote Services, click **Settings**.
5. For Schedule Upload, type the time for the billing data and supplies data to upload to the Xerox® Remote Services data center.
   
   ∨ **Note:** Enter the time using a 24-hour clock format.
6. To download billing data and supplies data to a .csv file, click **Download Data**.
   
   ∨ **Note:** Look for the .csv file in your Downloads folder.
7. Click **OK**.

**Enabling Email Notifications for Remote Services**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. In the Embedded Web Server, log in as a system administrator. For details, refer to **Logging In as the Administrator at the Control Panel**.
3. Click **System → Remote Services Upload**.
4. For Remote Services, click **Settings**.
5. For Email Notifications, select one or more options.
   
   When a selected condition or event occurs, the system generates an email that is sent to the specified recipient.
6. For Whom to notify, type the email address of the recipient.
   
   ∨ **Note:** You can specify up to five email recipients.
7. To stop notifications for a recipient, for the email address, click the **Trash** icon.
8. Click **OK**.
Disabling Remote Services

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as the Administrator at the Control Panel.

3. Click System → Remote Services Upload.

4. For Remote Services, click Disable.

5. For Who is disabling, select an option.

6. Type the reason for disabling Remote Services Upload.

7. Click Disable.
Updating the Printer Software

Note:
- Software installation begins several minutes after you submit the software to the printer.
- When installation begins, the Embedded Web Server is disabled.
- You can monitor the installation progress from the printer control panel.
- When the installation completes, the printer restarts and prints a Software Upgrade Report.

Checking the Software Version
You can update your printer when Xerox releases a new version of printer software or firmware. Before you download and install new software, determine the current software version installed on your printer.

To determine the software version from the Embedded Web Server:
1. In the Embedded Web Server, click System.
2. Click Software Update.
3. In the Software Update area, view the Current Version.

Enabling Upgrades
1. In the Embedded Web Server, click System.
2. Click Software Update.
3. In the Software Update area, click Enable.
Specifications

This appendix contains:

- Printer Configurations and Options ................................................................. 216
- Physical Specifications ......................................................................................... 218
- Environmental Specifications ............................................................................. 221
- Electrical Specifications ....................................................................................... 222
- Performance Specifications .................................................................................. 224
Available Configurations

The Xerox® Phaser® 6510 Color Printer is available in three configurations:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Print</td>
</tr>
<tr>
<td></td>
<td>USB and Network Connectivity</td>
</tr>
<tr>
<td>DN</td>
<td>Print</td>
</tr>
<tr>
<td></td>
<td>Automatic 2-Sided printing</td>
</tr>
<tr>
<td></td>
<td>USB or Network Connectivity</td>
</tr>
<tr>
<td>DNi</td>
<td>Print</td>
</tr>
<tr>
<td></td>
<td>Automatic 2-Sided printing</td>
</tr>
<tr>
<td></td>
<td>USB or Network Connectivity</td>
</tr>
<tr>
<td></td>
<td>Wireless Network Adapter</td>
</tr>
</tbody>
</table>

Standard Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standard and Enhanced modes up to 30 ppm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Speed</td>
<td></td>
</tr>
<tr>
<td>2-Sided Print Speed</td>
<td>• Standard mode up to 20 images per minute</td>
</tr>
<tr>
<td></td>
<td>• Enhanced mode up to 20 images per minute</td>
</tr>
<tr>
<td>Print Resolution</td>
<td>• Standard mode: 600 x 600 dpi</td>
</tr>
<tr>
<td></td>
<td>• Enhanced mode: 600 x 600 x 8 dpi from the print driver, which prints at 1200 x 2400 dpi</td>
</tr>
<tr>
<td>Paper Capacity</td>
<td>• 50 sheets</td>
</tr>
<tr>
<td></td>
<td>• 250 sheets</td>
</tr>
<tr>
<td></td>
<td>• 550 sheets</td>
</tr>
<tr>
<td></td>
<td>• 150 sheets</td>
</tr>
<tr>
<td>Maximum Print Size</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td>2-Sided Printing</td>
<td>• N Configuration: Manual</td>
</tr>
<tr>
<td></td>
<td>• DN Configuration: up to 176 g/m² from any tray</td>
</tr>
<tr>
<td>Control Panel</td>
<td>Button-navigated menu with two-line display.</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Connectivity</th>
<th>Remote Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>• USB 2.0</td>
<td>Embedded Web Server</td>
</tr>
<tr>
<td>• USB 3.0</td>
<td></td>
</tr>
<tr>
<td>• Ethernet 10/100/1000 Base-TX</td>
<td></td>
</tr>
<tr>
<td>• Wireless network connectivity with an IEEE802.11 n/g/b-compliant Wireless Network Adapter: Standard only on the DNi Configuration.</td>
<td></td>
</tr>
<tr>
<td>• AirPrint™</td>
<td></td>
</tr>
</tbody>
</table>

### Options and Upgrades

- Wireless Network Adapter: Optional for the N and DN configurations, but standard for the DNi configuration. The Wireless Network Adapter is IEEE802.11 n/g/b-compliant, and supports 2.4-GHz and 5-GHz frequencies.
- 550-Sheet Feeder
Specifications

Physical Specifications

Weights and Dimensions

<table>
<thead>
<tr>
<th></th>
<th>Configurations without the Optional 550-Sheet Feeder</th>
<th>All Models with the Optional 550-Sheet Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>420 mm (16.5 in.)</td>
<td>420 mm (16.5 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>499 mm (19.6 in.)</td>
<td>499 mm (19.6 in.)</td>
</tr>
<tr>
<td>Height</td>
<td>347 mm (13.7 in.)</td>
<td>497 mm (19.6 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>24 kg (53 lb.)</td>
<td>31 kg (68 lb.)</td>
</tr>
</tbody>
</table>

Standard Configuration

Configuration with Optional 550-Sheet Feeder
Total Space Requirements

<table>
<thead>
<tr>
<th></th>
<th>Configurations without the Optional 550-Sheet Feeder</th>
<th>All Models with the Optional 550-Sheet Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>870 mm (34.3 in.)</td>
<td>870 mm (34.3 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>1264 mm (49.8 in.)</td>
<td>1264 mm (49.8 in.)</td>
</tr>
<tr>
<td>Height</td>
<td>751 mm (29.6 in.)</td>
<td>901 mm (35.5 in.)</td>
</tr>
</tbody>
</table>

Clearance Requirements

Clearance Requirements for Base Configuration
Clearance Requirements with Optional 550-Sheet Feeder
Environmental Specifications

Temperature
- Operating temperature: 5–32°C (41–90°F)
- Optimum temperature: 15–28°C (59–82°F)

Relative Humidity
- Minimum–Maximum Humidity Range: 15–85%
- Optimal Humidity Range: 20–70% relative humidity at 15–28°C (59–82°F)

Note:
- Under extreme environmental conditions, such as 10°C and 85% relative humidity, printing defects can occur due to condensation in the printer.
- Print quality can be affected when operating near the limits for both temperature and humidity.

Elevation
For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).
Electrical Specifications

Power Supply Voltage and Frequency

<table>
<thead>
<tr>
<th>Power Supply Voltage</th>
<th>Frequency</th>
<th>Current Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>120 V AC +/-10%</td>
<td>60 Hz +/-3 Hz</td>
<td>12 A</td>
</tr>
<tr>
<td>(108–132 V AC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>220–240 V AC +/-10%</td>
<td>50 Hz +/-3 Hz</td>
<td>6 A</td>
</tr>
<tr>
<td>(198–264 V AC)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Power Consumption

- Power Saver Mode (Sleep): 1 W
- Ready: 44 W
- Continuous printing: 380 W

ENERGY STAR Qualified Product

This product is ENERGY STAR® qualified under the ENERGY STAR Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European Union, and Japanese governments and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that result from generating electricity.

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes after 1 minute from the last copy or print.

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device the Blue Angel Environmental Label. This label distinguishes it as a device that satisfies Blue Angel criteria for environmental acceptability in terms of device design, manufacture, and operation. For more information, go to: www.blauer-engel.de.
Recycling Supplies

For more information on the Xerox® supplies recycling program, go to www.xerox.com/gwa.
Performance Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer warm-up time</td>
<td>Power on: As fast as 41 seconds.</td>
</tr>
<tr>
<td></td>
<td>Recovery from sleep mode: As fast as 1 second.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> Warm-up time assumes an ambient temperature of 20°C (68°F) at 60% relative humidity.</td>
</tr>
</tbody>
</table>

Print Speed

Print speeds for continuous printing are up to 30 ppm. Print speeds are the same for color or black and white printing.

Several factors affect print speed:

- Print mode: The fastest print modes are Standard and Enhanced.
- Paper size: Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger sizes reduce print speeds.
- Paper type and weights: For faster printing, use paper weights of 105 g/m² or less.

The maximum print speed for 1-sided printing is 30 ppm on Letter-size paper, and 28.6 ppm on A4-size paper.

The maximum print speed for 2-sided printing is 20 ppm on Letter-size paper and 18.8 ppm on A4-size paper.

The maximum print speed for heavy paper weights is 17 ppm.
Regulatory Information

This appendix contains:

- Basic Regulations .......................................................... 226
- Material Safety Data Sheets ............................................. 230
Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 and Part 18 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy. If the equipment is not installed and used in accordance with these instructions, it can cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference. Users are required to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate this equipment.

⚠️ **WARNING:** To ensure compliance with Part 15 and Part 18 of the FCC rules, use shielded interface cables.

Canada

This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

Certifications in Europe

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the following applicable Directives of the European Union as of the date indicated:


Hereby, Xerox declares that the radio equipment model Phaser® 6510 is in compliance with Directive 2014/53/EU. The full text of the EU declaration of conformity can be found at the following internet address: [www.xerox.com/environment_europe](http://www.xerox.com/environment_europe)

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the environment.
**WARNING:**

- Changes or modifications to this equipment not specifically approved by the Xerox Corporation may void the user’s authority to operate this equipment.
- External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the operation of this Xerox device. If external radiation from ISM equipment interferes with this device, contact your Xerox representative for assistance.
- This is a class A product. In a domestic environment, this product can cause radio frequency interference, in which case the user can be required to take adequate measures.
- To ensure compliance with European Union regulations, use shielded interface cables.

**European Union Lot 4 Imaging Equipment Agreement Environmental Information**

**Environmental Information Providing Environmental Solutions and Reducing Cost**

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria:

- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute

**Introduction**

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria:

- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute

**Environmental Benefits of Duplex Printing**

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto enabled, during the setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the
environmental impact of your work. However, should you require simplex/1-sided printing, you may change the print settings in the print driver.

**Paper Types**

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m²), which contains less raw material and thus saves resources per print, may be used in certain applications. We encourage you to check if this is suitable for your printing needs.

**ENERGY STAR**

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the following website: [www. energystar. gov](http://www.energystar.gov)

For additional information on energy or other related topics, go to [www.xerox.com/environment](http://www.xerox.com/environment) or [www.xerox.com/environment_europe](http://www.xerox.com/environment_europe).

**Power Consumption and Activation Time**

The amount of electricity that a product consumes depends on the way the device is used. This product is designed and configured to enable you to reduce your electricity usage.

After the last print, the device switches to Ready mode. In this mode, the device can print again immediately. If the product is not used for a period of time, the device switches to a Power Saver mode. In these modes, to enable reduced product power consumption, only essential functions remain active. The product takes slightly longer to produce the first print after it exits Power Saver mode than it takes in Ready mode. This delay is the result of the system waking up from Power Saver mode and is typical of most imaging products on the market.

You can set a longer activation time or completely deactivate the Power Saver mode. This device can take longer to switch to a lower energy level.

Changing the default Power Saver activation times can result in an overall higher energy consumption of the product.

To learn more about Xerox participation in sustainability initiatives, go to: [www.xerox.com/environment](http://www.xerox.com/environment).

**EcoLogo Certified to Office Machines CCD-035**

This product is certified to EcoLogo standard for office machines, meeting all requirements for reduced environmental impact. As part of achieving certification, Xerox Corporation has proven this product meets the EcoLogo criteria for energy efficiency. Certified copier, printer, multifunctional device, and fax products must also meet criteria such as reduced chemical emissions and demonstrate compatibility with recycled supplies. EcoLogo was established in 1988 to help consumers find products and services with reduced environmental impacts. EcoLogo is a voluntary, multi-attribute, and lifecycle-based environmental certification. This certification indicates that a product has undergone rigorous scientific testing, exhaustive auditing, or both, to prove its compliance with stringent, third-party, environmental performance standards.
Germany

Blendschutz
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Lärmemission
Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder weniger gemäß EN ISO 7779.

Importeur
Xerox GmbH
Hellersbergstraße 2-4
41460 Neuss
Deutschland

Turkey RoHS Regulation
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”
“EEE yönetmeliğine uygundur.”

Regulatory Information for a 2.4–GHz Wireless Network Adapter

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the user’s authority to operate this equipment.
Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

- North America: www.xerox.com/msds
- European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
Recycling and Disposal

This appendix contains:

- All Countries.................................................................................................................. 232
- North America .................................................................................................................. 233
- European Union ............................................................................................................... 234
- Other Countries................................................................................................................. 236
All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.
North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal information, contact your local authorities.
European Union

Some equipment may be used in both a domestic/household and a professional/business application.

**Domestic/Household Environment**

Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

**Professional/Business Environment**

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.
Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used batteries, please take them to applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable resources and prevent any potential negative effects on human health and the environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact your local municipality, your waste disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes compliance with the requirements set out by the Directive.

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.
Other Countries

Please contact your local waste management authority to request disposal guidance.